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WELCOME TO EZ-ENGRAVE 

FOR THE RECORD 
For the record, and to enable us to better assist you, please make note of your serial number, the 
modules you have purchased, as well as the passwords below. 
Serial Number______________________ 
Password__________________________ 
Modules___________________________ 

INCLUDED WITH EZ-ENGRAVE   
This EZ-Engrave User Guide contains installation instructions, an overview of the features, and a 
summary of files and applications on the CD-ROM included with all s of this product. A registration 
card is included as part of the EZ-Engrave package.  Please take the time to complete and return the 
registration card. 
Registration includes: 

¾ Software updates; 

¾ Special pricing on upgrades; 

¾ Special pricing on other Roland products. 
The EZ-Engrave  package includes: 

¾ EZ-Engrave User’s Manual; 

¾ EZ-Engrave Tutorial Guide; 

¾ Product registration card; 

¾ EZ-Engrave  CD-ROM; 

¾ A security device; 

¾ Font Library and Poster, Clip-art and Corporate Logo book; 

¾ EZ-Engrave Fonts and Clip-art CD-ROM. 
Whether a new user or are upgrading from a previous  of EZ-Engrave, peruse the contents of this 
guide. 
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SYSTEM REQUIREMENTS 
To use EZ-Engrave the following system settings are required as a minimum: 

¾ a PC 486 with hard disk; 

¾ 8 MB of RAM; 

¾ Microsoft Windows ’95 or NT; 

¾ a graphics monitor (VGA or higher); 

¾ a mouse or tablet supported by Windows ’95 or NT; 

¾ 50 MB of hard disk space available on the hard drive. 
It is highly recommended that the system contain a math coprocessor, and be equipped with at least a 
100 MB  hard disk and 12 MB of RAM to operate Windows at a reasonable speed with EZ-Engrave.  
In addition, a video system supporting 800 by 600 screen resolution and 256 colors or greater is 
recommended. 

SECURITY DEVICE 
EZ-Engrave comes with a software protection device (or “dongle”) to prevent unauthorized use or 
pirating of the software.  This device plugs into a standard parallel port on the back of the computer.  
The security device is transparent, only EZ-Engrave knows it’s there.   
To avoid static discharge be sure to turn off the computer and ground yourself by touching the metal 
casing of the computer before plugging in the security device. 
The security device or 'dongle' (also called the 'plug'), is a sealed parallel plug that allows a pass 
through for other parallel devices like printers or plotters. To attached the dongle: 

¾ The security device should be placed into the LPT/printer port; 

¾ The printer port is a 25 hole female port; 

¾ Place the dongle, by the 25 pin male end, into the port; 

¾ The other side of the dongle is a 25 hole female port that allows other parallel devices like 
plotters or printers to be installed in a daisy chain manner. 

Be aware that the serial (or COM) port may be the same size as a parallel port but has the female end 
on the computer. This may cause confusion, as the dongle can be turned around and plugged into the 
COM port accidentally. 

Note: The plotter and the security device do NOT have to be plugged into the same 
port. Some plotters have parallel connections that can be plugged into the back of the 
security device. The majority of plotters, however, have serial connections and plug 
directly into a serial port. 

If using a switch box with multiple parallel devices, place the security device on the parallel port, then 
hook up the rest of the cabling through the security device. Keep in mind that the length of parallel 
cable will determine it's reliability. Over ten feet, the stability of the signal will degrade very quickly -- 
combinations of switchboxes and parallel cables may exceed this limit and cause security device 
problems. 
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If a printer or plotter is installed into the back of the security device, there is normally no difference 
between turning the printer on before the computer.  However, there are some cases where it is 
necessary for the printer or plotter to be turned on before the computer. 
There are certain printers and plotters that can cause problems with the security device. Watch out for 
'bi-directional' parallel ports and/or devices -- these ports do not behave like the older ports, and can 
cause problems with security device errors or by blocking the signal to the printer. 
To correct these problems, access the Control Panel... Printers... (if a printer is the problem) and look 
for the statement 'enable/disable enhanced parallel ports' (or something similar) -- select 'unidirectional 
printing'. In the case of a plotter, there may be a setting on the plotter that requires disabling, but it is 
more likely that the ultimate solution lies in getting a second parallel port and placing the security 
device on it. 

Error Locating Security Device Messages 
The error message 'Error locating Security device xxxxxxxxxx' where xxx is a series of numbers that 
alerts EZ-Engrave into thinking that the security device is installed and/or the passwords are installed 
incorrectly . Double check that the passwords that are installed match up with the dongle number. If 
they do, contact technical support for further details. If not, re-enter the proper password. 
The error message 'Error with last password' indicates that the password was typed into EZ-Engrave 
incorrectly.  The most common mistakes are entering vowels (use the number 0, not the letter O), or 
putting spaces between passwords. If everything looks exactly as on the password sheet, contact 
technical support to help fix the problem. 
The message 'Error Locating Security Device 1' indicates that EZ-Engrave has attempted to read the 
security device and has gotten an incorrect value back. This means that the device is either not present 
or another piece of hardware/software is interfering.  If EZ-Engrave stopped working after installing 
new hardware/software, it is likely that the new device is attempting to use a resource that EZ-
Engrave's security device requires. Remove the new hardware/software and try EZ-Engrave again -- if 
it works, contact the manufacturer of the new hardware/software to see what changes can be made to 
the new item. If nothing can be done, confirm the default settings (e.g., what port, IRQ, or memory 
address to use) and contact technical support. The most common hardware devices that interfere with 
the security device are network cards and sound cards. 
A lightning strike or power surge can cause an unpredictable effect on electronics. Some users have 
had only certain circuit boards burn out during a lightning strike but other components fail. If the 
security device no longer seems to work and there has recently been a lightning strike, try to find 
another computer to test the software on — if it works on the other computer, then it is likely that the 
parallel port on the original computer has been damaged. If it does not work on the new computer, it is 
likely that the device is damaged and needs to be replaced. 



Welcome To EZ-Engrave 

1-4 • EZ-Engrave User Guide 

Limited Warranty on Roland Products 
Roland warrants that the disk medium upon which the EZ-Engrave product is recorded and any 
hardware accompanying said disk(s) shall be free from defects in materials and workmanship under 
normal use and service for a period of ninety (90) days from the date of delivery, as evidenced by a 
copy of the receipt. 
Roland’s entire liability and exclusive remedy as to the disk(s) or hardware shall be, at Roland’s 
option, either (a) return of the purchase price or (b) replacement of the disk(s) or hardware which do 
not meet Roland’s Limited Warranty and which are returned to Roland postage pre-paid with a copy of 
the receipt. 
If failure of the disk(s) or hardware has resulted from accident, abuse or misapplication, Roland shall 
have no responsibility to replace the disk(s) or hardware, the replacement will be warranted for the 
remainder of the original warranty period or thirty (30) days, whichever is longer.  Other then the 
above limited warranty, Roland makes no other warranties whatsoever, either legal or conventional, 
express or implied, with respect to the licensed software and hardware.  You are advised to test the 
licensed software thoroughly before relying on it.  You assume the entire risk of using the licensed 
software.  Because of the diversity of conditions and hardware under which the licensed software may 
be used, no warranty of merchantability or fitness for a particular purpose is given. Some regions do 
not allow the exclusion of implied warranties, so the above exclusion may not apply. 

Copyright Notice 
No part of this publication may be reproduced mechanically or electronically or in any form without 
the prior written permission of Roland. The software described in this manual is furnished under 
license and may only be used or copied in accordance with the terms of such license. The information 
in this manual is for instructional use only, is subject to change without notice and should not be 
construed as a commitment by Roland.  Roland assumes no responsibility or liability for any errors or 
inaccuracies that may appear in this document. EZ-Engrave is a registered trademark of Roland 
Technology Corporation. 
Written and designed at CADlink Technology Corp. 
100 - 2440 Don Reid Drive, Ottawa, ON  Canada   K1H 1E1 
Phone (613) 247-0850 Fax (613) 247-1488 
Manual & Package Design by Roland Marketing and Customer Support. 
Printed in Canada. Product of Canada. 
© 1998 CADlink  Technology Corporation.  
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INSTALLING EZ-ENGRAVE  

INSTALLING EZ-ENGRAVE  - INTRODUCTION 
While running Windows ’95 or NT, insert the CD-ROM into the CD drive.  All of the modules 
purchased will be activated during the installation process, unless features are deselected in the 
“Custom Setup”.   
In most instances the CD will commence on it's own after insertion into the CD drive, as we have 
included a file that the system will detect when the CD is present . This file will not work if the Auto-
insertion feature for the CD drive is de-activated. In those instances or if after five to ten seconds the 
CD has not started on it's own, simply double-click on the setup.exe icon in the CD drive,  

 
or select Start… Run… from the toolbar of the Windows desktop.  
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Type the location of the CD drive followed by “:\setup” in the Command Line (i.e., D:\Setup). 

 
The Installation process will commence. 

 
A dialog box opens asking if you have a license disk included in your Roland package, if so insert the 
disk in your disk drive and select Yes, if not simply select No. The installation will continue. 
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At this point there is a prompt to select the user language, choose your required language (you can 
only select one language for installation). Choose Next to continue the installation procedure. 

 
It is strongly recommended that all other applications be closed prior to installing the new EZ-Engrave 
software, this is a standard procedure to avoid corruption of the installation process. 
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The licensing agreement will appear on screen, please ensure that it is read thoroughly prior to 
agreeing with the EZ-Engrave licensing terms and pressing Yes to accept them.   

 
If there was no license disk included, the following screen appears requesting the Product Code. Enter 
the product code located on a sticker on the CD jewel case. If installing a demonstration  press Next. 

 
The Software setup phase of the installation procedure begins. 
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Select the Destination Location for the EZ-Engrave software. Select the Browse button to search the 
system for a location. If the default directory is all right click on Next. 

 
If upgrading from the previous  of EZ-Engrave this installation procedure will find and optionally 
upgrade the current application.  

  
We suggest, however, that the older  be removed if no settings are to be kept. 

 
A prompt for password opens (if there was no Password disk included in the package), it is absolutely 
imperative that the codes be entered exactly as they appear in the documentation supplied by Roland or 
its authorized re-seller.  Otherwise EZ-Engrave will not run properly, if at all.  Note that Roland 
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passwords do not include any vowels. 

 
Select among the following: 

¾ Full install — installs all purchased files and modules, including the Help file; 

¾ Minimal install — installs the EZ-Engrave application only; and  

¾ Custom install — recommended for advanced users only. 

 
 

The install asks to create a new program group created called “EZ-Engrave”(the actual name of the 
group may change due to the modules purchased). This group contains icons for EZ-Engrave, Plot 
Spooler, a full featured Demo (as well as all other applications the password allows), and the Readme 
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file for notes and compatibility issues related to EZ-Engrave . 

 
The actual software install will complete and a notification of installation will appear. 

 
Before finishing the install there is the option to upgrade/install new drivers. 
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Font Installation 
After the drivers installations are completed EZ-Engrave provides the opportunity to install fonts 
directly to the system. 

 
To install fonts click continue. Fonts can also be installed at a future time using the Install… Fonts… 
option from the File menu (for more information see the File section of the EZ-Engrave Basics 
chapter). The installs will commence and notify upon completion. At the conclusion of the installation 
procedure there is a choice to reboot the system immediately or at a later time. 

 
Windows must be restarted before EZ-Engrave will run. 

Note:  If modules refuse to run, it is likely that the password has been inserted 
incorrectly during the install program, or the security device in not correctly attached.  
Under these circumstances, select Install Modules from the File menu and re-install the 
required password.  (See the Install Modules segment of the EZ-Engrave Basics chapter 
for more details.) 
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BRING THE PLOTTER ON LINE 
Plug the plotter cable into the appropriate port on the system and ensure that the connections are 
secure. Turn on the plotter and make sure it is on line and ready to accept data from EZ-Engrave. 

Set Up Windows to Communicate with The Plotter 
If the router is attached to the computer through a serial (COM) port, first configure the serial port in 
Windows prior to plotting for the first time. To do this, first consult the plotter manual to determine the 
handshaking protocol required by the plotter. The handshaking will be described as: 
>  Software or X-On/X-Off >  Hardware >  None 
Also configure the port with regards to the following four variables, check the plotter manual for these 
setup requirements as well: 
>  Baud Rate  >  Word Length or Data Bits >  Parity  >  Stop Bit  

Windows NT Port Setup 
Communications Port Setup can be accessed via the Start menu...then go to Settings..., then to Control 
Panel: 

¾ Double-click on the Ports icon to bring up the Ports screen; 

¾ Double-click on the icon representing the port through which the plotter is connected; 

¾ Single-click on the Settings option, the Port Settings screen will appear; 

¾ Set up the Baud and Flow Control as required by the plotter (refer to the plotter manual for 
these settings); 

¾ Click on the OK button to accept these settings and the OK button in the Ports screen to 
return to the Control Panel; 

¾ Close the Control Panel to return to the main Windows screen; 

¾ Do not make any adjustments to any ports other than the one through which the plotter is 
connected, as this may interfere with other devices present in the system; 

¾ Once the appropriate changes are made to the communications port, restart Windows to 
ensure the changes take effect. 

For more information on setting up the ports from within Windows, consult the Windows 
documentation. 

Note: Gerber users with the Roland FastBoard should set their handshaking to 9600 
baud, no parity, 8 data bits and 1 stop bit, and either "X-ON/X-OFF" or "Hardware" 
handshaking ("X-ON/X-OFF" preferred). 

If using a Roland Super Adapter Card, the proper settings are 9600 baud, no parity, 8 data bits, and 2 
stop bits, and no handshaking (i.e., "None"). 

Windows 95 Port Setup 
Communications Port Setup can be accessed via the Start menu...then go to Settings...then to Control 
Panel: 

¾ Double-click on the System icon to bring up the Hardware settings of the computer; 
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¾ Click on the Tab marked Device Manager, the hardware devices in the computer should be 
available; 

¾ One of the icons will be Ports (COM and LPT), double click on this; 

¾ all the COM and LPT ports available on the computer should be visible, double click on the 
port to configure; 

¾ Click on the Tab marked Port Settings for this COM port; 

¾ Set up the Baud and Flow Control as required by the plotter (refer to the plotter manual for 
these settings); 

¾ Click on the OK button to accept these settings and the OK button in the Ports screen to 
return to the Control Panel; 

¾ Close the Control Panel to return to the main Windows screen; 

¾ Once the appropriate changes are made to the communications port, restart Windows to 
ensure the changes take effect; 

Note: Do not make any adjustments to any ports other than the one through which the 
plotter is connected, as this may interfere with other devices present in the system; 

For more information on setting up the ports from within Windows, consult the Windows 
documentation. 

Note: Gerber users with the Roland FastBoard should set their handshaking to 9600 
baud, no parity, 8 data bits and 1 stop bit, and either "X-ON/X-OFF" or "Hardware" 
handshaking ("X-ON/X-OFF" preferred). 

If using a Roland Super Adapter Card, the proper settings are 9600 baud, no parity, 8 data bits, and 2 
stop bits, and no handshaking (i.e., "None"). 
Plug the plotter cable into the appropriate port on the system and ensure that the connections are 
secure. Turn on the plotter and make sure it is on line and ready to accept data from EZ-Engrave. 
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USING EZ-ENGRAVE - THE BASICS  

TERMINOLOGY 
There are several types terminology for functions used by EZ-Engrave that are common to most 
Windows applications. They should be reviewed before starting EZ-Engrave. 

Click on 
Reference to “click on” or “click the mouse on” in the manual entails positioning the on-screen cursor 
on top of the designated item and pressing and releasing the left mouse button once. 

Double-click on 
Reference to “double-click on” in the manual entails positioning the on-screen cursor on top of the 
designated item and pressing and releasing the left mouse button twice in quick succession. Windows 
interprets this as a single action. The Control Panel option in the File menu allows for adjusting the 
speed of a double-click to suit particular styles. 

Right-click on 
Reference to “right-click on” or “right-click the mouse on” in the manual entails positioning the on-
screen cursor on top of the designated item and pressing and releasing the right mouse button once. 

Drag 
Reference to “drag” in the manual means to press the left mouse button, and while continuing to hold 
the button down, move the mouse. When the desired action is completed, release the button. “Drag” 
refers to the complete action, this is also referred to click-and-drag on occasion. 

Sweep-Select 
Sweep-select means simply dragging a box around an object or number of objects. For example: 

¾ Place the cursor or pointer on the screen, with the mouse, at any location. 

¾ Drag the mouse (i.e. depress the left button on the mouse and drag the mouse down or up and 
to the left or right, while keeping the button depressed). 

¾ A box will begin to form on the screen as the pointer moves. 

¾ When the box completely surrounds the intended object(s), release the mouse button. 
The box formed on the screen is called a marquee. 
When using some commands, once the marquee has been made, it will snap back to form a smaller box 
that exactly defines the largest outside dimensions of any objects inside the original marquee. 
This smaller box is referred to as a bounding box. 
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STARTING EZ-ENGRAVE - INTRODUCTION 
To start EZ-Engrave first start Windows. 

¾ Start EZ-Engrave by double-clicking on the EZ-Engrave icon in the Program group 

; or 

¾ Single-click on the icon from the Start menu. 

 
The EZ-Engrave working screen opens. 
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Title Bar 
Tells the name of the current application running and the name of the open file. Move the position of 
the EZ-Engrave window by dragging the Title Bar to a new location. 

Menu Bar 
The Menu Bar allows access to a number of drop-down menus which contain tools for manipulating 
files. Each of these menus and their functions are explained in detail later in the manual. 

File Menu  Edit Menu 

  

Layout Menu  Arrange Menu 
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Cut Menu  Transform Menu 

   

Image Menu View Menu 

  

Options Menu   
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Help Menu 

 

Customizable Toolbar 
The Custom Toolbar in the second from the top row, below the Menu Bar provides the option to set up 
a palette of the most frequently used tools. This Custom Toolbar can be activated via the Show Custom 
Toolbar option in the View menu. Most of the options available through menu selection are available 
as icons for use in the Custom Toolbar. For more detailed information on the icons functions refer to 
the related menu selection information in the EZ-Engrave Basics chapter of this manual. 

  
When first running EZ-Engrave the default setting is with the Show Custom Toolbar activated and the 
default EZ-Engrave Toolbar open. To select a different Toolbar or to edit or create new Toolbars, right 
mouse click anywhere within the Toolbar itself. The Toolbar pop-up menu opens: 

 

Customize 
Selecting the Customize opens the Customize Toolbar dialog box. Within this dialog box icons can be 
selected to be added or removed from the Current Toolbar. 

 

EZ-Engrave User Guide • 3-15 



Using EZ-Engrave - The Basics 

3-16 • EZ-Engrave User Guide 

Available Buttons 
The List of Available buttons displays all icons currently available for quick access to various features 
in EZ-Engrave. Scroll through the list using the scroll bar or the down or up arrows on the keyboard, to 
select any icon. 

Add 
Once an icon is selected in the Available buttons list it can be added to the Toolbar buttons by pressing 
the Add button. The Toolbar on the EZ-Engrave window will refresh itself immediately to display the 
new icon. Any icon added to the Toolbar buttons list is no longer available from the Available buttons 
list. 

Remove 
The Remove button is only available for use if an icon is selected in the Toolbar buttons list. To 
remove an icon from the list select it and press Remove. Any icon that is removed from the Toolbar 
buttons list is now available from the Available buttons list. 

Toolbar Buttons 
The List of Toolbar buttons displays all icons currently included in the Custom Toolbar, for quick 
access to various features in EZ-Engrave. Scroll through the list using the scroll bar, or the down or up 
arrows on the keyboard, to select any icon for removal. 

Close 
When a Customizing session is complete exit and return to EZ-Engrave by pressing the Close button, 
as all edits to the Custom Toolbar are applied immediately the Close button does not reapply the 
changes. 

Reset 
The Reset button returns the Custom Toolbar to the Toolbar settings that were functioning upon 
entering the Customizing session. This does not necessarily return the Toolbar settings to the Default. 

Help 
Access the On-line Help document by pressing this button. 

Move Up 
When an icon is selected in the Toolbar buttons list it’s priority can be increased in the order by 
pressing the Move Up button. This moves the button to the left on the Toolbar. 

Move Down 
When an icon is selected in the Toolbar buttons list it’s priority can be decreased in the order by 
pressing the Move Down button. This moves the button to the right on the Toolbar. 

Hide 
Selecting Hide from the pop-up menu causes EZ-Engrave to hide the Custom Toolbar, this increases 
the size of the editing window.  
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To reactivate the Custom Toolbar select Show Custom Toolbar from the View menu. 

 

New Configuration 
The customized tool palettes can be saved as Configurations. For example, if there are a number of 
projects that require welding features to be available, a palette can be set to contain all the various 
weld tools, then if a different project requires the special effects features, a palette can be set to include 
all the relevant special effects tools. These configurations can be called up via the Restore 
Configuration option. 
Selecting the New Configuration option opens the Configuration Name dialog box. Enter a relevant 
name up to 20 characters in length and press OK. 

 
The New Configuration will now appear in the Restore Configuration fly-out list, and can be edited to 
suit specific requirements. We recommend creating a new configuration prior to editing it. 

Update 
The Update button saves any customizing made to a Toolbar configuration. After a New Configuration 
is created and edited using the Customize option, select Update to ensure that the Configuration is 
saved. 

Restore Configuration 
All Configuration will be available from this fly-out menu. If no configurations have been created only 
the Default setting is available. The default setting can be customized, however any changes to the 
setting cannot be saved and if Default is selected EZ-Engrave will restore the original Default settings 
for the Toolbar. 
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To access a Toolbar configuration select it from the fly-out menu. The EZ-Engrave Default 
configuration will always be available. 

 

Delete Configuration 
Use this option to delete the current Toolbar configuration. The EZ-Engrave Default Toolbar 
configuration cannot be deleted and will not be available from the fly-out menu. 

 

Status Bar 
The Status Bar in the bottom section of the top title bar provides the area to view (and edit) object 
location, size, scale, rotation, and color. 

 

Objects Selected 
The first information listed in the Status Bar is the Objects Selected information, if only one object is 
selected EZ-Engrave will list the type of object as well as the layer upon which it exists. 

 

X & Y Coordinates of Mouse/Cursor 
The area immediately below the Objects Selected are displays the X and Y coordinates of the cursor on 
screen. 

 

Object Coordinates  
The X and Y value boxes denoted by the Anchor icon display the X and Y origin for the selected 
object(s).  

 
These values can be edited, however once a value is entered the Return/Enter key on the keyboard 
must be pressed to activate the entry. The Anchor appears on the selected object at the designated 
Anchor point, and can be moved by clicking and dragging on the Anchor icon.  
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If the Show Anchor Tool option in the View menu is not activated, the Anchor icon will not appear in 
front of the Object Coordinates value boxes, and the last selected node on the object becomes the 
Anchoring point.  
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Object Width and Height 
The Object Width and Height value boxes display the width and height of the selected object(s). These 
values can be edited, however once a value is entered the Return/Enter key on the keyboard must be 
pressed to activate the entry, or use the arrow cursor to increase or decrease the absolute width or 
height values. If more than one object is selected all objects will be sized when these values are edited. 

 

Object Scale 
The Object Scale arrows adjust the scale of the selected object(s) in 5% increments. These values can 
be edited, however once a value is entered the Return/Enter key on the keyboard must be pressed to 
activate the entry. Once the scale of an object’s width or height is complete the values in the scale box 
revert back to 100%. 

 

Rotation 
The Rotation option rotates the selected object(s) the defined angle of rotation. Use the arrow buttons 
to rotate the selected object(s) in increments of 15 degrees. These values can be edited, however once a 
value is entered the Return/Enter key on the keyboard must be pressed to activate the entry. Only 
vector object can be rotated with this tool. 

 

Vinyl Name and Code  
The selected object(s) color layer and vinyl name and code are displayed in this view box. If no object 
is selected the currently selected color plate is displayed. 

    

Tool Bar 
The Menu Bar allows access to a number of drop-down menus which contain tools for manipulating 
files. Each of these menus and their functions are explained in detail later in the manual. 

 Select tool  
Scanning/Tracing Select tools:   
(Available only within Scanning/Tracing Modes) 

 Click Select tool .....................  Oval Area tool 

 Rectangular Area tool ............  Polygon Area tool 

 Freehand Area tool.................  Magic Wand tool 

 Select By Color tool 
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 Cut tool 

 Measure tools 
Measure tool palette contains five tools:    

 Measure tool ..........................  Dimension tool 

 Object Dimension tool ...........  Arrow Draw tool 

 Notes tool 

 Text tool 
Text tool palette contains three tools:   

 Text Compose tool.................  On-Screen Text Kerning tool (WYSIWYG) 

 Text Auto Layout tool 

 Zoom tools 
Zoom tool palette contains five tools:   

 Zoom In tool ..........................  Zoom Out tool 

 Zoom To Selected tool...........  Zoom To Sign Blank tool 

 Return To Previous View tool 

 Weld tools 
Weld tool palette contains five tools:   

 Basic/Color Weld tool ...........  AND Weld tool 

 XOR Weld tool 

 Shape tools 
Shape tool palette contains ten tools: 
 

 Circle/Ellipse tool ..................  Stars/Polygon tool 

 Rectangle tool ........................  Arrow Draw tool 

 Weed Border tool...................  Decorative Border tool 

 Registration Mark tool...........  Multi-Registration tool 

 Drill point tool 
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Graphic Creation tools 
Creation tool palette contains three tools:  

 Node Edit tool   Free Edit tool   Arc Edit tool 
When the Node Edit tool is selected a palette opens containing three tools:  

    Drawing tool       Node Editing tool           Segment Editing tool  
When the Arc Edit tool is selected a palette opens containing three tools:  

    Drawing tool        Arc/Node Editing tool     Segment Editing tool  
 

 Scanning/Tracing tools 
Con tool palette contains Two tools:     

  Scanning  PhotoMachine 

   

 Stroke Tool 
Stroke Tool     

 Line Style tool  

 Tool Path tools 
Tool Path tool palette contains six tools:    

 Online tool  Male tool  Female tool  

 Fill tool  
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Scrolling and Panning 
The scroll bars along the vertical edge and along the bottom of the screen allow for viewing sections of 
the graphic not currently in the viewing window. 

 

Vertical/Horizontal Scroll Bars 
Scroll Bars are used to scroll the current viewing window to view another part of the image on-screen. 
This is very useful when using a zoomed-in view of the image. 

Scroll Bar Arrows 
Clicking on a scroll arrow causes the viewing window to move in the direction indicated by the arrow. 
This will have the appearance of moving the graphic in the opposite direction a short distance. This 
distance is approximately 1/10 the width or height of the view screen, depending on whether you are 
moving the view screen vertically or horizontally. 

Keyboard Shortcut: Press the [Control] key and the appropriate arrow key to move the 
view screen as a scroll arrow was pressed. 

Scroll Bar Elevators 
Clicking on a Scroll Elevator causes the viewing window to move in the appropriate direction a large 
distance. The distance moved is approximately equal to 1/3 the width or height of your view screen, 
depending on whether you are moving your view vertically or horizontally. 

Keyboard Shortcut: Press the [Control + Shift] keys, and the appropriate arrow key 
simultaneously to cause the view screen to behave as if a scroll arrow was pressed. 
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Scroll Bar Thumb 
Dragging a scroll bar thumb within the scroll bar causes the viewing window to move in the direction 
of the thumb in very large movements. How far the view screen actually moves depends on how far 
the thumb is moved within the scroll bars. When deciding how far to drag the scroll thumb, be aware 
that the ends of the scroll bar represent the outer edges of the file on screen. 

Editing Window 
The large blank area of the screen is the Editing window.  If Show Sign Blank is activated (see Layout 
menu), a rectangle representing the sign blank appears on the Editing Window.  Any objects in the 
Editing Window except the Sign Blank can be cut or edited by EZ-Engrave commands. 

Color Palette 
The Color Palette at the bottom of the screen is used to assign a layer to selected objects. Each color 
depicts a different layer. For more information see the section on the Color Palette in the EZ-Engrave 
Basics chapter. 

Dialog Boxes 
Many operations are controlled by actions found in a dialog box. Typically, they appear as follows: 

 

Radio Buttons  
Radio buttons provide the choice between two or more mutually exclusive choices. Clicking on a radio 
button selects the associated option, and de-selects any previous related settings. 

Checkbox  
Check boxes enable/disable a particular command option. When selected, an X or check mark appears 
in the checkbox. 
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Numeric Entries  
This feature provides for entering numeric values. These may be entered by dragging the cursor over 
the existing values to highlight them, and then typing in new values from the keyboard. Where they 
appear, use the Scroll Arrows also to change the values. 

Scroll Arrows 
Scroll Arrows are used to change the numeric entries using the mouse. The up arrow increases the 
displayed value, while the down arrow lowers the value. Clicking on an arrow changes the value one 
increment at a time. Holding down the mouse button on the Scroll Arrow changes the value rapidly. 

Display Boxes 
Display boxes are included in some dialog boxes to give a visual representation of the selected 
command. 

OK Button 
Selecting this button confirms all choices or changes made to within the dialog box and returns to the 
previous dialog box, window, or view.  

Apply Button 
Selecting this button confirms all choices or changes made to within the dialog box and applies the 
changes while remaining within the dialog box. Use this button specifically when testing to see results 
of an edit or to verify the results before exiting dialog boxes. 

Note: Wherever a dialog box is explained in the manual the OK, Apply, and Cancel 
buttons will not be explained any further, as the use of those features is consistent 
throughout the software. 

Cancel Button 
Selecting this button ignores all choices or changes made to within the dialog box and returns to the 
previous dialog box, window, or view without applying any changes made.  

Note: If the Apply button is pressed prior to the Cancel button the changes made at the 
point of the Apply button will be retained while any changes made after pressing Apply 
will be Canceled.  

List Boxes 
List boxes provide for selection of an item from a list. Scroll through the list using the scroll arrows 
and select the desired item by double-clicking on it, or click on the selection and then click on OK. 

Short-Cuts 
EZ-Engrave is also equipped with a number of short-cuts to some of the more common functions. 
These short-cuts take three forms — Hot Keys, Function Keys, and Accelerators. 
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Hot Keys 
A Hot Key may be one or more keys pressed at the same time to replace a series of mouse and menu 
movements. For example, select all of the objects in a drawing by either entering the Edit menu and 
selecting Select-All, or by pressing the [Control+A] keys at the same time. On the screen (in the 
menus), this key combination appears as ^A. The [Control] key is abbreviated as ^. 

File — Hot Keys 
These Hot Keys enable access to the various options of the File Menu.   
 [Ctrl+N]  New File   [Ctrl+O]  Open File 

[Ctrl+P]   Print   [Alt+Q]   File Capture 
[Ctrl+S]   Save File  [Ctrl+V] Save File As  
[Ctrl+X]  Exit  

Edit — Hot Keys 
These Hot Keys enable access to the various options of the Edit Menu.  
  [Alt+Bksp] or [Ctrl+Z]  Undo [Ctrl+Bksp] or [Ctrl+Y]  Redo 

[Shift+Del] or [Ctrl+X]  Cut  [Ctrl+Ins] or [Ctrl+C] Copy 
[Shift+Ins] or [Ctrl+V]   Paste [Del]         Clear 
[Ctrl+D]     Duplicate 
[Shift+Drag Center of Selected Object] Duplicate and leave original 
[Ctrl+T]    Edit Text  [Ctrl+E]     Edit Path 
[Ctrl+I]     Edit Font  [Ctrl+A] or [F3] Select All  
[Shift+F3]   Select None  [Alt+F3]    Select Inverse  
[Alt+D]     Redraw 

Layout — Hot Keys 
These Hot Keys enable quick access to the options in the Layout Menu.  
 [Alt+K]   Alignment  [Ctrl+K]  Align  

[Ctrl+G]  Group   [Alt+G]   Ungroup 

Alignment — Hot Keys 
These Hot Keys enable quick access to the Alignment selections.   
  [Alt+1]  Left/Vertical .... [Alt+2]  Center/Vertical 

[Alt+3]  Right/Vertical .. [Alt+4]  Top-Left/Horizontal 
[Alt+5]  Center/Horizontal [Alt+6]  Bottom-Right/Horizontal 
[Alt+7]  Center 

Arrange — Hot Keys 
These Hot Keys enable quick access to the options in the Arrange menu.   
  [Ctrl+F]   To Front   [Ctrl+B]  To Back  

[Ctrl+U]  Forward   [Ctrl+L]  Backward  
[Ctrl+R]  Reverse   [Ctrl+H]  Make Path  
[Ctrl+J]   Break Path   [Alt+B]   Text to Graphics 
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Cut — Hot Key 
This Hot Key enables quick access to the Cut menu of EZ-Engrave 
 [Alt+P]  Plot  

View — Hot Keys 
These Hot Keys enable quick access to the selections in the View menu.   
  [Alt+S]  Show Fill  [Alt+N]  Show Thick Lines 

[Alt+J]   Show Tool Paths [Alt+R]   Show Rulers  
[Alt+M]  Show Bitmap Outlines 

Options — Hot Keys 
These Hot Keys enable quick access to the selections in the Options menu.   
  [Ctrl+W]  Snap To Grid  [Alt+W]  Use Guides  

Generic — Hot Keys 
These Hot Keys enable quick access to the various generic selections in EZ-Engrave.   
  [Arrow key]  Nudges 1 pixel [Shift+Arrow key]  Nudges 5 pixels  

[Tab]  Toggle selection through objects  
[Shift+Tab]  Reverse direction toggle selection through objects 
[Spacebar]  Activates Select tool 
[Ctrl+Select tool]  Move/Draw/Edit/Select with Horizontal/Vertical constraint 

EZ-Engrave Functions Keys 
These function keys provide access to various functions of EZ-Engrave. 
  [F1]   Help  [F2]   Disable all but the target layer   

[F3]   Select All   [F4]   Redraw Screen  
[F5]   Activate Zoom In Tool  [F6]   Zoom Out 
[Shift+F6]  Zoom Out to Center [F7]   Zoom To Selected Object   
[F8]   Zoom To Sign Blank  [F9]   Zoom In/Out Toggle   
[F10] Select the Menu Bar [F11] Pan to Mouse 

Accelerators 
Accelerators are single keystrokes that will access a function from within an open menu. For example, 
press the [S] key on the keyboard while in the File Menu to access the File Save command. These 
accelerators are menu-specific, and are indicated within the menu an underscore beneath the 
accelerator (e.g., Save). they are available only when a given menu is open. To open a menu without 
using the mouse simply press the [Alt] key combined with the underscored letter in the menu title to 
open the drop-down menu (e.g., [Alt+F] to open the File menu). 
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EZ-ENGRAVE BASICS 

STANDARD FEATURES IN EZ-ENGRAVE 
The EZ-Engrave Basics chapter explains all the fundamental features included with most modules and 
explains the regular router and engraver drivers to control the more common engraving plotters. EZ-
Engrave Basics also explains all of the basic tools and menus available for EZ-Engrave. Other feature 
specific or advanced tools and menus which may require additional modules to become active are 
explained in detail in later chapters of this manual. 
All add-on EZ-Engrave modules need the Foundation module to function, and in most cases these 
additional modules can be activated by installing their password into EZ-Engrave. Passwords are 
purchased from EZ-Engrave dealers, and can be installed into EZ-Engrave at any time. Through the 
various add on modules available, upgrade the EZ-Engrave program, with a quick phone call to a 
Roland Authorized Dealer, or to Roland directly. 
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SELECT TOOL  

SELECTING OBJECTS WITH THE  TOOL 
The Select  tool is used to select objects that will be operated on by the commands contained in the 
menus. The Select  tool is also used to move and re-size objects. 

¾ Click on the Select  tool button to make it active. 

Selecting a Single Object 
¾ With the Select  tool active, position the Select  tool on the object’s outline and click. 

A group of 9 nubs appear around the selected object and the Status Bar will indicate the dimensions of 
the selected object and the layer designation of that object. 

  
1. Object un-selected 2. Object selected 

Selecting Multiple Objects 
¾ With the Select  tool active, click on several objects while pressing the [Shift] key.  

A group of 9 nubs will surround the entire group of selected objects and the Status Bar will indicate the 
size of the group and the number of objects selected. This group of objects can be operated on as one 
object with the menu commands. Click on an already selected object while holding down the [Shift] 
key to de-select that object. 

Sweep selecting objects 
A sweep select is simply a quick means of selecting several objects by surrounding the objects with a 
marquee. To sweep select an object, place the Select  tool on a blank part of the screen adjacent to 
the objects to be selected. Select multiple objects by sweep selecting multiple groups with the [Shift] 
key pressed. 

¾ Click and drag the cursor to form a dotted rectangle that surrounds the objects. When the 
mouse button is released, all the objects inside the marquee will be selected. 

   
1. Click and Drag cursor 2. Release cursor after 3. Surrounded objects  
   around objects.     surrounding objects     selected 



Select Tool 

Index Select of Objects 
An indexed selection of objects means scrolling through the objects of a file in the order that they were 
created.  

¾ Pressing the [Tab] key with the Select  tool active selects an object in the graphic, pressing 
the [Tab] key again selects the next object created, and so on. 

Repeated pressing of the [Tab] key will cause the Select  tool to index through the graphic selecting 
each object in turn. The Status Line indicates the size of each object as it is selected. 

Reverse Index Select of Objects 
¾ Pressing [Shift+Tab] with the Select  tool active reverses the order of objects selected with 

the [Tab] key. 

Shortcut to Activate the Select  Tool 
¾ When using another tool from the toolbox, the Select  tool can be immediately activated 

by pressing the [Space] bar. This disables the originally active tool. 

De-select Objects 
¾ Moving the Select  tool to a blank area of the screen away from any selected objects and 

clicking will de-select all selected objects. 

Keyboard Shortcuts: 
To Select all objects: [F3] key. 
To De-select all objects: [Shift+F3] keys. 
To Reverse select objects: [Alt+F3] keys. 

MOVING OBJECTS WITH THE SELECT  TOOL 
¾ Move the Select  tool onto the outline of the selected object, when the cursor changes to a 

+ sign click and hold the left mouse button down. 

¾ Drag the cursor to a new location while pressing the left mouse button. As this happens, 
notice that the bounding box representing the overall dimensions of the selected object(s) 
follows the Select  tool. 

¾ When the box is in the desired location, release the mouse button and the object appears 
inside the box in its new location. 

  
1. Select object 2. Click on the edge of the object and Drag 
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3. When box is in required location… 4. Release button to place object 

¾ Pressing [Alt+Bkspc] undoes the previous action. 
The Status Bar will indicate the distance moved. 

Constrained Move 
¾ Move a selected object with the [Control] key pressed, to constrain the move in the vertical 

or horizontal direction. 

¾ Pressing [Alt+Bkspc] undoes the previous action. 

Note: If Snap to Grid is selected in the Options dialog box, objects will move in 
increments equal to the Grid Size set up in the Preferences dialog box. 

Leave Original 
¾ Press the [+] key while moving the selected objects, and a copy of the original object is left 

behind. The [+] key does not have to be held down. 

  
1. Select object 2. Click on nub and Drag 
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3. When box is in desired location… 4. Release button to place object 

Nudge 
It’s possible to move graphics a pixel at a time on screen. This small movement is called a nudge. 

¾ To nudge a selected object(s) up or down, left or right, press the [Arrow key] on the 
keyboard in the direction of the arrow. 

¾ Pressing [Shift+Arrow key] nudges the graphic 5 pixels at a time. 

RE-SIZING OBJECTS WITH THE SELECT  TOOL 
The Select  tool can also be used to stretch and compress an object in the horizontal or vertical 
direction and to re-size it proportionally bigger or smaller. 

To Stretch / Compress Objects 
¾ Select the object with the Select  tool. Move the Select  tool pointer over one of the 

center nubs on either of the four sides until it changes to a bi-directional arrow Ù, facing the 
directions that the stretch/compress can follow;  
 

¾ Drag the nub in the required direction and a dotted bounding box will  grow/shrink as the 
pointer is dragged; 
 

¾ Release the mouse button when the bounding box is the required size, the object is re-sized. 
 

The Status Bar will show the change in dimension. 

Constrained Stretch / Compress Objects 
¾ Pressing the [Control] key while stretching or compressing the object from the middle nubs 

on either of the four sides will cause the object to re-size in increments of 100% of the 
original. 

The Status Bar indicates the new dimensions. 

¾ Pressing [Alt+Bkspc] keys undoes the previous action. 
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To Scale an Object 
¾ Select the object with the Select  tool. Move the pointer over one of the corner nubs until it 

changes to a bi-directional arrow Ù; 

 
¾ Drag the nub to the left or right and a bounding box will increase or decrease proportionally 

in scale; 

 
¾ Release the mouse button when the bounding box is the desired size and the re-sized object 

will be re-drawn. 

 
¾ Pressing the [Control] key while scaling the object from the corner nubs will cause the object 

to scale in multiples of 100%. 

¾ Pressing the [Shift] key while dragging the nubs has the effect of scaling from the center of 
the selected object(s). Dragging the left side nub with the [Shift] key scales the object(s) 
width from the center, while dragging the top nub with the [Shift] key scales the object(s) 
height from the center. Dragging either the bottom or the right nub with the [Shift] key scales 
both the height and width proportionally from the center of the selected object(s). 

 
The Status Bar will indicate the new dimensions. 

¾ Pressing [Alt+Bkspc] keys undoes the previous action. 
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Note: If Snap to Grid is selected in the Options dialog box, objects will only be able to 
be re-sized in multiples of the Grid Size established in the Preferences dialog box. 

Creating Mirror Images with the Select  Tool 
A partial reflection image of the selected object can be drawn during re-sizing by moving the selected 
nub toward and past the corresponding nub on the opposite side of the bounding box. 
 

¾ A horizontal mirror is made by moving the right side nub to the left, past the left side nub 
while pressing the [Control] key to constrain the re-size to 100% of the original. 

Leave Original 
Press the [+] key on the numeric key-pad at any time during the re-sizing of an object, to leave a copy 
of the original sized object behind.  The [+] key does not have to be kept pressed down. 

Shortcut to the Layout Menu 
¾ Move the Select  tool over one of the nubs; 

¾ Click on the nub with the right mouse button and the Layout menu appears allowing access 
to perform one of these commands to the selected object.  

Drag and Drop Using the Select  Tool 
The Drag and Drop capability provides the ability to select a file or object from the File Manager or 
Program Group and drag the object into an open EZ-Engrave window.   
The same principle of Drag and Drop can be used by dragging a file or object onto the EZ-Engrave 
icon in the Program Group, this opens the EZ-Engrave application with the object or file in the Sign 
Blank. 

¾ Within Window’s Program Manager or from the Window’s ’95 desktop click on the file to 
open/import; 
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¾ Drag the file onto the EZ-Engrave Edit Window; 

 
¾ Release the mouse button, the file will open in EZ-Engrave.  The Drag and Drop functions 

like the Open with Merge selected (i.e., if an object is already in the EZ-Engrave Edit 
Window, the new object will be placed on top). 

 
Alternatively, if EZ-Engrave is not opened, select the file to open and drag it onto the EZ-Engrave 
icon. 

 

EZ-Engrave User Guide • 5-7 



 

5-8 • EZ-Engrave User Guide 



Cut Tool 

EZ-Engrave User Guide • 6-1 

CUT TOOL  

CUT TOOL 
The Cut  tool is a quick way to plot/rout a graphic without having to proceed through the Cut menu. 

Note: Click on the  icon and the image currently in the view window will be 
presented on the screen with vertical and horizontal dotted lines representing ‘tiling 
lines’. 

Selection of tiles and subsequent cutting of the tiles is explained in the section describing the Set Tiles 
section of the Cut menu. The parameters saved previously in the Plotter Set Up option of the Cut menu 
will be used by default to control the cutting operation. Only one copy of the graphic can be cut from 
the Cut  tool. If more than one copy is required, make the selection in the Plot option of the Cut 
menu and proceed to cut from this menu. 
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MEASURE TOOL   

MEASURING AND DIMENSIONS 
Clicking on the Measure Tool   button produces a tool palette containing five tools: 

 

MEASUREMENT TOOL    
The Measure Tool   permits selection of two points on a graphic, determine the distance between 
these two points and then force this distance to any length.  Select the Measure Tool   and a ‘+’ 
shaped cursor appears on the screen. The following dialog box also appears: 

 
¾ Select one point and press the mouse button; 

¾ Drag the mouse to the point which represents the end of the area to be measured and release 
the mouse button. 

The dimension between the two selected points is shown in the dialog box. To make a further change 
to this dimension, type in the desired dimension and accept by pressing the check mark button. The 
entire drawing will now change in size such that the distance between the two selected points complies 
with the value entered into the dimension box. The new dimensions of the entire drawing will appear 
in the Status Bar. 

¾ Select the X button to close the Measure Tool  if no change is to be made to the measured 
dimension. 

The Measure Tool  can be constrained to measure distances that are exactly vertical or horizontal. 
Simply press the [Control] key while dragging the cursor over the area to be measured. 

DIMENSION TOOL   
The Dimension  tool provides the ability to create arrows indicating dimensions on any given plane 
or angle. The format of the final dimension arrows is governed by the settings set in the Dimension 
Setup dialog box, located under the Options menu. To use the Dimension Tool: 

¾ Click on the Measure  tool button; 

¾ Click on the Dimension  tool in the tool palette; 

¾ Click on the start point for the measurement; 

¾ While holding down the left mouse button, drag the on-screen cursor to the position which 
represents the end of the required dimension; 



Measure Tool 

¾ Upon release of the mouse button, drag the dimensioning arrows in the direction required 
(i.e., the direction the arrows will lie, typically away from the object being measured); 

¾ Click the mouse button again when satisfied with the results. 

OBJECT DIMENSION TOOL   
The Object Dimension  tool is designed to generate Vertical and horizontal measurements based on 
a specific object or group of objects. To use this tool, first select the object(s) required to draw 
dimensioning information. To use the Object Dimension Tool: 

¾ Select the object(s); 

¾ Click on the Measure  tool button; 

¾ Click on the Object Dimension  tool in the tool palette; 

¾ Click on the nub on the side or top of the selected object(s) required to draw dimensioning 
information. 

Note:  The cursor has turned into a cross hair 

¾ Drag the nub in the appropriate direction. 
The dimensioning arrows will appear on screen as formatted in the Dimension Setup dialog box.  

ARROW DRAW TOOL   
The Arrow Draw  tool provides the ability to draw arrows and to apply notes to objects. To use the 
Arrow Draw Tool: 

¾ Click on the Measure  tool button; 

¾ Click on the Arrow Draw  tool in the tool palette; 

¾ Click on screen at the point to place the arrow head; 

¾ Drag the first segment of the arrow to the point where it should end, and release the mouse 
button; 

¾ Drag the second segment of the arrow to its conclusion; 

¾ Click on the end point of the arrow. 
This will produces the Edit Notes dialog box. The operation of this box is discussed in the next section, 
The Notes Tool.  

NOTES TOOL   
The Notes  tool provides the ability to add descriptive notes to files. To operate the Notes Tool: 

¾ Click on the Measure  tool button; 

¾ Click on the Notes  tool in the tool palette; 

¾ Click on screen at the point to place the notes. 
This produces the Edit Notes dialog box. 
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Edit Notes Dialog Box 
This box can be accessed from within EZ-Engrave in three different ways: by clicking on a note and 
selecting Edit Notes from the Edit menu (or by double-clicking in the note); by drawing an arrow with 
the Arrow Draw Tool; or through the use of the Notes Tool. 

 
When this dialog box appears, begin to enter the text for the note immediately using the settings 
previously established for notes, or choose to change the font information for the notes. 

Changing Fonts: The Font Button  
Pressing the Fonts button produces the Font dialog box. 

 
This is a standard Windows dialog box, choose a font, font style (i.e., regular, bold, italic, or bold-
italic) and size of font for the notes. Because it is a Windows dialog box, only those fonts registered in 
Windows will be available (i.e., True Type and postscript).  
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TEXT TOOL  

TEXT TOOL - INTRODUCTION 
The  tool is used to create text messages from software fonts supplied by EZ-Engrave and other 
sources, such as a True Type Font Library. Full control over kerning, scaling, line width, font, line 
spacing, line positioning, and slant make this tool an effortless and powerful method to produce the 
most complex text passages. 

Activating Text Compose Modules 
To activate the Text Composition module, enter the password that activates the Text Compose tool . 
The correct password for the Text Composition module should have been received at the time the 
module was purchased from Roland or a EZ-Engrave re-seller. 
The password can be entered into EZ-Engrave during initial installation of the software, or, if the 
module was purchased subsequent to the initial installation of the EZ-Engrave software, enter the new 
password using the Install Modules option from the File menu. 

Installing the EZ-Engrave Fonts 
With the initial purchase of EZ-Engrave, some fonts may have already been installed during the 
installation procedure. However, if the modules with fonts were purchased subsequent to the initial 
purchase, perform the Install Fonts procedure available from the File menu (detailed in the section 
titled Install Fonts in the Foundation Chapter of this manual). 

Text Compose Options 
With the release of EZ-Engrave 5.0 there are two distinct ways to work with Text Composition: 

¾ The new on-screen text editing method, available only with versions 5.0 and newer, as 
described in the proceeding pages; and 

¾ The 4.95 text composition method using the Compose / Edit Text dialog box, as described at 
the end of this chapter. 

When using Text Compose, the default setting is the new on-screen text editing method, set with the 
installation of versions 5.0 or newer.  
To activate the 4.95 Text Compose using the Compose / Edit Text dialog box: 

¾ Open Setup fly-out menu available from the Options menu; 
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¾ Click on the Use 4.95 Text Layout option to activate it, a check mark appears next to the 
option. 

 
¾ To de-activate the Use 4.95 Text Layout re-select the option from the Setup fly-out menu. 

Composing Text Signage 
To start composing text: 

¾ Click on the Text Compose  tool in the Toolbox. 

¾ Click on the Text  tool in the fly-out menu that appears. 

¾ Move the  cursor to the position on screen where the text message is to appear and click 
the mouse. 

Compressing or expanding the composed text: 

¾ Move the cursor to the position on the screen where the text message is to appear and then 
drag the cursor to a new location to the right. 

The distance moved will determine the width of the text string. The text string will be compressed or 
expanded to fit within this space 
When the mouse button is released the Text tool bar appears at the top of the view screen: 

 

Keyboard Controls In Text Compose 
Any text message placed on a Engraving is composed from the keyboard. When using the keyboard, 
the following keystrokes should be remembered as having special functions: 
[BkSpc] Deletes character immediately to the left of the cursor 

[Del] Deletes character immediately to the right of the cursor. 

[Home] Sends cursor to first character in a text line. 
[End] Sends cursor to las haracter in a text line. t c

[Enter] Same as Carriage Return function on all standard word-processing applications, and indexes 
cursor to next line.  
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[Shift] Pressing [Shift] key while pressing another key accesses upper case character for the key or 
the top character of the two characters shown on the key pad. 

[ →] Pressing the arrow keys moves the cursor in the direction of the arrow whenever the cursor is 
inside the text view box or one of the pull-down menus. 

Characteristics Of EZ-Engrave Text 
¾ Any text composed and viewed on screen in one composing session (i.e., one mouse click 

with the Text  tool) will be designated as a paragraph of text; 

¾ Each paragraph of text composed with the Text tool  will be treated as a single entity. 
Each line of text may contain as many as 300 characters; 

¾ Each paragraph of text may contain as many as 20 lines of text; 

¾ Text can be edited after it has been transformed by any function which does not distort the 
shape of the characters in a paragraph, this includes Fit Text to Arc and Fit Text to Path; 

¾ To select individual lines or characters within a paragraph, when implementing changes 
without affecting other lines or characters in the paragraph, first ungroup the paragraph text 
into individual lines of text using the Ungroup option in the Layout menu, accessible by right 
mouse clicking on any nub of the Text group. 

 
¾ To separate the characters in a line from each other, ungroup the line. Any operation can 

then be performed on the individual character without affecting the other characters in the 
string. 

¾ Once the paragraph or line is ungrouped, the characters become individual objects. Even 
when re-grouped these characters will be seen as a group of objects, and not as a paragraph. 
Once a paragraph is broken up, it is broken permanently. 

¾ To transform a paragraph of text using any tool that physically changes the shape of the 
letters, the selected text will be converted into graphic format using the Text to Graphics 
option in the Arrange menu, before performing the transformation (EZ-Engrave does this 
automatically, when required). Once text has been converted to graphics, it cannot be 
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returned to a text state.  

 

Text Entry  
The Text Compose tools now sit directly on the view screen, and the Text is entered and edited directly 
on screen. Text may be entered from the keyboard, or it may be pasted from the Windows clipboard.  
Text entered into a Text paragraph remains ASCII text, and can be exchanged with the Clipboard. An 
example of this facility is seen in the Text Compose Tutorial included with the EZ-Engrave package as 
a separate booklet. 

FONT DETECTIVE  
The Font Detective dialog box is available in three ways: 

¾ By selecting the Font Detective  button in the Text tool bar when working in Text 
Compose; 

¾ By selecting the Add button in the Manage Favorite Fonts dialog box, available from the 
Options menu; 
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Font Display Box 
This box displays a section of the font selected. 

Group 
This drop-down menu list displays the group of fonts selected as they are divided on the EZ-Engrave 
Font CD. The groups to select from are: All Fonts; East European; Fancy; Line Font; Miscellaneous; 
Monument; Sans Serif; Script; Serif (Modern); and Serif (Roman). 

 

Group Options  
The Group Options fly-out menu is accessed by clicking on the Options button beside the Group 
display box. 

 

Add Group 
Selecting the Add Group button opens the Add Group dialog box. 

 

Group Name 
Insert the name of the new group in the Group Name box. 

Create New Group 
The Create New Group section offers three choices for adding a new group, activate one of the radio 
buttons to select a new group: 

¾ which is initially empty; 

¾ with the current filter selection; 

¾ with the contents of, below this option is a drop-down list that includes all of the groups 
currently available to choose from. 
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Delete Group 
Selecting the Delete Group option opens a warning box prior to deleting the currently selected group. 

 

Edit Group 
Selecting the Edit Group option opens the Group Editor dialog box. 

 

Source Group 
The Source Group is a drop-down list that gives access to all groups currently available, select a group 
from the list by clicking on it. 

Source Group Font List Box 
The Source Group font list box displays all the fonts within the selected group, any of the fonts in the 
list box can be selected for addition into the Current Group. As in most windows applications, the fonts 
can be [Shift] selected to select the entire list between the first and last selected, or the fonts can be 
[Ctrl] selected to select multiple fonts out of sequence. 

Add 
Pressing the Add button will add any selected font(s) from the Source Group to the Current Group. 

Add All 
Pressing the Add All button will add all fonts in the Source Group into the Current Group. 

Remove 
The Remove button is activated only if fonts in the Current Group are selected, pressing the Remove 
button will delete the font from the Current Group. As in most windows applications, the fonts can be 
[Shift] selected to select the entire list between the first and last selected, or the fonts can be [Ctrl] 
selected to select multiple fonts out of sequence. 
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Clear 
The Clear button removes all fonts from the Current Group. 

Current Group 
The Current Group is an information box stating the Font Group currently selected for editing.  

Current Group Font List Box 
The Current Group font list box lists all fonts in the Current Group, including those originally in the 
Group as well as those added during the editing session. 

Select Group 
The Select Group button will add the entire group of fonts to the source of origin as follows:  

¾ If Font Detective is accessed from the Font Detective  button in the Text Compose tool 
bar, the entire group of fonts is added to the font list available for the currently open file; 

¾ If Font Detective is selected from Add button in the Manage Favorite Fonts dialog box, the 
entire group of fonts is added to the Favorite Font list; 

¾ If Font Detective is selected by right mouse clicking the Text tool in the Text fly-out menu 
the Select Group button is not available. 

Font 
The Font box displays the selected font and opens into a drop-down menu list that can be scrolled 
through to choose different fonts within the selected Group. 

 

Uninstall Font 
The Uninstall Font option removes the currently selected font from the font list. There will be no 
warning notification and the font will not appear in the Group font list for any future editing sessions 
unless it is re-added. 

Note: If the font has already been loaded into the EZ-Engrave file it will remain 
available for the file. 

Select Font 
The Select Font button applies the font to the source of origin as follows:  

¾ If Font Detective is accessed from the Font Detective button in the Text Compose tool bar, 
the font is added to the font list available for the currently open file; 

¾ If Font Detective is selected from Add button in the Manage Favorite Fonts dialog box, the 
font is added to the Favorite Font list; 
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¾ If Font Detective is selected by right mouse clicking the Text tool in the Text fly-out menu 
the extended character set for the selected font is placed in the view screen. 

Show Filter 
Activating the Show Filter option opens the articulated Font Detective dialog box to display the full set 
of filter features available. 

 

Type  
Click on the down arrow to open the drop-down selection menu. Select from five different types of 
fonts: General; Text and Display; Hand Written; Decorative; and Pictorial. 
Within each of these types there are various styles of filters to mix and match to build, edit or modify 
font groups, these filters are accessed through the Tabs. 

Font Type  
The Font Type Tab list displays the format of font selected, there are four format types available: 
Adobe Type 1 (PFB), Roland VEF, Corel WFN, and True Type (TTY).  

Font Language 
The Language Tab option displays the language of font whether Arabic, Braille, Chinese, Cyrillic, 
Greek, Hebrew, Latin, Japanese, or symbol. 

Italic Style  
The Italic Tab option offers three styles of Italics: No Italic (no slant); Regular Italic (forward slant); 
and Reverse Italic (backward slant). 

Fill Style  
The Fill Style Tab option lists the types of fill available for the different font groups: solid font 
(normal); line font (routing and engraving); or bitmap font (digital printing). 
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List Box 
The List box displays the filters available within each Tab of a selected Type. 

   
General - Font Type Text and Display - Serif Style Hand Written - Spacing 

Viewer  
The View box displays a graphic depiction of the selected filter. 

       
Font Type - WFN Any Filter No Filter X-Height - Constant/Standard  

Select All  
The Select All button selects all filters available in the current list box. 

Clear 
The Clear button clears all selected filters available in the current list box. 

Filter  
The Filter button applies the selected filter parameters to the current Group. 

Reset  
The Reset button resets the filter parameters to the default setting. 

Show Properties 
Selecting the Show Properties option opens the selected font’s Properties dialog box. 

 
Within the Properties dialog box there are four tabs to select from: 

¾ General 

¾ Location 

¾ Panose (major) 

¾ Panose (minor) 
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General 
The General tab provides information regarding the Font Type, Font Family, Language, Fill Style, and 
Italic Style. The Font Type and Font Family sections cannot be edited. Care should be taken when 
editing any of the other options within the font’s Properties dialog box. Often if an edit is made, that 
can drastically effect the selected font or other fonts within the same family or type, the following 
dialog box (or one similar) appears: 

 
For detailed information regarding fonts, font types, and font families, access the font web site hosted 
by Hewlett-Packard at http://www.fonts.com. This web site is a resource setup by Hewlett-Packard to 
help customers locate and download a variety of font technologies including font files and font 
information. There is also a manual published by Hewlett-Packard, the HP Grey Book. The Grey Book 
is a fountain of font knowledge and can be extremely useful for those working with fonts extensively.  

Font Type 
The Font Type can be one of four different varieties of font: Adobe Type 1 (PFB), Roland VEF, Corel 
WFN, or True Type (TTY). 

Font Family 
The Font Family is determined by the name of the font. For example, Arial Bold Italic font is a 
member of the Arial font family. 

Language 
No Language .................This designates fonts that are not associated with any language.  
Arabic There is currently no Panose classification system for this language. 
Braille There is currently no Panose classification system for this language. 
Chinese There is currently no Panose classification system for this language. 
Cyrillic There is currently no Panose classification system for this language. 
Greek There is currently no Panose classification system for this language. 
Hebrew There is currently no Panose classification system for this language. 
Japanese There is currently no Panose classification system for this language. 
Latin Text and Display, Handwritten, Decorative, and Pictorial. See description on following 

pages for more information. 

Fill Style 
Solid Font ......................Solid fonts are fonts where all glyph contours are closed and filled. 
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Bitmap Font .................. A Bitmap font is one where there are areas of color rather than contours, 
defining the glyph shape. 

 
Line Font ...................... Line fonts are fonts where the glyph contours are open, often used in routing 

and engraving. 

 

Italic Style 
No Italic (normal) ......... Normal style fonts have no more than a 15º slant in either a forward or 

backward direction. 
Regular Italic ................ Regular Italic fonts are slanted a minimum of 15º degrees forward. 

 
Reverse Italic ................ Reverse Italic fonts are slanted a minimum of 15º degrees backward. 

 

Location 
The Location tab provides the following information: 

Path 
Path displays the directory structure leading to where the font resides on the system. Fonts that are 
installed into Windows directly will be listed as ‘Resident in Windows’. Fonts resident on a CD will 
list the path starting with the drive name of the CD-Reader (i.e., D:\European\…). 

Media Type 
The Media Type defines the source media, if the fonts are resident on a CD this will read CD-ROM, if 
the fonts are resident on a Removable Disk the Media Type  will read Removable Disk, etc… 

Volume Name 
The Volume Name will display the title of the specific object in the drive. For example the Roland 
Professional Engraving Fonts CD might read ProEngrave. 

Panose (major) 
Panose is a typeface matching system used to classify and/or match type styles. It was originally 
developed by Benjamin Bauermeister and is licensed to Hewlett-Packard Corporation. 
The Panose (major) attributes are those attributes that best describe the general appearance of a font. 

Family Kind 
All information relayed via the Panose (major) and Panose (minor) tabs is dependent upon the Family 
Kind. Within the Panose (major) tab depending upon which Family Kind selected certain of the 
following information is available and editable: 
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Text and Display 
The Text and Display classification is applied to fonts which are clearly derived from the Latin 
alphabet and which are produced primarily for legibility rather than for decorative purposes.  The 
letterforms of Latin text and display fonts have, whether serif or sans serif, a conventional appearance. 
Serif Style......................This digit describes the appearance of the serifs used in a font design and 

groups them into one of fourteen general categories. Serif and sans serif faces are classified 
within this digit, though less description is given to the stem terminators of sans serif styles. 

Weight The Weight digit classifies the appearance of a fonts' stroke thickness in relation to its 
height. This is expressed as a comparison of the measurements taken on the uppercase E 
glyph and the Upper H used before. 

Proportion......................The proportion of a font in the PANOSE Typeface Matching System is 
defined in greater detail than simply an indication of general glyph shape aspect ratio such as 
extended and condensed. It also compares the relative widths of a few standard characters 
that are often varied by type designers to give their typeface a certain historical or legible 
appearance. 

Contrast The Contrast digit describes the ratio between the thickest point on the stroke of the letter O 
and the narrowest point on the letter O. This ratio is called the ConRat and involves two 
relatively straight forward measurements. This measurement should not be confused with the 
sixth PANOSE digit, Stroke Variation. 

Handwritten 
Generally speaking, handwritten fonts are those which look like script and which do not have 
corresponding book faces. 
Tool Kind ......................Kind of implement predominately used to create character forms. Includes flat 

nib, pressure point, wild brush etc. 
Weight The Weight digit classifies the appearance of a font's stroke thickness in relation to its 

height. This is expressed as a ratio taken from two measurements on the uppercase E glyph. 
Spacing This digit allows monospaced and proportional fonts to be distinguished. 
Aspect Ratio ..................This is the ratio between the width and the height of the face measured using 

the Upper O .  

Decorative 
Latin Decorative faces are those that are designed more for impact than readability. Usually Decorative 
faces are used singly or in small groups, for special purposes. Small cap fonts are also included in this 
group because they have become unusual enough to be considered special purpose fonts. 
Class The class is the general look and feel of the face. Faces should be classed with as low a digit 

as is reasonable.  
Weight The Weight digit classifies the appearance of a fonts' stroke thickness in relation to its 

height. This is expressed as a ratio taken from two measurements on the uppercase E glyph.  
Aspect This is the ratio between the width and the height of the face.  
Contrast The Contrast digit describes the ratio between the thickest point on the letter O and the 

narrowest point on the letter O. 
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Pictorial 
Latin Pictorial is where all the nonalphabetic fonts reside. These are fonts that can be loaded like 
normal text fonts, but do not contain readable characters. Dingbats and specialized symbol fonts are 
two examples.  
Kind The kind classification determines the general nature of the symbol set.  For example a 

Montage classification would mean that there are a wide variety of themes described within 
the character set. 

Weight The Weight digit is required by the PANOSE engine, but is not meaningful for symbol faces, 
so it is always set to 1.  

Spacing This digit allows monospaced and proportional symbols to be distinguished.  
Aspect Ratio and Contrast ............ The Aspect Ratio & Composite digits is required by the PANOSE 

engine, but are not meaningful for symbol faces, so they are combined into this digit and 
always set to 1. 

Panose (minor) 
The Panose (minor) attributes are those attributes that best describe the more specific details of the 
appearance of a font. 
Within the Panose (minor) tab depending upon which Family Kind is selected certain of the following 
information is available and editable: 

Text Written and Display 
Stroke Variation............ Stroke variation classifies how the thick and thin segments of the uppercase O 

transition. Both the angle of the transition and the speed of the transition are measured. Note: 
If the Contrast is No Contrast, then there cannot be a Stroke Variation. 

Arm Style...................... The Arm Style category classifies two attributes of a glyph design: special 
treatment of diagonal stems and termination of open rounded letterforms. Most font designs 
will classify as Straight Arms/Wedge or Straight Arms/Single Serif. The uppercase A and C 
are used extensively for this classification. 

Letterform..................... Most sophisticated typeface designs alter the roundness of the character 
shapes in order to give the font a distinctive appearance or balance of white-space. This 
roundness is classified in the Letterform category. In addition to the glyph roundness, the 
predominant skewing of the character forms is also recorded and used to isolate oblique 
characters. The uppercase O is used to determine this classification. 

Midline The ninth category in the PANOSE classification system analyzes two traits, the placement 
of the midline across the uppercase characters and the treatment of diagonal stem apexes. 
The midline classification falls into one of four sub-categories: Standard, High, Constant, 
and Low. The apex treatment has only three variants: Trimmed, Pointed, and Serifed. 

X-Height Two different traits are represented in the X-height digit: the treatment of uppercase glyphs 
with diacritical marks (such as Ã) and the relative size of the lowercase characters. The 
classification of these traits are simple and straightforward. Note: If a face does not have 
lowercase glyphs, it is a Decorative. 

Handwritten 
Contrast The Contrast digit describes the ratio between the thickest point on the letter O and the 

narrowest point on the letter O. 
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Topology The topology classification is a two step process. First the cursive face is separated into 
Roman, Cursive, and Blackletter based on the letterforms and then the connections between 
the letters are classified.  

Form The form digit tries to measure the general look of the face. It combines two measures, the 
slope of the verticals and the wrap of the tails of connecting strokes, such as the curving 
stroke in the Upper D.  

Finials The Finials classification examines the ends of strokes, such as the right bottom of the lower 
a, and the appearance of the ascenders of the lower case characters, as in the letter l. 

X-Ascent The X-ascent classification describes the height of the lowercase characters relative to the 
uppercase characters. 

Decorative 
Serif Variant ..................The most sophisticated digit in the PANOSE classification system is the Serif 

Style digit. This digit describes the appearance of the serifs used in a font design and groups 
them into one of fourteen general categories.  

Treatment ......................This digit describes the treatment of the total letters. For the sake of this digit 
it is assumed that the character actually consists of two parts, the outline and the fill within 
the outline.  

Lining Lining refers to how the outlines of the characters are handled.  
Topology This digit attempts to encapsulate unusual characteristics inherent in the topology of the font. 

Sometimes faces have more than one of these characteristics and the classifier must make a 
judgment call. Remember that the reason for PANOSE numbers is to make distinctions, so 
choose what seems to best characterize the unique features of the font. 

Range of Characters ......This digit quantifies the range of characters available in the decorative font. 

Pictorial 
Aspect ratio of character 94...........The Aspect Ratio is taken to be the height of character 94 divided 

by the black width. Character 94 was chosen to be in the Lower ASCII range and thus 
usually used. 

Aspect ratio of character 119.........The Aspect Ratio is taken to be the height of character 119 divided 
by the black width. Character 119 was chosen to be in the Lower ASCII range and thus 
usually used. 

Aspect ratio of character 157.........The Aspect Ratio is taken to be the height of character 157 divided 
by the black width. Character 157 was chosen because it lies in the printer control area of the 
standard ASCII table and is thus often not used. 

Aspect ratio of character 163.........The Aspect Ratio is taken to be the height of character 163 divided 
by the black width. Character 163 was chosen to be in the Upper ASCII (8-bit ASCII) range 
and thus will likely be used only in an extended symbol set. 

Aspect ratio of character 211.........The Aspect Ratio is taken to be the height of character 211 divided 
by the black width. Character 211 was chosen to be in the Upper ASCII (8-bit ASCII) range 
and thus will likely be used only in an extended symbol set. 
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FONT LIST 
To the right of the Font Detective button is the Font List. When unselected the current font is displayed 
in the box with a down arrow button.  

 
By pressing the down arrow access is provided to the complete list of fonts registered and installed in 
EZ-Engrave.  

 
Scrolling down the list with either the mouse or with the down arrow key on the keyboard opens a fly-
out display window showing a reduced character set of the selected font. This handy feature provides a 
quick visual way to choose from all the fonts available. 

  

DEFINING TEXT ATTRIBUTES 
Before beginning to enter text from the keyboard, set the character and line attributes required by the 
present job, or generate the required text, and then sweep select all characters for formatting as 
necessary. EZ-Engrave’s Text Compose offers very precise control over the text being generated. 
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CHARACTER SECTION 
The Character section of the Text Compose tool bar allows for specification of the individual letter 
characteristics of the text being created.  

Font Height 
The Font Height edit box is used to specify the letter height of the text being entered, in the current 
unit of measurement. By convention, nominal height for a font is defined by the height of the upper 
case H.  Every font has height information embedded in its code, EZ-Engrave reads this code and 
assume it to be correct. The only exception occurs when the font height is specified as 0 (zero). Under 
these circumstances, EZ-Engrave measures the letter height of the upper-case H and uses this 
measurement as the letter height.  

 
To edit the Character Height either use the scroll bars to increase/decrease the Height value, or 
highlight the Height value and type in the required Height. Changes in height of characters will be 
applied to only the selected text and future text entered into the Text Entry box. 

Font Slant Degree 
The Font Slant option, when edited from the keyboard, allows the text to be tilted to the left or right as 
desired.  

 
The Slant is measured in degrees. Entering a positive value applies a forward slant (top toward the 
right) while a negative value applies a backward slant (top toward the left). 

 

Auto Kern Button 
Selecting the type of kerning required does not apply the Auto Kern function to the text unless Auto 
Kern is activated. To invoke Auto Kern, click on the Auto Kern button, the button will have an 
indented look when activated.  

 
To de-activate Auto Kern, click on the check box again, the button will appear as normal and 
unselected.  

 

Auto Kern 
EZ-Engrave’s Professional Text Compose has a special kerning routine that replaces the kerning 
information contained within a given font. The Auto Kern feature measures each pair of characters and 
then spaces them by balancing the white space between the characters. This usually results in text that 
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is more pleasing to the eye. Auto Kern is accessed by right mouse clicking the Auto Kern button, this 
opens Auto Kern’s dialog box: 

 

Styles 
There are five different Auto Kern styles available from this option: 

 

Normal 
The Normal style of kerning balances the amount of white space while maintaining a normal character 
spacing. 

Wide 
The Wide style of kerning places extra white space between characters. The additional space is 
roughly equal to the 120% of the normal spacing. 

Narrow 
The Narrow style draws characters closer together by reducing the amount of white space between 
them. The white space placed by this style is roughly equal to 80% of the normal spacing. 

Touching 
The Touching kerning style sets the spacing between letters such that they actually make contact with 
one another, but do not overlap. 

Overlap 
The Overlap kerning style causes adjacent letters to overlap by approximately 5% of the normal 
kerning space. 

Accuracy Vs. Speed 
Auto Kern works by measuring the distance between any two adjacent letters at several different points 
along the height of the letters. The accuracy of the spacing of letter pairs depends strongly on the 
number of points measured between them (points are a form of measurement). However, as the number 
of points measured increases, so does the amount of time required to calculate the proper spacing. EZ-
Engrave offers the ability to draw a balance between the speed of Auto Kern, and its accuracy. 
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Fast 
The Fast option measures only a limited number of points along the height of the letter pairs. This 
option typically provides quite acceptable results, and is very quick in calculating the space between 
letter pairs. 

Accurate 
The Accurate option measures a much larger number of points along the height of the letter pairs than 
the Fast option. As a result, this option is somewhat slower to calculate the appropriate spacing than 
the Fast setting, but provides more accurate results. 

Adjust For Engraving Tool Check Box 
The Adjust For Engraving Tool check box when activated provides the option to set the Toolbit 
Diameter. 

Toolbit Diameter 
When using a router or engraver, the Toolbit diameter can be set in this value box, EZ-Engrave will 
then allow for the diameter of the Toolbit when performing Auto Kern on any text. This feature 
ensures that text is kerned in appropriate way so that text kerned to a Wide setting and routing with a 
large bit still has a large pair kerning space, as opposed to overlapping. Either type in a value or use the 
scroll arrows to the right of the box. 

Kerning 
The option allows for changing the kerning of text.  

 
The changes made to the Kerning entry box are measured as a percentage of the natural kerning of the 
font. A setting of 100% is equal to the normal kerning. Lower values will draw letters closer together, 
while values greater than 100% will space the characters further apart. 
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LINE FORMAT SECTION 

Line Properties Button  
Pressing the Line Properties button opens the Text Line Properties dialog box: 

 
Within the Text Line Properties Line Length can be adjusted as either Free Length or Fixed Length.  

Free Length 
Free Length allows the line to run to its natural length based on the height, width, and kerning of the 
fonts in the line of text. Selecting the Free Length option adjusts the length of the lines based on the 
standard font settings. 

Fixed Length 
Fixed Length sets the line length as specified by an absolute value, in the unit of measurement pre-
determined in the General Preferences dialog box. Because the method for line width alteration must 
be specified, this option must be used in conjunction with the Compression option.  

Selecting the Fixed Length option activates the Horizontal Compression  button and value box 
. 

Horizontal Compression 
The Professional Text Compose module includes the option to control the length of lines of text as 
they are created. Horizontal Compression is the feature that controls this. 
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When using a compression type, specify a line length for the Compression function to operate. This 
length is specified under the Length option by activating the Fixed Length value in the Unit edit box. 
There actually two very different options for controlling Line Length, Compression, and 
Compression/Expansion. 
Choose Compression by activating the Compress text only when width exceeded radio button. Choose 
Compression/Expansion by activating the Always compress or expand text to fit width. 

Compression Vs. Compression/Expansion 
Compression allows for specification of a maximum length for a line of text. If the line of text does not 
reach that length, it will not be altered. If the line of text reaches that threshold length, EZ-Engrave 
will act upon it to restrict it from becoming longer.  
Conversely, Compression/Expansion allows for specification of the absolute length to which a given 
line of text is to be drawn. If the line of text is naturally shorter than the specified length, it will be 
expanded, while being naturally longer than the specified length will cause the text to be compressed. 
Put in simpler terms, specifying a Compression sets a Maximum length for a line of text, while a 
Compression/Expansion sets an Absolute length. 

Method 
The options available for Method of compression are: None; Width compression; Height compression; 
and Kerning compression. 

 
The options available for Method of Compression/Expansion are basically the same but apply also to 
the expansion, and are: None; Width compress/expand; Height compress/expand; Kerning 
compress/expand.  

 

None 
Click on this option and no restrictions will be applied to line length. Any text line will run freely 
according to the natural height, kerning, and width of the characters used in the text line. A Width 
value cannot be selected, when None is the selected Compression option. A warning to the effect that 
this change may cause text wrapping may appear. 

 

Width Compression 
Width Compression constrains a line of text to the specified maximum length by reducing the width of 
the characters in the line of text. This option will also reduce the character kerning proportionately, but 
will have no effect on character height. Because this is a simple compression type, it will only have an 
effect on the length of a line if it exceeds the value designated in the Units edit box. Otherwise, the line 
of text will be allowed to run freely according to the other parameters set in the Text Compose dialog 
box. 
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Height Compression 
Height Compression constrains a line of text to the specified maximum length by reducing the height 
of the font in the line of text. This option will also reduce the character width and kerning 
proportionately. Because this is a simple compression type, it will only have an effect on the length of 
a line if it exceeds the value designated in the Units edit box. Otherwise, the line of text will be 
allowed to run freely according to the other parameters set in the Text Compose dialog box. 

Kerning Compression 
Kerning Compression constrains a line of text to the specified maximum length by reducing the 
kerning between characters in the line of text. This option will have no effect on either character height 
or width. Because this is a simple compression type, it will only have an effect on the length of a line if 
it exceeds the value designated in the Units edit box. Otherwise, the line of text will be allowed to run 
freely according to the other parameters set in the Text Compose dialog box. 

Width Compression-Expansion 
Width Compression/Expansion forces the line of text to an absolute length by increasing or decreasing 
the width of the characters as necessary. Character Kerning will also be scaled proportionately, but 
character Height will not be affected. Any line of text composed with this option selected will be 
forced to the width specified in the Units edit box. 

Height Compression-Expansion 
Height Compression/Expansion forces the line of text to an absolute length by increasing or decreasing 
the height of the characters as necessary. Character Width and Height will also be scaled 
proportionately. Any line of text composed with this option selected will be forced to the width 
specified in the Units edit box. 

Kerning Compression-Expansion 
Kerning Compression/Expansion forces the line of text to an absolute length by increasing or 
decreasing the space between the characters as necessary. Character Width and Height will not be 
affected. Any line of text composed with this option selected will be forced to the width specified in 
the Units edit box. 

Apply To (Line Link and Direction) 
The Apply to options determine how the lines in a multi-line paragraph of text are linked and the final 
direction for the compression effect. There are three options to choose from: Each Line Individually; 
All Lines Equally; and Equal Height Lines. 

 

Each Line Individually 
This option allows for treatment of each line in the paragraph independently when applying a 
compression or compression-expansion. The effect of this type of link is that each line of text may 
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have very different height, width, or kerning characteristics. 

   

All Lines Equally 
Applying compression or compression-expansion to All Lines Equally causes all lines to be 
compressed or expanded equally such that the longest line in the paragraph will exactly match the 
length (or maximum length) specified for the compression. The effect of this type of link is that all 
lines in a given paragraph will maintain exactly the same kerning and character width characteristics, 
regardless of the height of each of the individual lines. 

Equal Height Lines 
Applying this type of line link causes all lines in which the characters are the same height to be 
compressed or expanded such that the longest line of text will exactly match the length (or maximum 
length) specified for the compression. The effect of this type of line link is that all lines of text with 
equal height will maintain the same character width and kerning information, but will not necessarily 
have the same characteristics as those line of text with different character heights. 

A Note About Line links And Character Height 
For the purposes of linking lines for Compression, the height of the characters in a given line of text is 
defined by the height of the first character in that line. This becomes important when using the Equal 
Height Lines link. If a given line of text contains a mix of character sizes, the entire line will be 
compressed or expanded as if it were composed solely of characters of the same height as the first 
character in the line. 

Word Wrap 
The Word Wrap feature can be activated by clicking in the check box. When activated a Wrap After a 
set percentage of Compression can be edited to suit the requirements of the text layout. Therefore if a 
line of text exceeds a set line Length or Compression/Expansion value and cannot reasonably be 
compressed further EZ-Engrave will Wrap the text to the proceeding line. 

 

Text Indent 
Also available with the Compression/Expansion is an automatic Text Indent feature. 

 
Text can be set to have a First Line Indent or a Hanging Indent, simply activate the appropriate radio 
button and set the required Indent value in the value box by using the scroll arrow or by highlighting 
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the current value and typing from the keyboard. 

      

Line Spacing 
This option allows for setting the vertical spacing between lines of text. Specifically, this option allows 
for specification of the distance between the baseline of the current line of text and the baseline of the 
line of text directly above it. The Line Spacing can be edited within the Line Properties dialog box or 
directly from the Text tool bar. 

 
This distance can be edited from the keyboard or by using the scroll arrows, and can be set in one of 
two ways from the Line Properties dialog box: 

Relative Spacing 
Select the Relative Spacing radio button for specifying the line spacing as a percentage of the font 
height in the current line, this will adjust the Line Spacing value box in the Text tool bar to read as a 
percentage value as well. A setting of 150% is usually a reasonable default. Enter the required value in 
the Line Spacing value box. 

 

Absolute Spacing 
Select the Absolute Spacing radio button for specifying the line spacing as an absolute value for font 
height in the current line, this will adjust the Line Spacing value box in the Text tool bar to read as an 
absolute value as well. Unit Spacing allows for specifying the line spacing in the current unit of 
measurement, pre-determined in the General Preferences dialog box. 

 

X Position, Y Position 
These options allow for setting the starting point for the baseline of any line of text at a specific 
position relative to the lower left corner of the Sign Blank. For example, an X Position of 1.00 and a Y 
Position of 1.00 will position the line of text so that its baseline begins 1 unit above and 1 unit to the 
right of the lower left corner of the Sign Blank. The position is set relative to the lower left of the sign 
blank in the current unit of measurement, pre-determined in the General Preferences dialog box. 

 

Note: When the Text Compose is first opened, the position of the cursor on screen 
where the mouse was clicked will determine the default values in the X Position and Y 
Position boxes for that editing session. These values will reflect the position of the 
cursor relative to the lower left corner of the sign blank. 
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FRAME PROPERTIES  
Pressing the Frame Properties button  while in Text Composition mode opens the Text Frame 
Properties dialog box. 

 
The purpose of framing text is to contain any text entered into the paragraph within a defined area of 
specified width and height. This is a great feature for controlling placement of text when there is a 
limited area for the text.  
Within the dialog box are controls for adjusting the width, as well as controls for the Height 
Compression, X and Y placement values, and Margin controls. 

Free Width & Fixed Width 
Explained in the Line Compression section earlier in this chapter (pp.19). 

Free Height 
Free Height allows the paragraph to run to its natural height based on the height, width, and kerning of 
the fonts in the lines of text. Selecting the Free Height option adjusts the length and height of the lines 
based on the standard font settings. 

Fixed Height 
Fixed Height sets the height of the paragraph as specified by an absolute value, in the unit of 
measurement pre-determined in the General Preferences dialog box. Because the method for line 
height alteration must be specified, this option must be used in conjunction with the Vertical 
Compression option.  

Selecting the Fixed Height option activates the Vertical Compression  button and value box . 
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Vertical Compression 
The Professional Text Compose module includes the option to control the height of lines of text as 
they are created. Vertical Compression is the feature that controls this. 

  
When using a compression type, specify a line height for the Compression function to operate. This 
height is specified under the Height option by activating the Fixed Height value in the Unit edit box. 
There actually two very different options for controlling Line Height, Compression, and 
Compression/Expansion (as explained in the Horizontal Compression section). 
Choose Compression by activating the Compress text only when height exceeded radio button. Choose 
Compression/Expansion by activating the Always compress or expand text to fit width radio button. 

Compression Vs. Compression/Expansion 
Compression allows for specification of a maximum height for a line(s) of text. If the line(s) of text 
does not reach that height, it will not be altered. If the line(s) of text reaches that threshold length, EZ-
Engrave will act upon it to restrict it from becoming higher.  
Conversely, Compression/Expansion allows for specification of the absolute height to which a given 
line or paragraph of text is to be drawn. If the line of text is naturally shorter than the specified height, 
it will be expanded, while being naturally longer than the specified height will cause the text to be 
compressed. 
Put in simpler terms, specifying a Compression sets a Maximum height for a line of text or paragraph, 
while a Compression/Expansion sets an Absolute height. 

Method 
The options available for Method of compression are: None; Character height compression; and Line 
spacing compression. 

 
The options available for Method of Compression/Expansion are basically the same but apply also to 
the expansion, and are: None; Character height compress/expand; and Line spacing compress/expand.  

 

None 
Click on this option and no restrictions will be applied to line height. Any text line will run freely 
according to the natural height, kerning, and width of the characters used in the text line. A Height 
value cannot be selected, when None is the selected Compression option. 
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Character Height Compression 
Character Height Compression constrains the lines of text to the specified maximum height by 
reducing the height of the font in the lines of text. This option will also reduce the character width and 
kerning proportionately. Because this is a simple compression type, it will only have an effect on the 
height of lines if they exceed the value designated in the Units edit box. Otherwise, the lines of text 
will be allowed to run freely according to the other parameters set in Text Compose. 

Line Spacing Compression 
Line Spacing Compression constrains the lines of text to the specified maximum height by reducing 
the spacing between lines in the paragraph of text. This option will have no effect on either character 
height or width. Because this is a simple compression type, it will only have an effect on the height of 
the lines if they exceed the value designated in the Units edit box. Otherwise, the lines of text will be 
allowed to run freely according to the other parameters set in Text Compose. 

Character Height Compression-Expansion 
Character Height Compression/Expansion forces the lines of text to an absolute height by increasing or 
decreasing the height of the characters as necessary. Character Width and Kerning will also be scaled 
proportionately. Any line of text composed with this option selected will be forced to the height 
specified in the Units edit box. 

Line Spacing Compression-Expansion 
Line Spacing Compression/Expansion forces the lines of text to an absolute height by increasing or 
decreasing the space between the lines as necessary. Character Width and Height will not be affected. 
Any line of text composed with this option selected will be forced to the height specified in the Units 
edit box. 

Apply To 
The Vertical Compression options can only be applied to All Lines. 

A Note About Character Height 
For the purposes of linking lines for Compression, the height of the characters in a given line of text is 
defined by the height of the first character in that line. This becomes important when using the Equal 
Height Lines link. If a given line of text contains a mix of character sizes, the entire line will be 
compressed or expanded as if it were composed solely of characters of the same height as the first 
character in the line. 

X Position, Y Position 
These options allow for setting the starting point for the baseline of any line of text at a specific 
position relative to the lower left corner of the Sign Blank. For example, an X Position of 1.00 and a Y 
Position of 1.00 will position the line of text so that its baseline begins 1 unit above and 1 unit to the 
right of the lower left corner of the Sign Blank. The position is set relative to the lower left of the sign 
blank in the current unit of measurement, pre-determined in the General Preferences dialog box. 

Margins 
The Margins option places the text within the paragraph s set distance away from the frame edge. The 
layout of the Margins value boxes relates to the Margin affected (i.e., the top value relates to the top 
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margin, the right value relates to the right margin, etc…). 

 
Use the scroll arrows to set the values, or highlight the current value and type in from the keyboard. 
The margins can only be set as positive or zero values. 

TEXT ORIENTATION 
The Text Orientation section controls the direction that type can be entered and displayed there are 
three choices available in this parameter. 

Horizontal Text  
Horizontal Text displays the text paragraph in order from left to right along a horizontal, top line to 
bottom line. 

 

Vertical Text  
Vertical Text displays the text paragraph in order from top to bottom along a vertical line, left line to 
right line.  

 

JUSTIFICATION 
Justification is the control that specifies the vertical point to which text will be aligned when 
generated. There are four options available in this parameter.  
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Left Justify  
Selecting the Left option causes the first characters of each line of text to be lined up vertically with 
the point selected by the Text tool  on the view screen. This option causes each line of text to run 
from a point on the left to the right, such that the left side of the paragraph is straight and linear, while 
the right side of the text is ragged. 

Center Justify  
Selecting the Center option causes the center of each line of text to be lined up vertically with the point 
selected by the Text tool  on the view screen. This option causes each line of text to run to the left 
and right from its center, such that both the left and right sides of the paragraph are ragged. 

Right Justify  
Selecting the Right option causes the last character of each line of text to be lined up vertically with 
the point selected by the Text tool  on the view screen. This option causes each line of text to run to 
a point on the right from the left, such that the right side of the paragraph is straight and linear, while 
the left side is ragged. 

Horizontal Compression  
The Horizontal Compression button opens the Horizontal Compression dialog box, explained earlier in 
this chapter (pp.19). 

LINE PLACEMENT/SPACING 
The Line Placement/Spacing options work in conjunction with the Line Spacing feature explained 
earlier in this chapter (pp.23).  

 
There are four choices for controlling Line Placement. 

Top Spacing  
The Top Spacing option, also the default setting, places the Y placement value at the top of the Text 
Paragraph. 

Center Spacing  
The Center Spacing option places the Y placement value at the center of the Text Paragraph. 

Bottom Spacing  
The Bottom Spacing option places the Y placement value at the bottom of the Text Paragraph. 

Vertical Compression  
The Vertical Compression option is only activated if the Vertical Text Orientation option is selected. 
The Vertical Compression then functions in the same manner as the Horizontal Compression (pp.25). 
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CASE CONTROL  
The series of Case Control buttons will reformat any selected text as follows: 

 Upper Case ........... This button converts all selected text to upper case characters. 

 Lower Case ........... This button converts all selected text to lower case characters. 

 Proper Name Case. This button causes characters that appear at the beginning of every selected 
word to be converted to upper case, while making all other selected characters lower case. 

CHARACTER PLACEMENT CONTROL  
The series of Character Placement Control buttons will reformat any selected text as follows: 

 Superscript ........... This button converts all selected text to Superscript characters.  
Right mouse clicking on the button opens the Superscript Properties dialog box. 

 

Height Value 
The Height value can be edited as a percentage value of the basic character setting. 

Raised Value 
The Raised value can be edited as a percentage of the basic character height and will raise any 
Superscript characters the given percentage value above the baseline of the text. 

 Subscript ............... This button converts all selected text to Subscript characters. 
Right mouse clicking on the button opens the Subscript Properties dialog box. 

  

Height Value 
The Height value can be edited as a percentage value of the basic character setting. 

Lowered Value 
The Lowered value can be edited as a percentage of the basic character height and will lower any 
Subscript characters the given percentage value below the baseline of the text. 
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 Unscript .................This button causes all selected characters that appear as Superscript or 
Subscript to be converted back to standard character placement. 

BULLETS  
The Bullets button  converts any selected text line to a bulleted format. 

 
Right mouse clicking on the Bullets button opens the Text Bullet Properties dialog box. 

 

Bullets Font 
The Bullets Font list displays all fonts available for use as bullets. Press the down arrow to open the 
drop-down menu list and select a font by clicking on it. 

Bullet Character Box 
The Bullet Character display box displays the currently selected character for use as the bullet, use the 
up or down arrows on the scroll bar to view the complete character set available for use as bullets, 
simply click to select the appropriate character. 

Browse Button 
Use the Browse button if a font is not readily available to open the Font Detective feature explained 
earlier in this chapter (pp.4). 

Height 
Set the height of the Bullet character to an absolute value based on the unit of measurement set in the 
General Preferences dialog box. 
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Bullet to Text Distance 
Set the Bullet to Text Distance to an absolute value based on the unit of measurement set in the 
General Preferences dialog box. The unit of measurement currently in use is displayed next to the 
value box. 

SPELL CHECK  
EZ-Engrave’s Professional Text Compose module is equipped with a Spell Check feature. To operate 
Spell Check, sweep-select the text to check and click on the Spell Check button . This opens the 
Spell Checker dialog box: 

   

Word Not Found 
The Word Not Found box displays the word that appears to be incorrectly spelled, the suggested 
replacement word (if any) in the Change To box.  

Suggestions 
In addition, a list of suggested replacement words will appear in the Suggestions box. 

Change To 
Where no suggestions are available, enter the appropriate word into the Change To box manually. 
Simply sweep-select the box, and enter the word as it should appear in the document.  

Verify 
To compare the spelling of a replacement word against the dictionary, press the Verify button. This 
causes the spell checker to look up the word in the dictionary. 

Context 
The context box shows the context of the word being used in a sample sentence, if the word is 
unknown no context will be shown. 
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Replace / Replace All 
Once satisfied with the replacement word, either press Replace, or Replace All, by pressing the 
appropriate button. Replace changes only the current selection of the word, Replace All changes all 
occurrences of the word in the selected paragraph. 

Add 
Where a word is perfectly legitimate, and should be added it to the personal dictionary, do so by 
clicking on the Add button. This causes the spell checker to add the word to the personal dictionary, 
and accept it, both currently and in the future, as a valid spelling. 

Ignore / Ignore All 
If the word is to be left as it appears (i.e., no changes) select the Ignore button for this instance of the 
word, or the Ignore All button for other instances in the current paragraph. 

New 
The New button provides the option of opening a new User dictionary, a prompt for a name for the 
dictionary occurs. Begin a new dictionary at any time by selecting New from the list. 

 

Main 
The spell checker uses two different dictionaries at any one time: the default dictionary which is 
supplied with Professional Text Compose, and a user-defined dictionary.  
There can be as many personal dictionaries as required, each with a unique name, but only one can be 
accessed at a time, in addition to the Main library supplied with EZ-Engrave. Select a Main dictionary 
to work from. EZ-Engrave provides an entire library of different language dictionaries, including: 
American English; Danish; Dutch; Finnish; French; German; Italian; Portuguese (Brazilian); Spanish; 
Swedish; and UK English.  
Any words added to the dictionary are included in the personal or user-defined dictionary, while the 
default dictionary remains constant. 

User 
To select a dictionary, click on the User list box, and select the name of the required dictionary from 
the list. Where no user dictionary exists, a prompt for a name for the dictionary occurs. Begin a new 
dictionary at any time by selecting New from the list. 
The ability to support multiple dictionaries can be particularly important when more than language is 
used. For example, in the southern United States, it is not uncommon to require both English and 
Spanish on some signs, while in Canada, English and French are often used together in signage. In 
these cases, develop a dictionary for the second language by adding new words to the dictionary as 
they occur in files. 
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Braille  
The Braille button  is used to operate the Braille module. If the Braille module has not been 
purchased from Roland or one of its re-sellers, this option will not be available, and will be grayed out. 
Please consult the chapter in this manual entitled The Braille Module for details on the operation of 
this feature. 

ON-SCREEN KERNING TOOL   
The On-screen Kerning tool , previously referred to as the Interactive Text tool in earlier versions of 
EZ-Engrave, is available from the Text fly-out menu of the tool bar is also available from the Text 
Compose tool bar when Text Compose is activated .  
This feature allows for making interactive adjustments to the text on screen. Specifically, adjust inter-
line spacing, line kerning, individual letter pair kerning, and alignment skew of existing text through 
the use of this tool. Access this tool by any of three methods: 

¾ Select an existing paragraph of text, click on the Text tool  in the tool bar, from the fly-out 
menu , click on the On-screen Kerning tool ; 

¾ Double-click on an existing paragraph of text and from the Text tool bar activate the On-
screen Kerning by pressing the button ; 

¾ Double-click on an existing paragraph of text while holding down the Control key to 
immediately activate the On-screen Kerning. 

A series of control handles appear on the selected text: Line Movement Handles, Line Kerning 
Handles, and Letter Kerning Handles. 

 
Each line of text in a given paragraph may be adjusted individually using the control handles. Click on 
a handle, a cross-hair will appear within the handle indicating that it is currently selected. All handles, 
once selected, may be moved using the arrow keys on the keyboard as follows: 

¾ Pressing an arrow key will move the text in the appropriate direction by one pixel; 
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Line Movement Handles 
These handles appear at each side of the text. In addition, one large Line Movement Handle will 
appear at the focal point of the text’s justification (i.e., left-justified text will have an additional handle 
on the left side of the line of text, right-justified, on the right, and center-justified at the center of the 
text). These handles, which appear as a small square nub, may be used to move any line of text from its 
current position independently from any other text in the paragraph, and without changing the 
appearance of the text. 

Line Movement And The Control Key 
By pressing and holding the CTRL key, constrain Line movements to 90° increments from the baseline 
of the text. For example, if text is rotated 30° from horizontal, holding the Control key while operating 
a Line Movement Handle will constrain the movement to 30°, 120°, 210°, or 300° from horizontal. 

Line Movement Handles And The Shift Key 
The Line Movement Handles may also be used to re-align lines of text to present a more artistic or 
striking appearance. Specifically, generate a new vertical axis for the alignment of several lines of text 
by moving any single line (other than the first line of text) while holding down the Shift key. For 
example, moving the last line of text in a series of four while pressing the Shift key will cause all lines 
of text in the paragraph to re-align themselves such that they take up positions that are evenly spaced 
both vertical and horizontally between the first and last lines. In other words... given this text: 

 
Moving the last line down and to the left produces these results: 

 
Note that each line of text has re-aligned itself to the axis created between the first and last lines of 
text, and that each line of text is evenly spaced relative to each other line. 

Line Kerning Handles 
The Line Kerning Handles allow for adjustment of the kerning in any given line of text independently 
of other lines in the paragraph. These rectangular handles will always appear on the side of the text 
opposite the focal point of the text’s justification (i.e., on the right for left-justified text, on the left side 
for right-justified text, and on both sides for center-justified text) as a larger circular handle. There are 
two modes for this tool: inter-character mode, and inter-word mode. 
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Inter-Character Mode 
By dragging the Line Kerning handle, the kerning of all characters, including the space between 
words, will be adjusted to fit between the Line Kerning handle and the focal point of the line. This 
allows for adjustment of the length of a given line of text by changing the kerning, or adjustment of the 
kerning of the text by extending or shrinking the line length. 

Inter-Word Mode 
To adjust the length of a line of text without affecting the kerning of the letter pairs in the text, press 
and hold the Control key while dragging the Line Kerning handle. This causes the inter-word spacing 
to expand or contract without affecting the space between letter-pairs in the line of text.  

Character Kerning Handles 
Each character in a given line of text, including space characters, has an associated Character Kerning 
handle, that appears directly below the character in the form of a small round nub. These handles are 
useful in adjusting letter-pair kerning without changing the kerning characteristics of the other letter 
pairs in the line of text. 
When moving any Character Kerning handle, both the selected character and all characters that are 
away from the focal point of the line of text will be moved. For example, given a left-justified line of 
text, any adjustments made using the Character Kerning handles will cause all of the characters to the 
right of the selected character to move with the selected character. 
To move a selected character independently from all other characters in the line of text, simply press 
and hold the CTRL key while moving the character. This allows for changes to be made without 
affecting the position of the others letters in the line of text.  

TEXT AUTO LAYOUT  
Create an effective pleasing layout, quickly and easily with the Auto Layout feature of EZ-Engrave. 
Auto Layout supports manual setup of a plate as well the development of plates based on the 
relationships between the elements included in the layout. 

The Text Auto-Layout tool  available from the Text fly-out menu in the tool bar is also available 
from the Layout menu as the Auto-Layout option.  

Note: When working with the Auto Layout feature, the Undo function is temporarily 
disable. As a result, be careful about using the delete function available in Auto Layout. 

Auto Layout operates by placing various cells in a pattern of lines. Text and/or graphics can be placed 
within each cell. Each layout (pattern) contains at least one line with one cell, however each layout can 
contain many lines with each line containing a different number of cells, as many as required for a 
particular pattern. The cells are represented in EZ-Engrave by a blue box. Within each cell there is a 
representation of a default text alignment, that appears in red. The Cell height represents the height of 
the text or graphic to be placed within the cell (note that letter height is defined as the nominal height 
of the upper case 'M' in any given typeface). 
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When either the Auto Layout button in the Text fly-out menu or the Auto Layout option from the 
Layout menu is selected the Auto Layout dialog box opens. 

 
The Auto Layout feature provides the ability to create layouts and save them for later use in other 
projects. When Auto Layout is first accessed, the Open Layout dialog box is also opened, to provide 
immediate access to previously saved layout (*.lyt) files. 

 
The Open Layout dialog box behaves in the same manner as the EZ-Engrave Open dialog box for files, 
however there are fewer options to choose from. The only new feature in the Open Layout dialog box 
is the Open as read-only option, which when selected opens the *.lyt file as a read only file. This 
ensures protection of the *.lyt file, as the new file must be saved under a new name. 
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Plate 
Selecting the Plate button opens the Plate Dimensions dialog box, to set the size of the plate (width by 
height) and the number of lines to be included within the plate. 

 

Plate Dimensions 
The Plate is the rectangle upon which the layout is created. It is typically sized to match the substrate 
(i.e., badge, plaque, or other finished product) for final output. 
The default plate size is equal to the size of the selected object when Auto Layout is accessed. If no 
objects are selected (or more than one object is selected), the plate size is defaulted to the size of the 
Sign Blank.  

Number of Lines 
A Line is a series of boxes (or Cells) that runs from left to right across the layout, and into which text 
or graphics are inserted.  
Set the size parameters first, then set the number of lines of text these values can be edited later if 
required. 

OK 
Pressing OK accepts the data and returns to the Auto Layout dialog box. 

Advanced 
The Advanced button opens the Advanced dialog box providing access to more advanced features in 
the setup of the Auto Layout tools, including the ability to develop layouts using specific relationships 
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between objects within the layout. 

 

Margins 
There are four margins in any layout: top, bottom, left, and right. These margins represent the distance 
between the nearest edge of a cell (or cells) and the edge of the plate. The margins for each layout are 
indicated in each of the four corners by crop marks, these crop marks appear green on-screen. 

Left / Right Margins 
The left and right margins can be specified as a percentage of the plate width, or as an absolute value 
by selecting the appropriate radio button. The values for the margins can then be set in the entry boxes 
on the right. 

Top / Bottom Margins 
The top and bottom margins can be specified by the user or by a mathematical formula, simply select 
the appropriate radio button: User Specified, or Formula.  

User Specified 
Specify the top and bottom margins manually as a percentage value of the height of the plate, or as an 
absolute unit value by selecting the appropriate radio button. The values for the margins can then be 
set in the entry boxes on the right. 

Formula 
Selecting the Formula option, causes EZ-Engrave to calculate the top and bottom margins 
automatically based on the Offset value and Multiplier value entered combined with the number, size, 
and spacing of the lines included in the plate. 

Note: Inter-line spacing is the distance between the bottom of any given line and the top 
of the line directly below it 
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Offset 
The Offset setting specifies the difference in height between the upper and lower margins as a 
percentage value of the entire plate height. A positive value causes the bottom margin to be larger than 
the top margin, while a negative value has the reverse effect. 

Multiplier 
The Multiplier setting governs the ratio of inter-line spacing with the top and bottom margins. 
Specifically, this number represents the top and bottom margin size as a multiple of the average inter-
line space. 
For example, if the inter-line spaces average 1 inch in size, and the multiplier is 2, then the average 
size of the top and bottom margins is 4 inches. 

Compression Mode 
Where necessary, text is compressed to fit into the cells defined in the layout. Cells can have the 
compression mode set independently of other cells or as a group. The method used for linking the lines 
in a layout determines the final effect of the compression style applied. There are three compression 
modes to choose from: Lines individually; All Lines Equally; and Equal Height Lines. 

Lines Individually 
The Lines Individually option provides the ability to treat each line in a paragraph independently when 
applying a compression. The effect of this compression mode is that each line of text may have very 
different height, width, and kerning characteristics. 

All Lines Equally 
Applying compression to All Lines Equally causes EZ-Engrave to find the cell that requires the most 
compression, and then compress all others to the same extent. The effect of the compression mode is 
that all cells in a layout display the same width and kerning characteristics, regardless of the height of 
the text in each line. 

Equal Height Line 
EZ-Engrave treats all the cells with text of the same height as a group for the purposes of compressing 
text when the Equal Height Lines compression mode is selected. EZ-Engrave finds all the cells of the 
same height and then selects the cell that requires the most compression. EZ-Engrave then applies this 
compression value to all cells of the same height. The effect of this type of compression mode is that 
all lines of text with equal height display the same width and kerning values, but not the same width 
and kerning values as those lines of text with different height values. 

Also Compress Characters 
All text entered into a line or cell will be compressed by EZ-Engrave to fit within the boundaries of the 
cell. When this option is de-activated only the kerning (space between characters) is affected. When 
this option is activated the character width itself will also be compressed along with the kerning. 

Open, Save, Save As 
The auto Layout feature provides the ability to create layouts in EZ-Engrave and save them for later 
use with other projects. The Open, Save ,and Save As buttons allow for the creation, modification, and 
use of layout files, in the *.lyt file format. 
The Open Layout and Save Layout dialog boxes behave in the same manner as the EZ-Engrave Open 
and Save dialog boxes, however there are fewer options to choose from. The only new feature is the 
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Open as read-only option, which when selected opens and/or saves the *.lyt file as a read only file. The 
read-only format ensures protection of the *.lyt file, as any new file must be saved under a new name. 

 

Line and Cell Controls 

 

Insert Line Before Selected  
The Insert Line Before button inserts a line of cells above the currently selected line. The new line will 
be identical to the currently selected line, except that the cells will not contain any text. 

Insert Line After Selected  
The Insert Line After button inserts a line of cells below the currently selected line. The new line will 
be identical to the currently selected line, except that the cells will not contain any text. 

Delete Selected Line  
The Delete Selected Line button removes the currently selected line of cells. Deleting a line also 
deletes the contents of the cells within the line, including a text. 

Note: The Undo feature is not available in Auto Layout, as such be careful when 
deleting lines, as critical layout information can be deleted along with the corresponding 
lines. 
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Insert Cell Before Selected  
The Insert Cell Before button inserts a cells to the left of the currently selected cell. The new cell will 
be identical to the currently selected cell, except that it will not contain any text.  

Insert Cell After Selected  
The Insert Cell After button inserts a cells to the right of the currently selected cell. The new cell will 
be identical to the currently selected cell, except that it will not contain any text.  

Delete Selected Cell  
The Delete Selected Cell button removes the currently selected cell. Deleting a cell also deletes the 
contents of the cell, including a text. 

Note: The Undo feature is not available in Auto Layout, as such be careful when 
deleting cells, as critical layout information can be deleted along with the corresponding 
cells. 

Text Justification Controls 
When developing text layouts in Auto Layout, there are three justification options for the text 
alignment: Left, Center, and Right. The justification of the text can be defined cell by cell. To set the 
justification for a cell simply select the cell and press the appropriate justification button.  

 

Left Justify  
Left justify the text in the cell by pressing this button. 

Center Justify  
Center justify the text in the cell by pressing this button. 

Right Justify  
Right justify the text in the cell by pressing this button. 

Text Entry Box 
The Text Entry box is used to enter text into the selected cell. 
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Once text has been entered and the OK button is pressed the Font Detective opens to provide access to 
select the font for the layout. 

 
For more information on the Font Detective see page 3-4 of this chapter. 

View Line Info 
Activating the View line Info, by placing and x in the checkbox, extends the Auto Layout dialog box 
to include specific information about the selected line. 

 

Save The Layout To File 
This pair of entry boxes provides the ability to navigate between the cells and lines of the layout. 
Either enter the appropriate number in the entry field or use the scroll arrows to scroll through the 
cells. Cell numbers are in ascending order from left to right, top to bottom. 
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Line and Cell Number 
This pair of entry boxes provides the ability to navigate between the cells and lines of the layout. 
Either enter the appropriate number in the entry field or use the scroll arrows to scroll through the 
cells. Cell numbers are in ascending order from left to right, top to bottom. 

% and Absolute Spacing 
The percent and absolute spacing represent the distance from the top of the selected cell to the bottom 
of the cell immediately above. The distance can be specified as either a percentage or absolute value. 

Relative Height 
This box provides the ability to set the height of the selected line based on the size of the other lines in 
the layout. For example, setting the line to 100% causes another line with a Relative Height of 50% to 
be half the height of the 100% line, while another line set at 150% will be one and a half times the 
height of the selected 100% line. Editing the Relative Height effects the Absolute Height value. 

Absolute Height 
This box provides the ability to set the height of the line as an absolute value. Editing the Absolute 
Height effects the Relative Height value. 

% Cell Spacing 
This setting is used to define the spacing between the cells in the selected line. Specifically, the space 
between the cells is defined as a percentage of the width of the cells. 

Main View Controls with Auto Layout 
There are several controls available in the main view screen. These controls operate differently 
depending on whether you have selected User Defined or Formula in the Advanced layout dialog box. 
The difference between these two modes is that the Formula mode always recalculates the margins, 
cell sizes, and interline spacing such that they meet the specifications in the Advanced layout dialog 
box, while the User Specified mode maintains the settings for margins and spacing. 
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Various parts of the Auto Layout template as seen on the main view screen. 

 
¾ The plate outline is blue;  

¾ The four margin marks (crop marks) are green; 

¾ The control nubs are red, with each line having four: right, left, top, and bottom; 

¾ The text alignment indicators are red, with each cell containing one indicator; 

¾ The cell outlines are blue, with the selected cell denoted by a red frame within the outline. 

Keyboard Control Options within Auto Layout 
There are also several control options, for adding, cells and lines as well as navigating from cell to cell, 
available when in the Auto Layout dialog box: 

¾ Pressing [Enter] after entering text in box adds an identical line of cells below the selected 
cell; 

¾ Pressing [Shift+Enter] ads an identical cell to the selected line, and resizes the cells to fit the 
line; 

¾ Pressing [Tab] shifts the focus into the next adjacent cell in the layout (moving from left to 
right, top to bottom); 

¾ Pressing [Shift+Tab] shifts the focus to the previous adjacent cell in the layout (moving from 
right to left, bottom to top); 

¾ Pressing the [Up or Down Arrow] on the keyboard move the focus to the cell before (UP), or 
after (Down) the currently selected cell. 

Mouse Control Options within Auto Layout 
Adding cells or lines and deleting cells in the layout can also be achieved using the mouse on the main 
view screen. The height attributes of lines and width attributes of cells and margin sizes can also be 
controlled using the mouse on the main view screen. 

Adding a cell or line 
To add a cell or line of cells combine a right mouse click with a keyboard command, as follows: 

8-44 • EZ-Engrave User Guide 



Text Tool  

EZ-Engrave User Guide • 8-45 

¾ Click on the top control nub while holding [Shift] to place a new line of cells above the 
selected nub, the new line will be identical to the line directly beneath it, including cell and 
text attributes; 

¾ Click on the bottom nub while holding [Shift] to place a new line of cells below the selected 
nub, the new line will be identical to the line directly above it, including cell and text 
attributes; and/or 

¾ Click on any cell while holding [Shift} to place a new identical cell to the right of the 
selected cell, all cells in the line will be resized to fit within the plate. 

Deleting a cell 
To delete a cell combine a right mouse click with a keyboard command as follows: 

¾ Click on any cell while holding [Control] to delete the selected cell, the remaining cells in 
the line will be resized to fit within the plate. In the case of a line that contains a single cell 
being deleted, all remaining lines will be resized to fit within the plate. 

Changing Margin Sizes 
To change the margin sizes combine a right mouse click with a keyboard command as follows: 

¾ Drag the top nub of the top line, or the bottom nub of the bottom line to adjust the top and 
bottom margins of the layout (if Formula mode is selected the will have no effect); 

Changing Line Attributes 
To change the attributes of a line of cells combine a right mouse click with a keyboard command as 
follows: 

¾ Drag the top or bottom nub of any line (other than the top-most or bottom-most nubs) to 
change the height of the selected line and it's inter-line spacing. If Formula mode is selected 
this will also cause changes to all of the other lines, so the layout maintains the specified 
requirements in the Advanced Layout dialog box; 

¾ Drag any side nub to change the selected margin size for the selected line, shrinking the cell 
widths within the line to fit the new line size. The cell spacing maintains the setting specified 
in the % Cell Spacing; 

¾ Drag any side nub while holding [Control] to change both margin sizes for the selected line, 
for example if the right margin is already set to twice the size of the left margin this ratio will 
be maintained while both margin sizes are either increased or decreased. This feature 
restricts the size of the line to respect the ratio of the margin sizes while maintaining the 
minimum margin setting defined in the Advanced Layout dialog box; 

¾ Drag any side nub while holding [Shift] to reset the selected line to be centered in the layout 
while resizing the margins, all cells are resized to fit within the new line width; 

¾ Drag any side nub while holding [Shift+Control] to move the selected line of cells laterally 
within the constraints of margin width settings in the Advanced Layout dialog box (if the 
line measures the full margin width it cannot be moved). 

EDITING TEXT 
Once entered into the Text Paragraph box, text can be edited. To do so, double-click the paragraph 
box, sweep-select the text to edit, and make the changes required. To add to a text paragraph, insert the 
cursor where the new text is to be added, set any options as required, and enter the text. 
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Editing Text Displayed on the View Screen 
To edit text displayed on the view screen, first select the text and open Text Compose with the selected 
text as the target paragraph: 

¾ Click on any character of the paragraph of text to edit with the Text  tool; 

¾ Select the Edit Text option from the Edit menu; alternatively 

¾ Double-click on any part of the paragraph of text. 
The Text Compose tool bar will appear at the top of the view screen with the selected text paragraph 
ready for editing.  

VIEW EXTENDED CHARACTER SETS 
EZ-Engrave has the added functionality of printing the entire extended character set for a given font 
onto the view screen.  Right mouse click on the Text Compose  tool from the Text fly-out menu in 
the tool bar, the Font Detective dialog box opens: 

  
Select the font of choice and press the Select Font button, the selected font will be placed in the view 
screen. 
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COMPOSING TEXT SIGNAGE USING 4.95 METHOD  
To start composing text: 

¾ Click on the Text Compose  tool in the Toolbox. 

¾ Click on the Text  tool in the fly-out menu that appears. 

¾ Move the  cursor to the position on screen where the text message is to appear and click 
the mouse. 

Compressing or expanding the composed text: 

¾ Move the cursor to the position on the screen where the text message is to appear and then 
drag the cursor to a new location to the right. 

The distance moved will determine the width of the text string. The text string will be compressed or 
expanded to fit within this space 
When the mouse button is released the following screen appears: 

   
Expanded view     Reduced  view 
This dialog box is articulated and can be expanded to display all of the available options in Text 
Compose (shown), or it can be contracted to conserve space on screen. When the dialog box is 
expanded to full size, pressing the button reduces it to a smaller size. When operating in the smaller 
mode, pressing the button returns the dialog box to full size. 

Text Entry Box 
The Text Compose dialog box contains a text entry box where text messages from the keyboard are 
entered. Text may be entered from the keyboard, or it may be pasted from the Windows clipboard.  
Text entered into the Text Entry Box remains ASCII text, and can be exchanged with the Clipboard. 
An example of this facility is seen in the Text Compose Tutorial included with the EZ-Engrave 
package as a separate booklet. 
Along the bottom of the Text Entry Box are three indicators: Line; Column; and Length. 
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Line Indicator 
Line indicates the line number on which the cursor is positioned at any time. The first line is number 
one, the second line is number two, etc... 

Column Indicator 
Column indicates the sequential number of the current character at which the cursor is positioned. The 
first character in a line is character number one, the second character in a line is number two, etc... 

Length Indicator 
Length indicates the length of the current line on which the cursor is positioned. The length is 
indicated in the unit of measurement as selected in the General Preferences dialog box. 

Defining Text Attributes 
Before beginning to enter text from the keyboard, set the character and line attributes required by the 
present job, or choose to generate the required text, and then sweep select all characters for formatting 
as necessary. EZ-Engrave’s Text Compose offers very precise control over the text being generated. 

Justify 
Justification is the control that specifies the vertical point to which text will be aligned when 
generated. There are four options available in this parameter.  

 

Left 
Selecting the Left option causes the first characters of each line of text to be lined up vertically with 
the point selected by the Text tool  on the view screen. This option causes each line of text to run 
from a point on the left to the right, such that the left side of the paragraph is straight and linear, while 
the right side of the text is ragged. 

Right 
Selecting the Right option causes the last character of each line of text to be lined up vertically with 
the point selected by the Text tool  on the view screen. This option causes each line of text to run to 
a point on the right from the left, such that the right side of the paragraph is straight and linear, while 
the left side is ragged. 

Center 
Selecting the Center option causes the center of each line of text to be lined up vertically with the point 
selected by the Text tool  on the view screen. This option causes each line of text to run to the left 
and right from its center, such that both the left and right sides of the paragraph are ragged. 

None 
The None option performs in the same manner as the Left option. 
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Character Section 
The Character section of the Text Compose dialog box allows for specification of the individual letter 
characteristics of the text being created. 

 

Height 
This edit box is used to specify the letter height of the text being entered, in the current unit of 
measurement. By convention, nominal height for a font is defined by the height of the upper case H.  
Every font has height information embedded in its code, EZ-Engrave reads this code and assume it to 
be correct. The only exception occurs when the font height is specified as 0 (zero). Under these 
circumstances, EZ-Engrave measures the letter height of the upper-case H and uses this measurement 
as the letter height. 
To edit the Character Height either use the scroll bars to increase/decrease the Height value, or 
highlight the Height value and type in the required Height. Changes in height of characters will be 
applied to only the selected text and future text entered into the Text Entry box. 

Kerning 
This option allows for changing the kerning of text. The changes made to the Kerning entry box are 
measured as a percentage of the natural kerning of the font. A setting of 100% is equal to the normal 
kerning. Lower values will draw letters closer together, while values greater than 100% will space the 
characters further apart. 

 

Slant 
This option, when edited from the keyboard, allows the text to be tilted to the left or right as desired. 
The Slant is measured in degrees. Entering a positive value applies a forward slant (top toward the 
right) while a negative value applies a backward slant (top toward the left). 
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Font 
This scroll box allows for the selection of a font from the active fonts list. The active font list includes 
all of the fonts registered within the currently open file, and any font designated as a Favorite Font in 
the Manage Favorite Fonts option from the Options menu. 

 

Font Browse Button  
Pressing the Font Browse button opens the Select Font dialog box: 

 
The Select Font dialog box is used to navigate through the system to select fonts compatible with EZ-
Engrave from any drive or directory. To select a font, click on the scroll arrow and scroll through the 
list, clicking on the name of the font required.  

Format  
This drop down list displays the format of font selected, there are five format types available for use 
with EZ-Engrave: PFB, TTY, VEF, WFN, and SGI.  

 

Font  
This box displays the selected font, use the scroll arrows to scroll through the directory, at the bottom 
of the list the drive directories and double dots (for accessing the previous level in the directory 
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structure are available. 

 

Font Language 
This option displays the language of font whether Arabic, Braille, Chinese, Cyrillic, Greek, Hebrew, 
Latin, Japanese, or symbol. 

Sample (ANSI code) 
Because computers understand numeric information only, each character in a typeface has a numeric 
value assigned to it. This numeric value, known as an ANSI code, is used by the computer in place of 
the 256 character shapes contained in standard typefaces. 
The ANSI code and Character boxes allow for scrolling through a font by either the ANSI code or the 
characters. 
ANSI code is particularly useful as it allows for selection of characters that may not appear on the 
keyboard. For example the extended character sets which include special characters such as the Ç 
commonly used in French. To use ANSI characters insert the code for the character while depressing 
the Alt key ([Alt+0199] equals Ç).  

Character Display 
The Character display box shows the selected character as it appears in the selected font. To view other 
characters, enter that character into the character box (or the ANSI code in the ASNI code box). 

 

Style 
 Most fonts contain a single typestyle (i.e., bold, italic, etc…). However, some fonts are supplied with 
different typestyles embedded into the one font file. For example, some of the WFN fonts supplied 
with earlier versions of CorelDRAW!TM. Fonts with several styles associated within a single file will 
have options displaying the available styles in the Style drop-down menu. 
Once a font has been selected, all of the text generated will appear in that font until another is selected. 
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Load 
The Load button behaves in a similar fashion to the Apply button in other dialog boxes, it will install 
the font to the file without closing the Select Font dialog box, allowing for further fonts to be loaded. 

Note: For more information about selecting fonts see Manage Favorite Fonts in the 
Options Menu section of this chapter. 

ANSI Characters 
Because the computer understands only numeric information, each character in a typeface will have a 
numeric value assigned to it. This numeric value, known as an ANSI code, is used by the computer in 
place of the 256 character shapes contained in most standard typefaces.  
ANSI codes are particularly useful, because they allow for selection of characters that may not appear 
on the keyboard. For example, if the sign being created requires a special character, such as the ‘Ç’ 
commonly used in French, insert the ANSI code [Alt+0199] into the text, and the required character 
appears in place. 

Entering Extended ANSI Characters Into Text Compose 
There are two methods by which an ANSI character can be entered into the EZ-Engrave Text Compose 
dialog box once the ANSI code is found: 

¾ Position the cursor where the character is to be placed in the Text Entry box, press and hold 
the [Alt+0xxx] (zero) where xxx equals the ANSI code, or 

¾ Cut and Paste the character from the Character display box in the Select Font dialog box into 
the Text Entry box where the character is required. 

Case Control  
The series of Case Control buttons will reformat any selected text as follows: 

 This button converts all selected text to lower case characters. 

 This button converts all selected text to upper case characters. 

 This button causes characters which appear at the beginning of every selected word to be 
converted to upper case, while making all other selected characters lower case. 

Line Format Section 
The Line Format section is available from the bottom area when the articulated Text Compose dialog 
box is in the expanded state. The options within the Line Format area are: Width; Spacing; XPosition; 
Yposition; Compression Type; and Line Link and Direction. 
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Width 
The Width entry box is used to control the width of any line of text. Specify the line length in one of 
three ways: 

¾ Free Width allows the line to run to its natural length based on the height, width, and kerning 
of the fonts in the line of text. 

¾ Percentage (%) Width sets the width of the line to a specified percentage of the natural width 
of the line. This option must be used in conjunction with the Compression option discussed 
earlier in this chapter in order to have an effect. 

¾ Unit Width sets the line length as specified by an absolute value, in the unit of measurement 
pre-determined in the General Preferences dialog box. Because the method for line width 
alteration must be specified, this option must be used in conjunction with the Compression 
option discussed earlier in this chapter. 

Line Spacing 
This option allows for setting the vertical spacing between lines of text. Specifically, this option allows 
for specification of the distance between the baseline of the current line of text and the baseline of the 
line of text directly above it. This distance can be edited from the keyboard or by using the scroll 
arrows, and can be set in one of two ways: 

¾ Percentage (%) Spacing allows for specifying the line spacing as a percentage of the font 
height in the current line. A setting of 150% is usually a reasonable default. 

¾ Unit Spacing allows for specifying the line spacing in the current unit of measurement, pre-
determined in the General Preferences dialog box. 

X Position, Y Position 
These options allow for setting the starting point for the baseline of any line of text at a specific 
position relative to the lower left corner of the Sign Blank. For example, an X Position of 1.00 and a Y 
Position of 1.00 will position the line of text so that its baseline begins 1 unit above and 1 unit to the 
right of the lower left corner of the Sign Blank. The position is set relative to the lower left of the sign 
blank in the current unit of measurement, pre-determined in the General Preferences dialog box. 

Note: When the Text Compose dialog box is first opened, the position of the cursor on 
screen where the mouse was clicked will determine the default values in the X Position 
and Y Position boxes for that editing session. These values will reflect the position of 
the cursor relative to the lower left corner of the sign blank. 
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Compression 
The Professional Text Compose module includes the option to control the length of lines of text as 
they are created. Compression Type is the feature that controls this. 

  
When using a compression type, specify a line width for the Compression function to operate. This 
length is specified under the Width option by entering a value in the Unit edit box. 
There actually two very different types of control, Compression, and Compression/Expansion. 

Compression Vs. Compression/Expansion 
Compression allows for specification of a maximum length for a line of text. If the line of text does not 
reach that length, it will not be altered. If the line of text reaches that threshold length, EZ-Engrave 
will act upon it to restrict it from becoming longer.  
Conversely, Compression/Expansion allows for specification of the absolute length to which a given 
line of text is to be drawn. If the line of text is naturally shorter than the specified length, it will be 
expanded, while being naturally longer than the specified length will cause the text to be compressed. 
Put in simpler terms, specifying a Compression sets a Maximum length for a line of text, while a 
Compression/Expansion sets an Absolute length. 

Height Compression 
Height Compression constrains a line of text to the specified maximum length by reducing the height 
of the font in the line of text. This option will also reduce the character width and kerning 
proportionately. Because this is a simple compression type, it will only have an effect on the length of 
a line if it exceeds the value designated in the Units edit box. Otherwise, the line of text will be 
allowed to run freely according to the other parameters set in the Text Compose dialog box. 

Kerning Compression 
Kerning Compression constrains a line of text to the specified maximum length by reducing the 
kerning between characters in the line of text. This option will have no effect on either character height 
or width. Because this is a simple compression type, it will only have an effect on the length of a line if 
it exceeds the value designated in the Units edit box. Otherwise, the line of text will be allowed to run 
freely according to the other parameters set in the Text Compose dialog box. 

Character Width Compression 
Width Compression constrains a line of text to the specified maximum length by reducing the width of 
the characters in the line of text. This option will also reduce the character kerning proportionately, but 
will have no effect on character height. Because this is a simple compression type, it will only have an 
effect on the length of a line if it exceeds the value designated in the Units edit box. Otherwise, the line 
of text will be allowed to run freely according to the other parameters set in the Text Compose dialog 
box. 
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Height Compression-Expansion 
Height Compression/Expansion forces the line of text to an absolute length by increasing or decreasing 
the height of the characters as necessary. Character Width and Height will also be scaled 
proportionately. Any line of text composed with this option selected will be forced to the width 
specified in the Units edit box. 

Kerning Compression-Expansion 
Kerning Compression/Expansion forces the line of text to an absolute length by increasing or 
decreasing the space between the characters as necessary. Character Width and Height will not be 
affected. Any line of text composed with this option selected will be forced to the width specified in 
the Units edit box. 

Width Compression-Expansion 
Width Compression/Expansion forces the line of text to an absolute length by increasing or decreasing 
the width of the characters as necessary. Character Kerning will also be scaled proportionately, but 
character Height will not be affected. Any line of text composed with this option selected will be 
forced to the width specified in the Units edit box. 

None 
Click on this option and no restrictions will be applied to line length. Any text line will run freely 
according to the natural height, kerning, and width of the characters used in the text line. A Width 
value cannot be selected, when None is the selected Compression option. 

Line Link and Direction 
The Line Link and Direction options determine how the lines in a multi-line paragraph of text are 
linked and the final effect of the compression. There are six options from which to choose: 

 

Lines Individually & Horizontally 
This option allows for treatment of each line in the paragraph independently when applying a 
compression or compression-expansion. The effect of this type of link is that each line of text may 
have very different height, width, or kerning characteristics. 

 

All Lines Equally & Horizontally 
Applying compression or compression-expansion to All Lines Equally & Horizontally causes all lines 
to be compressed or expanded equally such that the longest line in the paragraph will exactly match the 
length (or maximum length) specified for the compression. The effect of this type of link is that all 
lines in a given paragraph will maintain exactly the same kerning and character width characteristics, 
regardless of the height of each of the individual lines. 
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Equal Height Lines & Horizontally 
Applying this type of line link causes all lines in which the characters are the same height to be 
compressed or expanded such that the longest line of text will exactly match the length (or maximum 
length) specified for the compression. The effect of this type of line link is that all lines of text with 
equal height will maintain the same character width and kerning information, but will not necessarily 
have the same characteristics as those line of text with different character heights. 

A Note About Line links And Character Height 
For the purposes of linking lines for Compression, the height of the characters in a given line of text is 
defined by the height of the first character in that line. This becomes important when using the Equal 
Height Lines link. If a given line of text contains a mix of character sizes, the entire line will be 
compressed or expanded as if it were composed solely of characters of the same height as the first 
character in the line. 

Lines Individually & Vertically 
This option allows for treatment of each line of vertical text in the paragraph independently when 
applying a compression or compression-expansion. The effect of this type of link is that each vertical 
line of text may have very different height, width, or kerning characteristics. 

 

All Lines Equally & Vertically 
Applying compression or compression-expansion to All Lines Equally & Vertically causes all vertical 
lines to be compressed or expanded equally such that the longest line in the paragraph will exactly 
match the length (or maximum length) specified for the compression. The effect of this type of link is 
that all lines in a given paragraph will maintain exactly the same kerning and character width 
characteristics, regardless of the height of each of the individual lines. 

Equal Height Lines & Vertically 
Applying this type of line link causes all lines in which the characters are the same height to be 
compressed or expanded such that the longest line of text will exactly match the length (or maximum 
length) specified for the compression. The effect of this type of line link is that all lines of text with 
equal height will maintain the same character width and kerning information, but will not necessarily 
have the same characteristics as those line of text with different character heights. 
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Check Spelling 
Spell Checker 

EZ-Engrave’s Professional Text Compose module is equipped with a Spell Checker. To operate this 
feature, sweep-select the text to check and click on the Check Spelling button. This opens the Spell 
Checker dialog box: 

   

Word Not Found 
The Word Not Found box displays the word that appears to be incorrectly spelled, the suggested 
replacement word (if any) in the Change To box.  

Suggestions 
In addition, a list of suggested replacement words will appear in the Suggestions box. 

Change To 
Where no suggestions are available, enter the appropriate word into the Change To box manually. 
Simply sweep-select the box, and enter the word as it should appear in the document.  

Verify 
To compare the spelling of a replacement word against the dictionary, press the Verify button. This 
causes the spell checker to look up the word in the dictionary. 

Replace / Replace All 
Once satisfied with the replacement word, either press Replace, or Replace All, by pressing the 
appropriate button. Replace changes only the current selection of the word, Replace All changes all 
occurrences of the word in the selected paragraph. 

Ignore / Ignore All 
If the word is to be left as it appears (i.e., no changes) select the Ignore button for this instance of the 
word, or the Ignore All button for other instances in the current paragraph. 

Add 
Where a word is perfectly legitimate, and should be added it to the personal dictionary, do so by 
clicking on the Add button. This causes the spell checker to add the word to the personal dictionary, 
and accept it, both currently and in the future, as a valid spelling. 
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Context 
The context box shows the context of the word being used in a sample sentence, if the word is 
unknown no context will be shown. 

Main 
The spell checker uses two different dictionaries at any one time: the default dictionary which is 
supplied with Professional Text Compose, and a user-defined dictionary. Any words added to the 
dictionary are included in the personal or user-defined dictionary, while the default dictionary remains 
constant. 
There can be as many personal dictionaries as required, each with a unique name, but only one can be 
accessed at a time, in addition to the Main library supplied with EZ-Engrave. Select a Main dictionary 
to work from. 

User 
To select a dictionary, click on the User list box, and select the name of the required dictionary from 
the list. Where no user dictionary exists, a prompt for a name for the dictionary occurs. Begin a new 
dictionary at any time by selecting New from the list. 
The ability to support multiple dictionaries can be particularly important when more than language is 
used. For example, in the southern United States, it is not uncommon to require both English and 
Spanish on some signs, while in Canada, English and French are often used together in signage. In 
these cases, develop a dictionary for the second language by adding new words to the dictionary as 
they occur in files. 

Show Changes 
The Show Changes button will display in the view screen any changes made to the text. To display 
changes, move the Compose / Edit Text dialog box away from the area where the text appears and 
press the Show Changes button. 
The Show Changes check box causes EZ-Engrave to update the text on screen automatically when 
certain events occur. These events include: 

¾ Turning on Show Changes; 

¾ Cutting text from the Text Entry box; 

¾ Changing the Height of selected characters; 

¾ Changing the Kerning of selected text; 

¾ Changing the Slant of selected text; 

¾ Setting a new Line Width; 

¾ Setting a new Line Spacing;  

¾ Setting a new X- or Y-Position; 

¾ Pressing the Enter (Return) key; 

¾ Changing the Font of selected text. 

Braille 
The Braille button and checkbox controls are used to operate the Braille module. If the Braille module 
has not been purchased from Roland or one of its re-sellers, this option will not be available, and will 
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be grayed out. Please consult the chapter in this manual entitled The Braille Module for details on the 
operation of this feature. 

Auto Kern 
EZ-Engrave’s Professional Text Compose has a special kerning routine that replaces the kerning 
information contained within a given font. The Auto Kern feature measures each pair of characters and 
then spaces them by balancing the white space between the characters. This usually results in text that 
is more pleasing to the eye. Auto Kern is accessed by pressing the Auto Kern button, this opens the 
Auto Kern dialog box: 

 

Styles 
There are five different Auto Kern styles available from this option: 

 

Normal 
The Normal style of kerning balances the amount of white space while maintaining a normal character 
spacing. 

Wide 
The Wide style of kerning places extra white space between characters. The additional space is 
roughly equal to the 120% of the normal spacing. 

Narrow 
The Narrow style draws characters closer together by reducing the amount of white space between 
them. The white space placed by this style is roughly equal to 80% of the normal spacing. 

Touching 
The Touching kerning style sets the spacing between letters such that they actually make contact with 
one another, but do not overlap. 

Overlap 
The Overlap kerning style causes adjacent letters to overlap by approximately 5% of the normal 
kerning space. 

Accuracy Vs. Speed 
Auto Kern works by measuring the distance between any two adjacent letters at several different points 
along the height of the letters. The accuracy of the spacing of letter pairs depends strongly on the 
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number of points measured between them (points are a form of measurement). However, as the number 
of points measured increases, so does the amount of time required to calculate the proper spacing. EZ-
Engrave offers the ability to draw a balance between the speed of Auto Kern, and its accuracy. 

Fast 
The Fast option measures only a limited number of points along the height of the letter pairs. This 
option typically provides quite acceptable results, and is very quick in calculating the space between 
letter pairs. 

Accurate 
The Accurate option measures a much larger number of points along the height of the letter pairs than 
the Fast option. As a result, this option is somewhat slower to calculate the appropriate spacing than 
the Fast setting, but provides more accurate results. 

Adjust For Engraving Tool Check Box 
The Adjust For Engraving Tool check box when activated provides the option to set the Toolbit 
Diameter. 

Toolbit Diameter 
When using a router or engraver, the Toolbit diameter can be set in this value box, EZ-Engrave will 
then allow for the diameter of the Toolbit when performing Auto Kern on any text. This feature 
ensures that text is kerned in appropriate way so that text kerned to a Wide setting and routing with a 
large bit still has a large pair kerning space, as opposed to overlapping. Either type in a value or use the 
scroll arrows to the right of the box. 

Auto Kern Check Box 
Selecting the type of kerning required does not apply the Auto Kern function to the text unless Auto-
Kern is activated. To invoke Auto Kern, click on the Auto Kern check box. To de-activate Auto Kern, 
click on the check box again. 
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ZOOM IN TOOL  
The Zoom In  tool provides the ability to zoom into a selected area of the graphic and magnify it. 

¾ Select the Zoom In  tool icon from the zoom menu and the cursor changes to a magnifier 
with a + sign  . Using the Zoom In  tool, sweep-select the area to be magnified; 

 
¾ Upon release of the mouse button, the screen will redraw to show only that area that has been 

sweep-selected. 

 
The Zoom In  tool remains active until another tool is selected from the toolbox. This allows for 
continued zooming-in, without having to re-select the tool. 



Zoom Tool 

Keyboard Shortcut: 
Pressing [F5] selects the Zoom In  tool. 
Note: The Zoom In  tool is used to define a “window” around a selected portion of 
the graphic. 

ZOOM OUT TOOL  
A drawing can be made smaller on the screen by successively clicking on the Zoom Out  icon on 
the Zoom menu bar. The Zoom Out  tool may also be invoked while using the Zoom In  tool, by 
clicking the right mouse button instead of the left. 

Keyboard Shortcut: 
Pressing [F6] activates the  tool.  

ZOOM TO SELECTED OBJECT TOOL  
Selecting the Zoom to Selected  tool causes the viewing window to fit the selected objects exactly 
into the boundary of the screen. If no objects are selected then all objects will be fit to the screen.  

Keyboard Shortcut: 
Pressing [F7] activates the  tool. 

ZOOM TO SIGN BLANK TOOL  
Selecting the Zoom to Sign Blank  tool causes the viewing window to fit any selected Sign Blank 
designated in the Layout menu. 

Keyboard Shortcut: 
Pressing [F8] activates the Zoom to Sign Blank  tool. 

RETURN TO PREVIOUS VIEW TOOL  
Selecting the Return to Previous View  tool, when zoomed in or zoomed out on an object will 
automatically change the screen view to any previous zoomed view. This tool is extremely useful to 
toggle back and forth between views when working at extreme detail. 

Keyboard Shortcut: 
Pressing [F9] activates the Return to Previous View  tool. 

9-2 • EZ-Engrave User Guide 



Weld Tool 

 

WELD TOOL  

WELD TOOL 
The Weld  tool is used to delete overlapping sections between two distinct objects or overlapping 
sections of the same object and convert these into one fused or welded object. 
This tool is useful when working, for example, with script fonts that have a “lead-in” and “lead-out” on 
each character that overlaps the adjacent letter. If adjacent (and overlapping) letters are not welded 
prior to actually cutting them on the plotter, the letters will be cut such that they overcut each other. 
The Weld  tool removes those overlapping cuts to make script lettering flow together as a single 
object. The Weld  tool is also useful to eliminate overlaps between two objects created during 
Outlining of text messages and other objects. There are two levels of Weld available in EZ-Engrave. 

Note: All items that are welded become Poly-arcs. These Poly-arcs can be edited using 
the Arc Edit tool found with the Graphic Creation tools explained in detail later in the 
Chapter. 

BASIC WELD  
The Basic Weld  tool is used to delete overlapping sections between two different objects in the 
same color layer, or overlapping sections of the same object, and convert these into one fused or 
welded object. The Basic Weld  tool can be found in the main toolbox and is represented by the  
icon.  This tool is useful when working, for example, with script fonts which have a “lead-in” and 
“lead-out” on each character that overlaps the adjacent letter. Without welding the overlaps, the letters 
will rout with overlapped routing lines. The Basic Weld  tool removes those overlaps to make script 
lettering flow together as a single object. 
To weld two overlapping sections together: 

¾ Select the two objects or two groups of objects that are to be welded with the Select tool. 

¾ Click on the Basic Weld  icon in the toolbox. 
The objects will be welded together into a single object. 

Note: For both Basic and Advanced welding, to weld text select the overall text string 
to be welded. Text will automatically be converted into graphics before welding. 

And Weld  
This And Weld  tool is represented by the And Weld  icon in the Welds fly-out toolbox. The And 
Weld  welds two overlapping objects leaving the area which was occupied by both (the area 
occupied by this AND this -- hence the name, the And Weld). It is a ‘what you don’t see is what you 
get’ weld, because the resulting objects will be rendered in the color of the hidden object. 
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For example, welding these two objects with the And Weld  tool has the following results: 

 

Note: that the resulting object is defined by the area where the two circles overlap, and 
is the same color as the object that was partially hidden. 

The And Weld  tool is used for graphical effects such as fancy clipping as follows: 

 
EZ-Engrave is laid over a different color Apply the And Weld  for this result. 

Note: Only two overlapping objects or group of objects can be welded at the same time. 
If there are three or more objects that overlap at the same location these must be 
organized into two groups before they can be welded.  
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Or Weld  
Welding with the Or Weld  tool will cause all areas where the selected objects overlap to be 
deleted. For example: 

 
Two overlapping objects.                                    The objects welded using the Or Weld . 

The properties of the Or Weld  make it useful for creating unique special effects like this: 

 
Note: Only two overlapping objects or groups of objects can be welded at the same time. If there are 
three or more objects that overlap at the same location, they must be organized into two groups before 
they can be welded. 
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SHAPES TOOL  

SHAPES TOOL 
¾ Click on the Shapes  tool icon and the following fly-out tool bar appears: 

 

Note: For all shapes that can be drawn the following rules apply. 
Pressing the [Shift] key while dragging will cause the shape to grow from the center. 
Pressing the [Ctrl] key while dragging will force the shape to be perfectly circular. 
Pressing the [Ctrl+Shift] keys while dragging will cause the perfect circle to grow from 
the middle. 

CIRCLES/ELLIPSES  
¾ Select the Circle  icon from the Shapes  fly-out menu. This permits drawing circles and 

ellipses on the screen; 

¾ Drag the pointer on the screen and a circle/ellipse appears to grow behind the moving 
pointer. 

STARS AND POLYGONS  
EZ-Engrave supports the automatic construction of polygons, star bursts, seals, and gear shapes.  

Selecting Shapes for the Stars/Polygons Tool 
¾ From the Shape tool right mouse select the Stars/Polygon  tool to open the Star Settings 

dialog box; 

¾ Select a shape, the number of points to be included in the shape, the core diameter, and the 
shape of the ray ends (whether pointed or square); 

 
¾ Press OK to save the settings, these settings will now be applied to the Stars/Polygons tool.  



Shapes Tool 

Drawing a Star or Polygon  
¾ Select the Stars/Polygons  tool from the Shapes  fly-out menu; 

¾ Drag the pointer on the screen and a Star/Polygon appears to grow behind the moving 
pointer. 

RECTANGLES  
¾ Select the  icon from the Shapes  fly-out menu. This permits drawing rectangles on the 

screen; 

¾ Drag the pointer on the screen and a rectangle appears to grow behind the moving pointer. 

ARROWS  
EZ-Engrave supports the automatic construction of Arrows.  

Selecting Shapes for the Arrow Tool 
¾ From the Shape tool right mouse select the Arrow  tool to open the Arrow Shape Settings 

dialog box; 

¾ Select a Shaft to head ratio, the Shaft thickness, and the Barb extent, (see diagram below); 

  

 
¾ Press OK to save the settings, these settings will now be applied to the Arrow tool.  
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Drawing an Arrow  
¾ Select the Arrow  tool from the Shapes  fly-out menu; 

¾ Drag the pointer on the screen and a Arrow appears to grow behind the moving pointer; 

¾ As the cursor is rotated clock-wise or counter-clockwise the arrow-head follows and points 
in the selected direction (at ninety degree increments), release the mouse to create Arrow. 

 

WEED BORDERS  
¾ Select the Weed Border  icon from the fly-out menu.  

This automatically surrounds any selected object(s)with a Weed Border. 
The Offset of the Weed Border from the edge of the graphic is user-definable in the General 
Preferences dialog box available from the EZ-Engrave Setup in the Options menu., or by right mouse 
clicking on the Weed Border  tool to access the Weed Setup dialog box.   

 

Border Offset 
The Border Offset places the Weed Border the designated distance away from the outside edge of the 
selected object(s).  
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DECORATIVE BORDERS  
EZ-Engrave provides the ability to apply a pre-defined frame or Decorative Border to selected 
elements of artwork. 

¾ Select the Decorative Borders  icon from the fly-out menu.  
This will apply a decorative border to the outside of the selected object(s).  If no object is selected the 
Decorative Border is applied to the Sign Blank. 
The settings for the decorative border are set in the Decorative Border dialog box available by right 
mouse clicking on the Decorative Border  tool. 

 

Border Size 
There are three ways to apply the size of the Decorative Border to artwork: 

 

Use Offset 
Use Offset applies the border with the Offset and Thickness values defined in the Border Extent box. 

Use Fixed Size 
Use Fixed Size applies the border with the Width, Height, and Thickness values defined in the Border 
Extent box.  The border is centered on the objects selected on screen. 

Fit Inside Sign Blank 
Fit Inside Sign Blank applies the border with the Offset and Thickness values defined in the Border 
Extent box and forces the border to an outside dimension that fits along the edges of the Sign Blank. 

Border Extent 
The Border Extent section of the Decorative Border Setting is used to define the size of the Decorative 
Border. 

Height and Width 
The Height and Width boxes are used to define the size of the border when Use Fixed Size is selected 
in the Border Size scroll box.  
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Offset 
The Offset box is used to specify the size of the border by calculating an offset from the outer edges of 
the selected object(s).  It is in effect only when Use Offset is selected in the Border Size scroll box.  

Thickness 
The Thickness setting specifies the width of the lines that make up the Decorative Border. This setting 
must always be positive (i.e., greater than zero). 

Corner Styles 
There are four corner styles to choose from: 

 
..Square Corner .......  

..Radial....................  

...Reverse Radial ......  

..Reverse Radial Filled............  
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Radius 
The Radius edit box is used to specify the radius of the round portion of the corner when you select 
any of the corner styles other than Square.  The Radius represents the distance from the center of the 
circle from which the curve is drawn to the outer edge of the curve. 
The Decorative Border dialog box is also available from the Layout menu.  For more information see 
the section which deals with the Layout menu. 

 

REGISTRATION MARK TOOLS 
The Registration Mark tool  and the Register Objects tool  are also available from the Shapes 
tool fly-out menu,  
These two icons allow for placement of registration marks on the screen, which can then be cut or 
printed with the on-screen objects to aid in registering the various color layers to produce a full-color 
lay up. The registration marks are identical to normal objects on the screen with the following 
exceptions: 

¾ A registration mark can be selected with the Select tool but cannot be scaled; 

¾ A registration mark will automatically be applied to all color layers and cannot be restricted 
to any one color layer; 

¾ A registration mark cannot be operated on by the any of the options in the Layout, Edit or 
Arrange menus; 

¾ A registration mark can be Deleted, Saved, and Exported as a regular object. 

Drawing Registration Marks  
The two icons on the fly-out menu, Registration Mark  and Register Object(s) , are used to place 
registration marks on any image in the view screen to assist in aligning the graphic elements during 
production. 
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¾ The Registration Mark  tool places a predefined registration mark wherever a left-click 
occurs on the Sign Blank. 

¾ The Register Object(s)  tool places a predefined number of registration marks around the 
selected object(s). If no objects are selected no registration marks will be placed. 

 

Setting Registration Marks  
The Registration Mark Setting dialog box is available by right mouse clicking on either of the 
Registration Mark tools. 

 
When selected, this option allows for specification of the size and pattern for the placement of the 
registration  marks around any selected drawing.  

Positions 
As many as eight registration marks can be automatically placed using the Register Object(s)  tool. 
To specify where on your selected graphics you would like to place registration marks simply click on 
the appropriate check boxes. 

 

Type 
There are four Registration Mark styles to choose from: 

 

.......Default ....... Midas 
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...... Classic .......Quick Classic 

Size 
The size of the Registration Marks can be set to a specific width and height measurement.  
Measurements units are determined by settings in the General Preferences. Enter the required values in 
the entry boxes. 

 

Offset 
This setting specifies the distance between the outermost edges of the selected objects and the center of 
the registration marks. 

 
The Registration Mark Setting dialog box is also available from the EZ-Engrave Setup menu under the 
Options menu. 
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Cutting Registration Marks 
Because registration marks are placed on all layers that are used in an image, they become objects on 
each layer that can be cut or printed. Since it is not always desirable to cut or print the registration 
marks on each color layer, EZ-Engrave allows the user the option to either cut the registration marks or 
not as required. 
A Cut Registration Marks option is offered to the operator when processing the image one color layer 
at a time using the Cut By Color option in the Plot dialog box of the Cut menu. 

 

DRILL TOOL  
The Drill  tool , when selected places drill points  where-ever left-clicks occur on the view-
screen. Drill points are similar to registration marks but are specifically for the routing and engraving 
features. Right-clicking on the tool opens the Drill Point Parameters dialog box: 

  
The default settings for the Tool, Depth, and Depth per pass, are the same as those set in the Plotter 
Setup and/or Depth Control dialog boxes. For more information about this tool refer to the routing and 
engraving sections of the Advanced Output chapter (10) of this manual. 

Drill point .....................  
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GRAPHIC CREATION TOOLS          

CREATING GRAPHIC ELEMENTS 
This tool provides the ability to create graphics on the screen using the point and click method with the 
mouse or on-screen digitizing. This tool also provides the ability to create graphics by freehand tracing 
as well as to edit the shape of on-screen graphic or text images produced by other methods and other 
programs. Create French curves and poly-arcs using the Arc edit feature of the graphic creation tools. 

¾ Click on the  icon in the toolbox and the following fly-out menu appears. 

 

NODE EDIT TOOL  
¾ Click on the Node Edit  icon from fly-out menu to activate the Node Edit (on-screen 

digitizing) tool. 
When activated, the tool is ready to begin the digitizing process. 

When the Node Edit  tool is selected, the Edit Toolbox appears on the view screen as follows: 

 
This tool box contains: 

¾ the On-screen Drawing Tool  ,  

¾ the Node Editing Tool , and  

¾ the Segment Editing Tool  . 

The Node Edit   tool can be used to manually trace a bitmap image on the view screen, a process 
known as On-Screen Digitizing.  

The Node Edit  tool also provides the ability to create new graphics by placing corner, curve, or 
tangent nodes to make up the outline of shapes. 

Generating Original Artwork with the Point & Click Method 
While the Node Edit  tool is active, each time the mouse button is pressed, a node is placed under 
the cursor on the view screen. A contour is defined by the nodes placed and how they are joined 
together by straight lines or curves. 
There are three node types in drawing mode: the corner node, the curve node and the tangent node. By 
default, the digitizing tool will place a corner node on the screen each time the mouse button is 
pressed. A straight line is drawn between any two adjacent corner nodes. Curved lines require at least 
three nodes, of which at least one other than the end nodes is a curve node. A tangent corner (a corner 
which flows smoothly from a straight line into a curve) requires three nodes as well, one of which must 
be a tangent node preceded by a corner node and followed by a curve node. 



Graphic Creation Tools 

Node Palette 
The Node Tool Palette provides the ability to change node types for drawing and editing, as well as 
perform other useful functions. To access this palette, place the cursor over a node and press the right 
mouse button. 

 
The following tools appear (clockwise from top left): 

¾ The Corner Node tool  which changes the selected or next-drawn node(s) to a corner node; 

¾ The Join tool  which joins the two endpoints of a selected contour, or any two selected 
contour endpoints; 

¾ The Curve Node tool   which changes the selected or next-drawn node(s) to a curve node; 

¾ The Set Start Point tool   which provides the ability to specify the start point of the 
selected contour; 

¾ The Tangent Node tool  which changes the selected or next-drawn node(s) to a tangent 
node; 

¾ The Break tool  which breaks a given contour at the selected node; 

¾ The Trash tool  which deletes the selected node or nodes; 

¾ The Clockwise/Counter-Clockwise button  which provides the ability to toggle the 
direction of the selected contour. 

Selecting from the Node Palette 
To select one of the Node Palette options: 

¾ Press the right mouse button to display the Node Tool Palette. 

¾ Keeping the right mouse button depressed, move the cursor in the direction of the node type 
to select. 

  
1 Display Node Palette  2. Select Node Type. 

¾ Upon releasing the right mouse button, the new node type is selected, and will be placed at 
the location where the left mouse button is pressed next. 

When using the Node Edit  tool, consecutive corner nodes will be joined by straight line segments, a 
curve node preceded and followed by any other node will create a curved line segment, and a tangent 
node between a corner node and a curve node will result in a contour with a smooth transition between 
a line segment and an adjacent curve segment. 
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Corner nodes joined Curve nodes joined Tangent nodes give  
by straight lines  by curved lines.  smooth transitions  
  from lines to curves 

Drawing Straight Lines 
By default, the digitizing tool   is automatically activated when the graphics creation tool is first 
selected.  

¾ Click on the Node Edit  icon in the  tool fly-out menu to activate the drawing tool. 

¾ Move the  pointer to the position on the screen that will be the starting point for the 
graphic and press the left mouse button. A  corner node appears on screen. 

¾ Move the pointer to the next position and press the mouse button again. A second  corner 
node is placed on the screen and a straight line is drawn connecting the two nodes. 

                                               
A directional arrow appears on this first line segment to designate the starting point of the line segment 
and the direction in which it is being drawn (this also affects the routting direction). 

Ending a Line 
To end a contour and begin to draw a new line or contour that is not connected to the first line, there 
are two options:  

¾ close the contour being drawn, which causes the next node to begin a new contour; or 

¾ in the case of an open contour, select the Node Edit  tool from the Edit toolbox or tool 
palette, and then begin drawing the next contour. 

All contours drawn within the same editing session will be related in that they will be part of the same 
path. 

Note: To make a new contour that is not related to existing contours (i.e. – not on the 
same path as the existing contours), exit the drawing tool (select X in the tool palette), 
and re-select the Node Edit  tool from the main toolbox to begin drawing a new 
contour on a new path. 
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Closing a Contour 
EZ-Engrave makes certain assumptions when drawing a contour in order to speed the drawing process 
and to make it more intuitive. For example, if a new node is drawn within 6 pixels of the first node of 
the current contour, EZ-Engrave closes the contour. 

 
The next time a node is placed on the view screen and the mouse is pressed, a new start point for a new 
contour is created. To place the two ends of an open contour within the 6 pixel limit without closing 
the contour, use the Zoom  tool to zoom in on the end point and then position the last node. In the 
magnified view of the screen, the 6 pixel limit will allow for placement of the last node much closer to 
the beginning node without closing the contour. 
Alternatively: 
To close a contour where the last node placed on the screen is not near the beginning node, select the 

 icon from the Node Palette and a new segment will be drawn automatically to join the last node to 
the first node and the contour will be closed. 

Ending a Contour 
When a contour has been drawn and is to remain open, end the contour at the last node by selecting the 

 icon from the pop-up tool palette, or by press the  button in the drawing tool bar. The contour 
will end without closing. 

Drawing Curved Contours 
Drawing with curves uses the same point and click technique as drawing with straight line segments 
except that the nodes placed at each mouse click will be curve nodes rather than corner nodes. To 
digitize with curve nodes rather than corner nodes, first change over to curve nodes on the pointer. To 
accomplish this: 

¾ Move the pointer to the location where the beginning node is to be placed; 

¾ Press and hold the right mouse button, the Node Palette appears around the pointer; 

¾ While pressing the right mouse button, move the pointer over the curve  icon to select it as 
the next node type; 

¾ Release the right mouse button. Begin to place circle nodes around the object to draw. 

  
1 Position pointer on location 2. Display Node Palette and 
   of first node.     select curve node icon.    

Once the curve node type has been selected, subsequent clicks with the left mouse button will continue 
to place the curve nodes at each click until a different node type is selected from the Node Palette with 
the right mouse button. Each of the nodes left behind is joined by curved line segments. 
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Using Tangent Nodes to Join Line Segments to Curve 
Segments 

The tangent node, designated by the tangent  icon in the Node Palette, will make a smooth transition 
or tangent between a line segment and a curve segment. 
To demonstrate this effect: 

¾ Draw a straight line between two corner nodes; 

¾ Select a new point on the screen and press and hold the right mouse button; 

¾ From the Node Palette, select the tangent  icon and place a tangent node in the drawing on 
screen. 

A straight line segment will join the tangent node to the previous corner node. 

¾ Now, select a new point on the screen that is almost at a right angle to the last line segment 
on the screen; 

¾ Using the right mouse button, select a curve node from the Node Palette. 
A curve node will be placed on the screen and a curve will be drawn joining the curve node with the 
previous tangent node. 

 
Notice that the transition from line to curve at the tangent node is smooth without any abrupt change in 
direction. 

Adding on to an Existing Contour 
When the Node Edit  tool is active, add on to the end of an existing open contour by pressing [Shift 
+ click on the node] at the open end of the contour, then continue to draw as normal. 
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Changing the Orientation of a Contour 
When the  tool is active, change the orientation of the contour from clockwise to counter-clockwise. 
Click with the right mouse button and select the tool from the palette to toggle the direction of the 
contour from clockwise to counter-clockwise and back. This feature is particularly useful when 
sending the file to output on a router or engraver. 

   

Moving the Start Point of a Contour 
When the  tool is active, move the start point of the selected contour. Move the cursor over the node 
selected to be the start point for the contour, click the right mouse button, and select the  tool from 
the palette. The start point of the object will now be positioned at the selected node. 

   

FREE EDIT TOOL  
It is possible to sketch a drawing on the screen freehand in the same way as drawing on a piece of 
paper. To implement the freehand sketching tool: 

¾ Select the Free Edit  icon from the Edit  tools fly-out menu; 

¾ Move the pointer on the screen to the beginning position of the sketch and press and hold the 
left mouse button; 

¾ With the button pressed, move the on-screen pointer to trace the object to draw. 
As the pointer moves on screen, a line will be drawn behind it representing the trace being created.  

The freehand sketching mode is automatically implemented when using the Free Edit  tool. Clicking 
and dragging the pointer across the screen will leave a trace behind on the screen following the path 
taken by the pointer. 
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ARC EDIT TOOL  
¾ Click on the Arc Edit  icon from fly-out menu to activate the Arc Edit (poly-arc) tool. 

When activated, the tool is ready to begin the digitizing process. 

When the Arc Edit  tool is selected, the Arc Edit Toolbox appears on the view screen as follows: 

 
This tool box contains: 

¾ the Arc Drawing Tool  ,  

¾ the Arc Editing Tool , and  

¾ the Segment Editing Tool  . 
It is possible to create arcs and curves quickly and easily without having to incorporate the three node 
types. To implement the Arc Edit tool: 

¾ Select the Arc Edit  icon from the Edit  tools fly-out menu; 

¾ Move the pointer on the screen to the beginning position of the sketch and press the left 
mouse button; 

¾ Move the on-screen pointer to the next position and press the left mouse button again, repeat 
this procedure until the object is drawn. 

 
The graphic created is the same as those created using the Node Edit tool except that the nodes created 
are curve nodes, and the nodes cannot be changed to corner or tangent nodes. The curve nodes differ 
from those of the Node Edit tool in that they are poly-arcs, and therefore the arc on one side of the 
node can be adjusted without affecting the arc on the other side of the node. To draw an Arc using the 
Arc Edit  tool: 

¾ Select the Arc Edit  icon from the Edit  tools fly-out menu; 

¾ Move the pointer on the screen to the beginning position of the sketch and press the left 
mouse button; 
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¾ Move the on-screen pointer to the next position and press the left mouse button again, while 
holding the button drag the cursor around the selected area and see how the arc is affected by 
the direction of the cursor, repeat this procedure until the object is drawn. 

 

Node Palette 
The Node Tool Palette available with Arc Edit does not provide the ability to change node types for 
drawing and editing. However it does provide access to the other tools in the Node. To access this 
palette, place the cursor over a node and press the right mouse button.  

 
When Arc Edit is accessed from a node in a 3D path, there are Palette two new tools, the Bridge  
and Depth  tools  

 
For more information about the Bridge and Depth tools refer to the 3D section in the Advanced Output 
chapter. For more information about the other tools refer to the Node Edit section on the Node Palette. 
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ADVANCED SCANNING TOOLS   

ADVANCED SCANNING TOOLS - INTRODUCTION 
Three different tools are available with most EZ-Engrave packages. The Scanning  tool is used to 
access: AccuScan; PhotoMachine. 
 

AccuScan ......................  The AccuScan module contains the tools that are required to convert black 
and white into line-traced drawings format that can be routed by EZ-Engrave. 

PhotoMachine ...............  The advanced PhotoMachine tool enables 3D routing and engraving using 
the 3D PhotoMachine module.  

Show Bitmap Options 
When working in EZ-Engrave, sometimes bitmaps do not redraw as quickly as other types of objects. 
To counter this, EZ-Engrave provides two options for working with bitmaps. 

 

Show Bitmap Outlines  
The Show Bitmap Outlines provides the ability to turn off the bitmap view, and show in its place a 
wire frame, or place holder. The Show Bitmap Outlines is found in the View menu. For the purposes of 
working with the Scanning tools, Roland recommends de-selecting this option, so that bitmaps will be 
shown in their entirety. 

Show Reduced Bitmaps 
The Show Reduced Bitmaps is a second option available in the View menu that can speed up refresh 
rates and save on time while working in the Scanning tools. For the purposes of working with the 
Scanning tools, Roland recommends selecting this option, so that bitmaps can be drawn and re-drawn 
quickly. 

AccuScan 
The AccuScan module contains the tools required to convert a monochrome bitmap into a line-traced 
drawing format that can be routed by EZ-Engrave. To take advantage of the advanced printing features 
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in EZ-Engrave, AccuScan also provides the tools necessary to manipulate bitmaps in their native 
format, and to combine them with other objects for printing. 

Note: While any color can be selected for the foreground and background of a bitmap, 
this manual assumes that the foreground is black and that the background is white 

Activating AccuScan  
Once a bitmap is imported, simply select it and press the AccuScan tool button to start AccuScan. 
Alternatively, double-click on the bitmap to activate AccuScan. Either method will enable AccuScan, 
and produce the Scanning control panel. 

 

Note: Only one bitmap can be selected to activate AccuScan. Attempting to activate 
AccuScan with more than one or no bitmap selected, will have no effect. 

Selection Tools  
When AccuScan is activated there are five different tools available from the Select tool in the tool bar. 
These tools are designed to help define those areas to scan, and each one is different from the others. 
However, they all have certain functions in common, including the way they work and the modifier 
keys that control them. 
In an effort to be consistent throughout the tracing process, all tools function in accordance with a 
common set of general rules, as follows: 

¾ Using any selection tool while pressing the shift key adds new objects or areas to the list of 
selected items. Select an area, and then Shift-select another area — the new area is added to 
the old to define the selected area. This is similar to the function of the Select tool in EZ-
Engrave, with which several items can be selected by holding down the shift key while 
clicking on them. 

¾ Using any selection tool while pressing the control key subtracts new objects or areas from 
the list of selected items. Select an area, and then Control-select another area, the new area is 
removed from the old to define the selected area, objects or colors. 

¾ When used without modifier keys, each selection tool selects only the current item, de-
selecting all others. Select one object or area, and then select another without using modifier 
keys, the previous selection is released, and the new selection becomes the only selection. 
This is similar to the Select functions in the main EZ-Engrave screen, clicking on one object 
selects it and de-selects all others. 
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Click Select Tool   
 This tool functions in the same manner as the Select tool available in EZ-Engrave all the time. For 

the purposes of scanning, its function is to select or de-select bitmaps. 

Oval Area Tool   
 The Oval Area tool is an area selection tool, that is used to define areas in a bitmap to scan. This 

tool is used to select regions that are circular, ellipse, or oval in shape. Like the circular drawing tool in 
EZ-Engrave, drag the circular area to include in the scan.  
The modifier keys also function with this tool. For example: 

 

Note: The gray shown in these drawings was added to show more clearly the selected 
area. Selected areas won’t be grayed like this. 
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Rectangular Area Tool (The Square Tool)   
 The Rectangular Area tool is an area selection tool. As the name implies, it is used to select 

rectangular areas of the bitmap. Using the modifier keys allows for multiple selections of shapes: 

 

Freehand Area Tool   
 The Freehand Area tool allows for freehand drawing an area on a bitmap to be traced. To operate 

this tool, press and hold the left mouse button, and trace around the area to select. The modifier keys 
can also be used with this tool: 

 

Polygon Area Tool  
 The Polygon Area tool is used to select areas that have an irregular shape. Click on the bitmap to 

specify the corner points of the area to trace. To close the polygon, either click again near the first 
corner, or double click on the last node required. For example: 
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Manipulation Tools 
There are several tools available within AccuScan to manipulate a bitmap, to prepare it for either 
routing or printing. 

Copy Tool   
  The Copy tool may be used to accomplish one of two tasks, use it to move a selected area to 

another position within the bitmap, or use it to copy a selected area to another position. 

Copy A Selection 
To copy a selected area, simply define the area to copy using the Select tools and click on the Copy 
tool button. The selection may now be dragged to another position within the bitmap.  

Move A Selection 
To move a selection, define the area to be moved, click on the Copy button and then drag the selection 
to its new location while holding the Control key. The area vacated by the selection will be filled with 
the target color from the Color Palette. 

Crop Tool   
 This tool is used to remove all of the bitmap except the selected area or areas. To use this tool, 

simply select the desired area with the select tool and click on the crop tool. 

Flood Tool   
 This tool is used to flood fill (change the color of all pixels) a selected area with the target color. To 

use this tool: 

¾ Select a target color from the palette of the bitmap (press the Palette button to toggle between 
black and white). 

¾ Select the area to be flooded using the selection tools 

¾ Press the Flood button 
The entire selected area will take on the Target Color. 

Paintbrush Tool   
 This tool is used to add paint lines to the bitmap. To draw on the bitmap, select the Paintbrush tool, 

and then click and drag lines onto the bitmap using the mouse. There are several brush shapes 
available, any of which may be selected by clicking on the Brush Shape button. The color selected as 
the Target color is used for the Paintbrush tool. 

Brush Shape Button  
 Clicking this button produces the Brush Shape palette. 
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Use this palette to choose the shape for drawing with the Paintbrush tool. Draw with a round brush 
using one of five thickness’, or a square brush, again with one of five widths. The available thickness’ 
for the round brush shapes are 1, 3, 5, 9, and 11 pixels wide. For the square brush shape, chose from 
widths of 3, 5, 7, 9, and 11 pixels wide. The selected shape and size will be highlighted with a red 
outline. 

Trace Setup Dialog Box 
Clicking on the  button in the Scanning Control Box produces the Trace Setup Dialog Box. 

 
This dialog box offers several types of control that determine the final output of the scan. These 
control types are: Setup, Line Fit, and Tracing Options  

Setup 
This section of the dialog box is used to manage configuration files for AccuScan. From within this 
area, select a saved setup, save a new or modified setup, or delete a saved setup. 
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Name List Box 
This box displays the name of the current setup. To select a new setup, click on the scroll arrow, and 
then select the desired setup from the list. Give a new setup a name in this box by sweep-selecting the 
name area and entering a new name. 

 

Save Button 
Use the Trace Setup dialog box to create setups to save for later use. The Save button is used to store 
these setups on the hard drive. To save a setup, sweep-select the name in the list box, enter a new 
name, and press the Save button. The newly selected setup now appears in the saved selection setup 
box. 

Note: Descriptive names for the setups allow for easy identification of a setup being 
appropriate for a given type of bitmap. 

Delete Button 
In addition to saving setups for AccuScan, delete those setups that no longer have value, by using the 
delete button. To delete a setup from the list, select the desired setup from the Name list box, and press 
the Delete button. 

Note: Once a setting is deleted, it is irretrievably gone, and cannot be recovered. 
Caution should be exercised when deleting any previously-saved scanning setups. 

Line Fit Section 
The Line Fit Section controls how AccuScan follows the edges of scanned artwork. This is particularly 
important, since appropriate settings in this section can produce a high-quality trace from poor quality 
bitmaps. 

 
Specifically, the Line Fit settings govern how closely AccuScan will follow the edge of the objects in a 
bitmap by varying the line Tolerance and Corner recognition capabilities of the tracing function. 

Tolerance 
The Tolerance setting specifies how closely AccuScan follows the edges of an object in a bitmap. A 
loose setting will approximate an object’s shape rather loosely, while a tight setting will follow the 
edge very precisely. 
Tolerance should be set tight (7 or greater) if a bitmap is very detailed and accurate. This allows for all 
of the fine detail to be traced. In general, the higher the detail, the higher the Tolerance setting. 
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The Tolerance should be set loose (three or less) if a bitmap contains long smooth edges, or if it is of 
poor quality. This results in AccuScan ignoring small errors in the edges of the objects, but can also 
result in a loss of the finer details. 

Corners 
The Corner setting controls AccuScan’s corner recognition ability. AccuScan uses this setting to 
determine which parts of a trace represent a corner, and which parts represent a tight curve. 
If a bitmap contains sharp corners, and is mostly angular, set Corners to sharp (7 or greater). If it is 
mostly curves, set Corners to loose (3 or less). Moderate settings (4 to 6) work best with a mix of 
corners and curves. 

Tracing Options 
This section of the AccuScan dialog box sets some general rules about how a bitmap is to be scanned. 

 

Speckle Filter 
Many bitmaps contain undesirable bits of dirt. These random spots of color usually appear due to a 
scratched or dirty scanner bed. The Speckle Filter allows for removal of these specks and creation of a 
cleaner finished product. 
The speckle filter sets the threshold at which AccuScan recognizes a group of pixels as an object. Once 
the filter is set, an object must be larger than the set value in order to be traced during a scan. For 
example, if the Speckle Filter setting is four pixels, then objects must be five pixels or larger in order 
to be recognized as a true object, and therefore scanned. 
The filter can be set by specifying the minimum number of pixels, or it may be specified as a 
percentage of the overall bitmap size. The percentage specification tends to be a much more coarse 
unit of measurement than the pixel specification, and is most useful when dealing with particularly 
large or dirty artwork. 

Note: While higher Speckle Filter settings result in fewer extraneous objects being 
traced, it may also result in the loss of smaller objects. Exercise caution when choosing 
an appropriate filter setting. 

Snap Long Lines to Vertical/Horizontal 
When a photo is placed on a scanner bed, it is difficult to place the image perfectly straight on the 
scanner bed. The Snap Long Lines to Vertical/Horizontal setting provides a method to account for 
picture placement. 
The Snap Long Lines to Vertical/Horizontal option allows for a threshold angle to be set, below which 
all lines will be made vertical or horizontal. For example, setting the snap angle to 5 results in any 
straight line 5 degrees or less off vertical/horizontal being made vertical/horizontal. 

13-8 • EZ-Engrave User Guide 



Advanced Scanning Tools 

A setting of less than 10 is usually best when using the Snap Long Lines to Vertical/Horizontal option. 
Higher settings result in noticeable distortion in the final output.  

Note: If a higher snap angle is required, there are two other options: re-scan the original 
picture; or use no snap angle and rotate the artwork after tracing. 

Small Shape Accuracy 
Small Shape Accuracy allows for application of Line Fit settings to each object in a bitmap relative to 
its size, by scaling those specifications to match the size of the object. For example, for a given 
Tolerance setting, a single pixel on the side of an otherwise smooth edge of a large object might be 
seen as dirt, and ignored, while the same pixel in a smaller object will be recognized as detail, and 
included in the trace. This provides the ability to vary Line Fit parameters to automatically account for 
differences in object size in a bitmap. 
In order for Small Shape Accuracy to function most effectively, assess the relative size differences 
between the largest objects in a bitmap and the very small ones. Where the difference is large, the 
Small Shape Accuracy should be set high (7-10). Where the objects are fairly similar in size, the Small 
Shape Accuracy should be set low (Off-3). 

Overlay 
The Overlay button allows either the default Traditional Scanning style or the Overlay Scanning style 
to be selected. 

Traditional Scanning Style 
The Traditional scanning style has two characteristics that set it apart from the Overlay style: it treats 
each object individually when tracing; and it recognizes objects inside other objects as being made up 
of both a smaller object and a hole within the larger object. For example: 
Given this bitmap; The Traditional Style scan would yield these parts; 

  

Overlay Scanning Style 
The Overlay scanning style creates a complete mask for each of the colors in a bitmap as it calculates 
the size and shape of the bitmap objects. The order that the color masks are placed on top of one 
another is dictated by the order of the colors in the Palette dialog box, such that the first color in the 
palette (upper left plate) is traced first and placed on the bottom, the second-row left plate is traced 
second, and so on. 
The result of an Overlay scan has two characteristic features: where two or more objects of the same 
color are connected by other objects of different colors, the two objects are recognized by the software 
as a single object; and objects within other objects are seen as being on top of the objects rather than 
inside them, this means that there are no holes in the bottom object. For example: 
An Overlay-style scan of these objects; Renders these results; 
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Note: This result differs from the Traditional trace in that the gray layer is one complete 
object that encompasses all of the gray areas and the bridge between them that was 
originally black. Note also that it is generated for placement underneath the black layer. 

The advantages of an Overlay scan are: 

¾ It typically results in simpler shapes, and  

¾ The resulting objects will have no overlap areas when the sign is routed and laid out.  

The disadvantage is that much larger objects are typically created (e.g. , vs.  ). 

Note: Since the order of the objects is governed by the order of colors in the Palette 
dialog box, be aware of the fact that (and, in the case of an Overlay-style trace, should) 
the colors can be sorted according to their usage in the bitmap, so that the most often-
used colors are on the bottom, and the least-used are on top. This sorting function is 
available through the Re-Order button in the Palette dialog box. 

Setup Selection Scroll Box 
The setup selection scroll box is located directly below the buttons. This box provides quick access to 
setups defined previously through the Trace Setup dialog box. The current setup name is shown in this 
list box. To select a different previously-saved setup, click on the scroll arrow, and select the desired 
setup. The name of the selected setup now appears in the Setup Selection scroll box. 

   

Vectorizing With AccuScan  
Once AccuScan is set up and the area to be scanned defined, return to the Scanning Control dialog box, 
and press the Scan button .  AccuScan traces the selected area of the bitmap, or the entire bitmap if 
no specific areas are selected, according to the parameters set in the Trace Setup dialog box. 

PHOTOMACHINE TOOL  
The PhotoMachine module contains the tools that are required to convert a bitmap into a line-traced 
drawing format that can be cut, routed, or engraved by EZ-Engrave.  

PhotoMachine 
With PhotoMachine cut, route or engrave drawings using fill patterns. 

13-10 • EZ-Engrave User Guide 



Advanced Scanning Tools 

The basic Image Cut pattern is available with Foundation,  

 

ImageCut Settings 
ImageCut traces the selected objects(s) and creates a pattern of bands, where the lighter portions of the 
object(s) are banded with thin lines and the darker portions are banded with thick lines. ImageCut is for 
use strictly with cutters. 
Several of the settings within PhotoMachine can be adjusted to alter the banding effects using 
ImageCut. 

Band Settings 
The Band settings are interdependent changing one value will affect the other. 

  

Bandwidth 
This option alters the maximum band width. Increasing the Bandwidth decreases the total number of 
bands applied. 

Number of Bands 
Set the total number of bands to be applied to the object(s). Increasing the Number of Bands decreases 
the maximum band width. 
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Style 
With Foundation the PhotoMachine dialog box contains one choice only in the Style list, ImageCut. 
ImageCut is strictly for use with cutters. 

 

Options 

 

Band Minimum 
Set a minimum width for the bands, in percentage values. Lower the Band Minimum value and the 
bands for light colored areas are made more narrow. If the Band Minimum value is too low, weeding 
the vinyl will be difficult as the strips of vinyl will be too thin to handle easily. 

Band Maximum 
Set a maximum width for the bands, in percentage value. Raise the Band Maximum value and the 
bands for dark colored areas are made wider. If the Band Maximum is made too wide, weeding the 
vinyl will be difficult as there will be almost no space between bands. 

Negative 
When the Negative check box is turned on, the banding effect is reversed (i.e., wide bands are applied 
to light colored areas and thin bands are applied to dark colored areas). 

 

Orientation 
The Orientation options are output device dependent. Check your cutter manual regarding how the 
device relays the X and Y axes.  In order to maintain a good quality cut use the option that uses less 
movement of the cutter, generally the option to choose is vertical. 
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Using ImageCut 
¾ Select an object(s) on screen. The object(s) can include  either vectors or bitmaps.  

 
¾ Choose the PhotoMachine tool  from the tool bar. 

¾ PhotoMachine automatically converts any vector based object(s) into bitmap images. 

¾ Adjust the following settings to suit the requirements: 
Band Width / Number of Bands 
Band Minimum; 
Band Maximum; 
Negative (to achieve a reverse effect); 
Orientation (generally, vertical). 
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¾ Click Apply! 

 
¾ If the results are as expected, click OK. 

 
Thin bands have been applied to light areas while thick bands have been applied to dark areas. 
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AccuScan Tool  
If you have purchased EZ-Engrave Pro, Pro Plus, or Pro Print the AccuScan Tool will be available. 
Refer to Chapter 8 — Advanced Scanning Tools, in this manual for detailed information on the 
different bitmap editing options that are available with EZ-Engrave and its modules. The AccuScan  
tool is used to access four different tools: 

 
AccuScan ......................  The AccuScan module contains the tools that are required to convert a 

black and white or gray scale bitmaps into a line-traced drawing format that can be cut by 
EZ-Engrave.. 

PhotoMachine ...............  The advanced PhotoMachine tool enables 3D routing and engraving using 
the 3D PhotoMachine module.  

CenterLine Trace ..........  The CenterLine Trace module contains the tools that are required to 
convert a bitmap into a centerline-traced drawing format that can be cut, routed, or engraved 
by EZ-Engrave. The CenterLine Trace module will be activated if you have purchased the 
appropriate password from Roland or a EZ-Engrave re-seller. 

3D Centerline................ ...............  The 3D Centerline module contains the tools that are required to 
convert a bitmap into a 3D line-traced drawing format that can be routed by EZ-Engrave.  
3D Centerline was designed for use with the new 3D routing machines. The 3D Centerline 
module will be activated if you have purchased the appropriate password from Roland or a 
EZ-Engrave re-seller.  
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STROKE AND FILL TOOLS  

FILL TOOLS 
The Stroke and Fill  tool icon in Foundation is used to access the Line Style tool. 

LINE STYLE TOOL  
The Line Style tool is used to apply a “thick line” effect around any selected object in the Editing 
Window.  

Note: Refer to Welding Tools, in this chapter for more detailed information on the 
different editing options available using the Line Style tool. 

The Line Style tool is located in the main toolbox to the left of the EZ-Engrave main view screen. The 
 tool is used to apply a “thick line” effect around any selected object in the Editing Window. 

To apply a “thick line” effect to a contour or group of contours: 

¾ Select the contour(s) to be given a “thick line”. 

¾ Click on the Line Style tool,  in the main toolbox. 
The following dialog box will appear: 

  

Line Width 
None 

Select the None option in the dialog box, and any Line Style currently applied to the selected 
contour(s) will be removed. 

Hair Line 
Select the Hair Line option in the dialog box, to apply a 1 pixel wide line to the edge of the selected 
contour(s). This Hair Line can be in any color selected from the Color Palette, and will only be 
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displayed if Show Line Style option is selected in the View… menu. 

 

Thick Line 
The Thick Line option applies Thick Lines around an image greater than 1 pixel in width. The Thick 
Line is superimposed on top of the contour line, and can be any color selected from the Color Palette. 

¾ Click on the Thick Lines button in the dialog box to select this option. 

¾ Edit the text entry box from the keyboard to specify the thickness of the line required. 

 
The thick line will only be displayed if Show Line Style option is selected in the View… menu. Apply 
a thick line to an open contour or to a closed contour.  An open contour is one which does not define a 
closed path (i.e., a straight line is an open contour, a circle is a closed contour). 

Line Style 

  
Three different styles of “Line Styles” can be select between: 

¾ Selecting the  icon provides a “butt” line ending; 

¾ Selecting the  icon provides a “square” line ending; and 

¾ Selecting the  icon provides a “round” line ending. 
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Any open contour will be displayed as a thick line that ends in the line style selected from among the 
three options above. 

End Style 

 
Three end styles of “Line Styles” can chosen to determine the corner styles: 

¾ Selecting the  icon provides lines with round corners; 

¾ Selecting the  icon provides lines with pointed corners; and 

¾ Selecting the  icon provides lines with mitered corners. 
Any closed or open contour will be displayed as a thick line with end style selected from among the 
three options above. 

Save As Default 
Click on this option to save the existing Line Style settings in the dialog box as default settings for use 
on other contours. 

 

Use As A Default 
Click on this option for the existing Line Style settings established in the Line Style dialog box to be 
applied to all new objects created in the EZ-Engrave view-screen using the Shapes tool ,the Text 
Compose tool , or the Graphics Creation tool . 
The following diagrams show various examples of contours with “thick lines”: 

       
Line Width of ‘None’ ‘Hair Line’ ‘Thick line’ of 0.1 inches  

Applying Color to a Thick Line 
The color plate that is selected when the Line Style tool is accessed will be applied to any thick line 
that is created. Right mouse selecting a color plate in the palette will apply the selected color to the 
thick line. 
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Line/Fill Selector Icon  
At the far right side of the normal Color Palette is the Line/Fill selector icon.  
The Line/Fill selector icon is used to select either the fill inside a contour or any thick line applied to 
the contour. Assign color to the fill inside a closed contour without affecting the properties of any Line 
Style attribute that may have been applied to the contour line and vice versa.  
Repeated clicking on the Line/Fill Selector Icon  will toggle alternatively between the Fill mode and 
Line Style mode. 
Changing the mode of the Line/Fill selector also changes the Left/Right mouse selection of colors.  

¾ With the Line/Fill selector in the default position ,  the right mouse selection of a color 
plate changes the thick line color;  

¾ With the Line/Fill selector in the reverse position ,  the right mouse selection of a color 
plate changes the Fill color. 

Using the Line/Fill Selector Icon  
Changing the Color of the Fill inside a contour 

The Line/Fill selector icon has two modes of operation, the Fill mode and the Line Style mode. When 
the Line/Fill selector icon shows a solid filled circle, it is in the Fill mode. 
In this mode, any time an object is selected and then a color from the Color Palette, the color of the fill 
of that object is changed to the selected color. 

Changing the Color of a Thick Line 
Click on the Line/Fill Selector icon to change it to show an outlined circle (  ). This signifies that it 
is now in Line Style mode. 
When in this mode, select a target color for the Line Style feature. In addition, if an object is selected 
before selecting the Line Style target color, this object’s Line Style attribute will be assigned the 
selected color, whether a thick line is applied to the object or not. 

Select any object while the  icon is in the Line Style mode, and only the Line Style attribute of the 
contour is selected, not the fill associated with the contour. Once the thick line has been selected, 
selecting a new color from the color palette will change only that thick line’s color, and not the color 
of the selected object’s fill. 

   
Box with Black Thick Line Selector in Line mode Thick Line color changes  
  while Fill is not affected 
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Box with Black Thick Line Selector in Fill mode Fill color changes while  
  Thick Line is not affected 

In the top right corner of the Status Bar, a color indicator will display the color is being assigned to the 
thick line, and the color that is being assigned to the fill for any selected object. 

Cutting Thick Lines 
Thick lines are attributes of an object rather than an actual object, just as the color blue is an attribute, 
and not an object. As a result, thick lines must be handled in a special way to cut them. 

NOTE: A Hair Line can’t be cut, as it has no thickness but is only a line stroke. 

Any thick line applied to an object is superimposed on top of the original contour. This means that the 
original contour is obscured somewhat by the thick line as long as Show thick lines is on in the 
Options menu. 
There are two options when cutting this graphic: 

¾ An image can be cut so that the thick line is cut as an object while preserving the shape of 
the original contour underneath the thick line; or 

¾ An image can be cut as it appears on the screen, so that the thick line is cut as an object 
while the original contour is processed so that only that portion not obscured by the thick 
line is cut. 

Objects that include thick lines to be cut are processed in the normal fashion in the Plot dialog box 
with one exception. Once the Cut options have been set in the Plot dialog box and the OK button has 
been clicked, the following dialog box opens: 

 

Yes 
Select this option if to cut the thick lines without diminishing the size of the original contour. 

 

No 
To process the graphic through the cutter and ignore the thick lines altogether, select this option. 

 

Cancel 
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To cut the thick lines as they appear on screen, and also to cut the objects as they appear on screen 
(i.e., diminish the size of the original objects such that they are not overlapped by the thick line, but 
rather butt into them)select this option. 

 
Once welded, a thick line is no longer an attribute of any other object, but rather becomes an object 
itself which can be edited, colored, and can even have a thick line applied. 

GRADIENT FILLS TOOL  
With EZ-Engrave Pro or any of the more inclusive packages available for EZ-Engrave, the Stroke and 
Fills  tool is used to access two different tools. 

 The Gradient Fills is not available for Foundation, assistant, or Expert. 
The Gradient Fills tool opens the Attribute Manager application, a 32-bit plug-in for EZ-Engrave.  
With Attribute Manager use gradient or bitmap fill patterns for vector object(s). Edit the fills to create 
new fill patterns, or edit existing default patterns to apply to object(s) in EZ-Engrave. 
Gradient and bitmap fill patterns can be applied to any vector object in EZ-Engrave, that can then be 
edited, cut, routed using 3D PhotoMachine or 3D Centerline, or printed using PrismPrint. 

Note: Refer to Chapter 6 — Fills, in this manual for detailed information on the gradient 
and bitmap fill editing options available with EZ-Engrave and its modules. 
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CREATE TOOL PATHS FOR ROUTING AND ENGRAVING 
The Tool Path  tool is used to access all the Tool Path Creation tools, selecting this tool opens the 
following fly-out menu: 

 
Used specifically for routing and engraving requirements, these tools are also accessed via the Create 
Tool Path option in the Cut menu. 

 

Create Tool Paths 

Note: This section deals with EZ-Engrave’s ability to fill objects using the cutting head 
on the router or engraver, or the thick pen on the plotter. This section makes the 
assumption that the Routing module is installed, and all of the features available for this 
type of work are included. If the Routing module is not installed, but the Engraving or 
Banner-making modules are running most of the features described in this section will 
be available, except for those sections dealing with the depth of cut and certain Tool 
Diameter functions. 

The Routing Fill Control dialog boxes are used to apply a rout or tool path to selected objects. They 
can be accessed by selecting a Tool Path option from the Create Tool Path fly-out menu available in 
the Cut menu. The Routing Fill options are: Online; Male; Female; Fill; 3D Centerline; and 3D Multi-
Pass. These options apply to the Tool Offset from the contour, this specification defines the type of cut 
to produce. 
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Online 
Selecting this option will result in a cut where the tool path is the same as the outside edge of the 
object.  

  
The resulting cut will have an offset of “0” (i.e., no offset) and will be centered on the edge of the 
original object. This offset is often used to trace objects in artwork without filling the objects 
themselves. 

 

Tool 
Use this option to set the default tool bit or the felt-tipped marker usually used in the plotter. As a rule, 
set this to the largest bit or marker to be used in the work. 

Depth 
This selection box sets the current Rout Path to a specific depth. Rout Paths rely on this value for depth 
information, so each path generated must be assigned a depth for Routing. 

Tool Library Button 
 The Tool Library button opens the Tool Library dialog box, explained earlier in this chapter. 

Target Layer 
This selection box sends the current Rout Path to a specific color layer. Assign each path generated to 
a different layer for Routing. 

15-2 • EZ-Engrave User Guide 



Tool Path Tools   

Male 
Selection of this option will generate a tool path which cuts around the outside of a given object 
without ever crossing the original object’s edge.  

  
The tool path will fall to the outside of the artwork with an offset equal to one half the width of the tool 
bit. This type of offset is typically used to cut objects out of a piece of material. 

 

Tool, Depth, Tool Library Button, Target Layer 
See the explanations for theses options in the previous pages documenting the Online style of fill. 

EZ-Engrave User Guide • 15-3 



Tool Path Tools   

Inlay  
Because of their round shape, the bits used for routing and engraving will run into problems when 
cutting corners. Specifically, the bits can cut around the outside of a corner very effectively, but will 
always leave the inside of corners rounded, because the round shape of the bit will not fit entirely into 
the square space of the corner. 
When doing inlay work, round corners are definitely a concern. The problem becomes apparent when 
trying to fit inlay pieces into their routed channels. For any given object, the channel cut’s inside 
corners will be an outside corner on the fill piece being cut, and vice versa. This means that every 
corner the router can bring to a point has a piece that is round to fit. 

 
Resolve this problem by selecting Inlay. This will cause the router to cut all corners in an identically 
rounded fashion, so that all of the inlay pieces will fit into their routed channels. 

Clockwise / Counter-Clockwise  
Selecting this option will toggle the direction of the tracing of the outside edge of all objects from 
clockwise to counter-clockwise, without regard for the direction they were originally produced. 
Contours inside contours will be traced in an opposite direction to the outer contour.  

 
The proper use of this setting will ensure that outside edges are cut with both the tool bit and the tool 
path facing the cut. This will produce a clean, smooth-edged cut. 
EZ-Engrave uses defaults based on the type of offset being used. Since routers and engravers rotate 
clockwise, an Female offset will result in all outside edges being cut in an counter-clockwise fashion, 
while an Male offset will cut outer edges clockwise. An Online offset has no default direction, but will 
use the current setting. 

 

Gap 
The gap value is the space between the male and female pieces. A larger value produces a looser fit. 
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Lead In 
Selecting this option will cause EZ-Engrave to generate a Lead In for the tool path. A Lead In is an 
additional portion added to the start of the tool path which begins away from the edge of the object 
being cut. This additional path prevents any distortions to the edge of the object caused by the 
movement of the router bit while it is plunging into the material. 
The shape and position of the Lead In is governed by the following rules: 

¾ Lead Ins are only applied to those paths which define the edge of the object being routed 
(i.e., they are not applied to fill strokes in a rout job) 

¾ When performing an outside rout, the Lead In will be added from the outside of the object 

¾ When performing an inside rout, the Lead In occurs inside the object 

¾ If the first contour of the edge cut of the object is a straight line, the Lead In will also be 
straight 

¾ If the first contour of the edge cut of the object is a curve, the lead in will be curved 

¾ If a Lead In is specified but will not fit within a given object, or will not fit without making 
contact with any other object to be routed, the Lead In will not occur 

Note: When a Lead In is specified, the Bridge function is disabled. 

Clean Up/Flange 
When cutting an object to a deep final depth, multiple passes can be used (i.e., several cut passes at 
varying depth settings) to avoid burning the material or bit, to make sure that the corners of the cut 
objects are sharp, and to speed the cutting process. 
However, multiple passes can often leave a "stepped" appearance to the finished object as a result of a 
progressively dulled bit, or minute shifts in the media. 

 
A Secondary Clean-up Pass will help you avoid this result. Selecting a Secondary Clean-up Pass will 
cause the router to trace once more around the edge of the cut object with the bit at full depth, leaving 
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a smooth surface on the inside of the cut. 

 
Specify the offset for the clean-up pass in the edit box. Specifying a positive value will cause the tool 
bit to cut along a path nearer to the object being cut than the regular tool path. 

Flange 
Selecting Flange will cause the clean-up pass to cut closer to the object for female paths and farther 
away from the object for male paths. 

Female 
This option will cause the outside edge of the tool bit to trace the edge of the artwork from the inside, 
without cutting outside of the objects. The  

  
Tool Path will fall inside of the artwork with an offset equal to one half the width of the tool bit. This 
offset is typically used when filling or cutting out an object. 
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Fill 
Under some circumstances, a custom tool offset should be specified. The offset is applied to the path 
generated by the Online setting (i.e., “0” will result in a cut equal to the Online setting) with negative 
values placing the path inside a given contour, and positive values placing the path outside. The 
required offset can be specified as either a percentage of the tool bit width or as an absolute value in 
the current unit of measurement. 

 
Tool, Depth, Tool Library Button, Color, Inlay, Rotation, Gap, Lead In, Clean-up/Flange: See the 
explanations for all of the options available in the Fill style in the previous pages documenting the 
Male style of fill. 

Fill Style 
From the Fill Style scroll menu select from seven fill styles: None, S-sweep; Line-sweep; Spiral; 
Reverse Spiral; Island; and Reverse Island. 
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None 
As the name implies, there is no Fill Style, which means that objects will have their edges traced, but 
will not be filled. 

S-Sweep 
This fill will generate a Line Sweep-like fill pattern except that the line paths are joined wherever 
possible.  

 
This fill is generated very quickly by EZ-Engrave, and it decreases the number of lift and drop 
movements required by the routing machine, thereby reducing the amount of time required to produce 
a given job. 

Line-Sweep 
This style will generate a fill of separate and discrete fill lines.  

 
This fill pattern is designed for those machines which have a very short maximum path length, and 
therefore require short fill paths. A disadvantage with this style is that the cutting head lifts and drops 
for each fill path, increasing the amount of time required to fill given object. 
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Spiral 
This fill pattern will trace around the edge of a given object and then cut the object’s fill on the same 
path.  

 
This fill style is a fairly traditional one which reduces the cutter’s lift and drop-type movements. 
However, it may not be suitable for those machines requiring shorter tool paths or machines which use 
a floating nose cone to control depth. 

Reverse Spiral 
This fill style will begin in the middle of a given object and spiral outward until it traces the edge of 
the object.  

 
Because it will cut from the inside of an object to the outside, a reverse spiral fill is well-suited to those 
machines which use a floating nose cone to control depth. It also has the property of always cutting the 
edge of objects last, which can result in a cleaner edge cut. 

Island 
This fill style is similar to Spiral, except that it generates discreet paths beginning at the edge of the 
object and working in towards the center.  

 
Use this fill style to create a Spiral-like fill if the routing machine does not support long tool paths. 
This style generates a tool lift and drop for each of the islands generated, and is therefore slower than a 
Spiral Fill. 

Reverse Island 
Reverse Island fill is very similar to Reverse Spiral, except that it cuts from the center out in 
progressively larger paths.  

 
This style is ideally-suited to cutting with a machine that requires short tool paths, and is fitted with a 
floating nose cone. It will also ensure that edges of objects are cut last, this will result in a cleaner, 
smoother cut. A tool lift and drop is generated for each of the islands generated. 
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Fill Overlap 
Fill Overlap is the amount that each successive tool path should overlap each previous path. The Fill 
Overlap is applied only when an object is being filled (i.e., not when only tracing an object). 
It is important to have tool paths overlap to ensure that the cut has a smooth, even fill with no residual 
material left uncut between fill paths. 

 
Specify the fill overlap as either a percentage of the tool diameter, or as an absolute measurement. 

Fill Angle 
This portion of the dialog box is to specify the angle of fill strokes when filling objects. The angle is 
defined relative to the X-axis (horizontal). 

 
Fill Angle 0° Fill Angle 45° 
Specify a Fill Angle when cutting artwork that leans in a specific direction. Proper setting of the Fill 
Angle can result in substantially reduced production time. 
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WORKING WITH COLOR PALETTES 
The Color Palette situated along the bottom edge of the screen is used to segregate the graphics into 
different colors that can then be cut or manipulated separately from other colors. 

 
The colors may be scrolled left or right by clicking on the Scroll Arrows at either end of the palette. 

 
Each color plate has a number that can be displayed on the plate by selecting the Layers On / Off 
option in the General Preferences dialog box of the Options… Setup… menus. 

PRIORITY OF COLORS IN THE PALETTE 
The order of the colors in the Color Palette is very important as they control the default order in which 
objects on the screen will be cut. 
When using the Cut by Color option while cutting from the Plot dialog box, the objects colored with 
colors to the left will, by default, always be cut before objects assigned colors to the right. That is, 
objects assigned the color from plate number 4 will cut before objects assigned the color in plate 
number 5 or any other number greater than 5. 
The tools and menu commands will only be implemented for objects in active color layers. 

ACTIVE AND INACTIVE COLORS 
Colors can be de-activated to make them temporarily unavailable. When de-activated, objects of the 
inactive color cannot be selected, deleted, moved, or otherwise edited. 
Active color plates and objects assigned to that color will appear on the screen in solid outlines and 
solid fills. Inactive color plates will be cross-hatched rather than filled with a uniform color, and 
objects in inactive color plates will show on the screen in broken outlines with no fills. 

 

De-Activate an Active Layer 
Active layers can be de-activated by clicking on the appropriate color plate while holding down the 
[Control] key. 

Activate an Inactive Layer  
To re-activate an inactive color, simply click on the appropriate color plate while holding down the 
[Control] key. The objects in that color will now be shown in solid lines on the screen and the color 
plate for that color layer will be uniformly filled. 



Color Palette 

Activating and De-activating Multiple Layers 
Sometimes, it is required to isolate one object or group of objects from all others so that they may be 
quickly selected and worked with, without affecting any of the other objects on-screen. This can be 
accomplished by de-activating all colors except those which contain the desired object or objects. 
To selectively activate one layer and de-activate all other layers: 

¾ Press the [Alt] key while clicking on the desired color plate in the palette. 
All colors will become inactive with the exception of the color selected. 
To re-activate all colors de-activated with the previous command: 

¾ Click on the active color plate while pressing the [Alt] key. 
All layers will be returned to their active state. 

ASSIGNING A COLOR LAYER TO AN OBJECT  
The color assigned to a given object can be changed at any time. Simply select the object or objects to 
be assigned a different color, and click on the required color plate in the palette. The object(s) will now 
be assigned that color, and will be redrawn accordingly. 

Line/Fill Selector Icon  
At the far right side of the normal Color Palette is the Line/Fill selector icon.  
The Line/Fill selector icon is used to select either the fill inside a contour or any thick line applied to 
the contour. Assign color to the fill inside a closed contour without affecting the properties of any Line 
Style attribute that may have been applied to the contour line and vice versa.  
Repeated clicking on the Line/Fill Selector Icon  will toggle alternatively between the Fill mode and 
Line Style mode. Changing the mode of the Line/Fill selector also changes the Left/Right mouse 
selection of colors.  

¾ With the Line/Fill selector in the default position ,  the right mouse selection of a color 
plate changes the thick line color;  

¾ With the Line/Fill selector in the reverse position ,  the right mouse selection of a color 
plate changes the Fill color. 

Using the Line/Fill Selector Icon  
Changing the Color of the Fill inside a contour 

The Line/Fill selector icon has two modes of operation, the Fill mode and the Line Style mode. When 
the Line/Fill selector icon shows a solid filled circle, it is in the Fill mode. 
In this mode, any time an object and then a color from the Color Palette is selected, the color of the fill 
of that object will change to the selected color. 

16-2 • EZ-Engrave User Guide 



Color Palette 

Changing the Color of a Thick Line 
Click on the Line/Fill Selector icon, to change it to show an outlined circle (  ). This signifies that it 
is now in Line Style mode. 
When in this mode, select a target color for the Line Style feature. In addition, if an object is selected 
before selecting the thick line target color, this object’s Line Style attribute will be assigned the 
selected color, whether a thick line has been applied to the object or not. 

When you select any object while the  icon is in the Line Style mode, you will be selecting only the 
Line Style attribute of the contour, not the fill associated with the contour. Once the thick line has been 
selected, selecting a new color from the color palette will change only that thick line ’s color, and not 
the color of the selected object’s fill. 

   
Box with Black Thick Line Selector in Line mode Thick Line color changes  
  while Fill is not affected 

   
Box with Black Thick Line Selector in Fill mode Fill color changes while  
  Thick Line is not affected 
In the top right corner of the Status Bar, a color indicator will display the color is being assigned to the 
thick line, and the color that is being assigned to the fill for any selected object. 
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TARGET COLOR 
One color must be designated as the Target Color. The Target Color is indicated in the Color Palette as 
the color plate surrounded by a white border. 

                
The significance of the Target color is that any new objects created or imported into the view screen 
will always be assigned to the Target Color by default unless it contains other layer information to the 
contrary. This means that any .DXF and .PLT files imported into the view screen, weed borders, 
rectangles and circles made with the  tool, text made with the  tool, and graphics created with the 

 tool will be created in the Target Color automatically (imported .CDL and .EPS files will contain 
their own layer information which will over-ride the Target Layer default). 

CHANGING THE COLOR PALETTE 
Change the Order in the Color Palette 

The order of the colors in the color palette is significant, particularly when using the Cut By Color 
feature available for EZ-Engrave. This is because objects will be cut by default in the order in which 
their colors appear in the palette. 
To change the order of a color: 

¾ Click on the color plate to be moved, and drag it left or right to its new position in the 
hierarchy. 

All the colors to the right of its new position will change their layer number to reflect their new 
position in the hierarchy. 

Changing the Background Color 
The sign blank background may be assigned a specific color in the palette. To assign the background 
to a specific color: 

¾ Click on the color plate corresponding to the color for the background screen color; 

¾ Drag the color plate to the single plate location which is to the left of the left hand side Scroll 
Arrow. The background will change to the new color.  
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Adding New Color to the Color Palette 
To add a new color: 

¾ Position the cursor on the Color Palette where the new color is to appear; 

¾ Double-click on the plate. 
The following dialog box appears: 

 
There are three ways of allocating color in the dialog box: 

¾ RGB (red, green and blue) 

¾ HLS (hue, lightness and saturation) 

¾ GRAY (gray scales only) 
Mix the color as required by adjusting the color controls. The color being mixed at any time is shown 
in the dialog box. 
Once satisfied with the color mix, select Add Layer. The new color plate will appear in the Color 
Palette where selected and the number originally in that plate will be assigned to the new color. All 
colors to the right will have their color number index to a higher number. 
There is always one color plate left blank which can be used to add a new color. This blank plate is 
located at the right hand end of the Color Palette. This blank plate can be used to add a new color 
without disturbing the color priority of the existing colors. 

Changing an Existing Color 
To change the color of an existing color plate: 

¾ Double-click on the color to be changed to bring up the Color dialog box; 

¾ Mix the new color for the selected color plate;  

¾ Select the OK button from the dialog box. 
The new color will now appear in the selected plate. All the other color plates will retain their original 
plate numbers and priority. 

Tool Number 
This setting provides the ability to specify a different tool for each color where multiple tools are 
supported by the plotter. For example, certain plotters allow plotting with two or more different pens at 
the same time. To take advantage of this fact, assign different tool numbers to the different colors 
plates. 
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CHANGING THE PALETTE 
As well as editing a color or color palette, the palette in use can be changed, or, create new palettes. 

¾ Select Palette from the Options menu; 

 
¾ The Palette fly-out menu appears. 

 

Palette Menu 
This menu provides the means by which palettes can be managed, both the currently active palette in 
EZ-Engrave and those previously saved.   

Edit Palette 
The Edit Palette option provides the ability to generate a new palette for use with EZ-Engrave. It 
produces the Edit Palette dialog box: 

 
The scrolling box along the left side of this dialog box contains a graphical list of all of the colors 
currently in the palette. The other sections of this box are used to generate new plates for the palette. 
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Color Box 
This section of the box provides the ability to specify a new color to add to the palette, and offers the 
following options: 

 

Type 
Offers the choice to use one of four color processing options: 

 
Photo Process................ Applies full color calibration with changes to hue, lightness, and saturation. 
Chart Process ................ Applies ink level changes only to the printed output. 
Spot  ...................... Allows for multiple-pass printing using custom color cartridges. 
Actual ...................... Prints exactly the color and ink levels called for by the color plate. 

Current 
Displays the currently selected color (the target color). 

New 
Displays the new color as it currently appears.  This box changes as color are adjusted. 

Color Sliders and Scales 
Color can be adjusted using one of three scales by selecting the appropriate radio button, and then 
moving the relative slider: 
RGD  Red/Green/Blue, 

  
HLS  Hue/Lightness/Saturation, and  
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CMYK  Cyan/Magenta/Yellow/Black. 

 

Pick… Button 
The Pick button opens the Color dialog box. Use this box to select or create a new color. 

 

Palette Management Section 
EZ-Engrave is supplied with a series of palettes in addition to the standard palette which appears when 
EZ-Engrave is first opened. These palettes are organized by vinyl manufacturer, and provide a 
representation of the most current catalog at the time this version of EZ-Engrave was produced. This 
section provides the ability to save, mix, and manipulate the completed color plate and the various 
color palettes. This is accomplished through the use of several features: 

Add 
The Add button adds the color created to the current palette without affecting the original color from 
which the new color was created. 

Delete 
The Delete Button removes the selected color plate from the palette. Because this button does not 
distinguish between the new color and the color from which it is derived, but simply deletes the 
selected color, caution should be exercised when using it to avoid inadvertently deleting colors. 

Change 
The Change Button changes the selected color plate into the color created. 

Load 
The Load Button provides the ability to load a previously-saved palette in place of the current palette. 
Any colors which are currently being used will remain in the palette. 
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Using An Illegal Name For The Palette 
DOS has certain conventions for naming files which must be followed when naming a palette file. The 
name of the file cannot contain more than eight characters, nor can it contain commas or colons. When 
specifying the name of the palette these conventions must be used, or EZ-Engrave will not be able to 
save the file. 
If Save Palette On Exit is checked, and an illegal name is used for the palette, then exiting EZ-Engrave 
produces a warning indicating a problem with the file name. There is a choice between aborting the 
exit or exiting. If the file is closed without changing the name of the file, the palette will not be saved. 
If Load Palette At Startup is checked, and an illegal name for the palette is specified, EZ-Engrave 
cannot load the specified palette, and will load the default EZ-Engrave palette instead. 

Save As 
The Save As Button provides the ability to save changes to a new palette file, thus allowing several 
palettes to be maintained for use in EZ-Engrave. 

Load From… 
The Load From... Button provides the ability to access previously-saved palette libraries, and load 
individual colors from them. 

Color Characteristics Section 
This section provides the ability to enter important data about the color created, or to access 
information about the colors in the palette. The available information includes the Color Name, the 
Vendor, the vendor’s color or part Number, and the Type of material for each color plate. 

Tool Number 
This setting provides the ability to assign a specific tool to the selected color. This can be particularly 
useful when the plotter supports multiple pens, or when planning to rout the file using several different 
tool bit sizes. 

Close 
Selecting this option closes the current palette, if the palette has not been saved using the Save As 
button no changes will be applied. If the palette has been saved, the option is available to use either 
this new palette created when EZ-Engrave opens, or the original EZ-Engrave palette. 

Alternate palettes can be accessed via the Palette options in the Preferences dialog box. 
¾ Select General Preferences from the EZ-Engrave Setup fly-out menu. 
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The General Preferences dialog box will open. The Palette section of the preferences dialog box 
provides the ability to develop and configure palettes as alternatives to the default palette supplied with 
EZ-Engrave. It is primarily used to develop a permanent palette as an alternative to the palette 
provided with EZ-Engrave. 
From the Palette box: 

 

Load Palette At Startup 
This option is used to load the palette named in the Palette File entry box, by default, whenever EZ-
Engrave is started. Clicking on this check box causes EZ-Engrave to load the named palette each time 
it re-starts, while leaving it unchecked causes EZ-Engrave to load the default palette. 

Save Palette On Exit 
This option tells EZ-Engrave whether or not to save changes to the palette when exiting EZ-Engrave. 
Clicking on this check box causes EZ-Engrave to save the palette under the name specified in the 
Palette File entry box, while leaving it unchecked causes EZ-Engrave to discard changes on exit. 

Sort Palette 
The Sort Palette option allows for sorting the colors in the Color Palette from the most commonly used 
to the least commonly used in the file on screen. There must be objects in the EZ-Engrave Edit 
Window or this option will not be made available. There are two options for this sort.  

 

By Selected Objects 
This option will sort only those colors which occur in the objects selected. All other colors will appear 
in the palette behind these colors in the order in which they originally appeared before the sort. 

By All Objects 
This option will sort tall of the colors in the palette based on their use in the file, from most to least 
used. Any colors which appear in the palette, but do not occur in the file will be placed at the end of 
the palette in the order in which they originally appeared. 

Truncate Palette 
Selection of this option will cause EZ-Engrave to remove all unused colors from your Color Palette 
from the current Target Layer forward. If, for example, the current Target Layer is the fiftieth color in 
the palette, the Truncate Palette command will eliminate all unused color plates from the fifty-first on. 

Reset Palette 
Invoking the Reset Palette command will replace the current palette with the original EZ-Engrave 
default palette. Resetting the palette will not delete any colors in use from the color palette. Any colors 
that are not part of the default palette will appear at the end of the reset palette. 

Note: The Reset Palette command, resets the palette to the default EZ-Engrave palette. 
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BRAILLE MODULE - INTRODUCTION 
The Braille module is designed to provide highly accurate, ADA compliant Braille translations for all 
signage needs. It is supplied with four standard fonts that meet the needs of nearly any project. To be 
able to take advantage of the unique Braille capabilities available in EZ-Engrave, the Braille Module 
must be installed in with the EZ-Engrave software. 

BRAILLE TRANSLATOR  
The Braille module is located within the Text tool bar. The Translator remains invisible except for the button that 
controls it, and is activated when the correct password is installed into EZ-Engrave. For instance if the Professional 
Text Compose password has been installed the Braille Module is activated. 

Braille Translation 
Any Text paragraph is designed to hold the text strings that will be translated into Braille.  
Un-translated text can be included within a paragraph with Braille text. After a string of text has been 
translated place the cursor in the appropriate spot and enter the un-translated text with the Braille Text 
paragraph. 

Selecting a Braille Font 
Before using the Braille Translator a Braille font must be selected as the target font for the translation 
process. To access the Braille Font Selector Dialog box right mouse click on the Braille button . The 
Braille Properties dialog box opens. 

 

Braille 
The Braille font scroll list displays all the fonts available for selection. Press the down arrow to vie the 
drop-down scroll list and select the appropriate font. 

Height 
Set the height of the font characters in this selection box by either using the scroll buttons or by 
highlighting the current entry and typing in the amount from the keyboard. 
When selecting a Braille font, the Character Height is automatically set to .395 inches, the Federally-
mandated standard in the United States. Change this height to suit a particular job, however, when 
selecting a Braille font, the height always returns to this default value. 
The height of the Braille characters may be changed on a job-by-job basis in the same way as normal 
text within text compose.  



Braille Module 

Browse 
If the Braille font required is not available in the Braille font scroll list press the Browse button to 
activate the Font Detective to add the required fonts to the system. 

Braille Button  
Pressing the Braille button causes all text to be translated into Braille. 

 
Because pressing the Braille button translates all selected text, even already translated text, be careful 
not to translate until all of the text to appear in Braille is entered. Otherwise, all text that has previously 
been translated within the text will be lost, and replaced with the new translation. 

Mixing Braille and Roman Text 
To create a sign that includes both Braille and Roman (English Alphabet) text, certain procedures 
should be followed to ensure satisfactory results. To include un-translated (Roman) text within a 
paragraph with Braille text, enter the text directly into the Braille Text paragraph, the text will then 
appear exactly as entered. Always enter all text to be translated to Braille, and then press the Braille 
Translate button before entering any Roman text into the Braille Text paragraph. For example, when 
creating a mixed Braille and Roman font sign such as: 

 
¾ Enter “Admitting” into the Text paragraph; 
¾ Press the Translate button; 
¾ Enter “Admitting” as Roman text into the Braille Text paragraph in the appropriate place. 

BRAILLE FONTS 
There are four fonts provided with EZ-Engrave’s Braille Module: 
¾ Engraving;  
¾ Photo-resist; 
¾ Pre-bled Photo-resist, and  
¾ Punch. 

Before pressing the Translate button, select one of these four Braille fonts. This ensures that the 
translated text appears in Braille, and not some other font. These fonts are designed to accommodate 
the three most common forms of Braille signage:  
¾ Engraving;  
¾ Photo-resist; and  
¾ Punch. 
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Engraving Font 
The Engraving font included with the Braille module is designed and optimized for routing and 
engraving. It consists of uniform rectangles with appropriately placed dots representing the Braille 
characters. When engraving these characters, the engraver should automatically remove all of the 
material within the box, leaving only the Braille character. 

 

Photo-Resist Font  
The Photo-resist font included with the Braille module is designed for use with photo-resist materials. 
Its characters consist of dots representing the Braille characters on a clear background, which when 
used as a mask in the photo-resist process, will produce properly spaced Braille characters.  

 

Pre-Bled Photo-Resist Font 
When producing Braille using the photo-resist method of production, using a font with the dots the 
correct size sometimes results in a finished font where the dots are slightly larger than standard. To 
address this concern, Roland has included with the Braille Module a Photo-resist font that is size-
corrected to create properly-sized dots when producing Photo-resist Braille lettering. 

Punch Braille Font 
This Punch Braille font, like the other three, produces ADA-compliant signage. It is designed for use 
with punch Braille machines that do not engrave, but rather punch the dots of each character into a 
semi-soft signage substrate.  

Braille and Character Height 
When selecting a Braille font, the Character Height is automatically set to .395 inches, the Federally-
mandated standard in the United States. Change this height to suit a particular job, however, when 
selecting a Braille font, the height always returns to this default value. 
The height of the Braille characters may be changed on a job-by-job basis in the same way as normal 
text within text compose.  

Braille And AutoKern 
Whenever the Braille translator is active, AutoKern and all of its components are disabled. This is 
because the Braille fonts are carefully constructed to meet the Federally-mandated standard in the 
United States. Autokern, and especially any special kerning modes (Wide, Narrow, etc.) will disrupt 
the proper spacing of Braille characters. 
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BRAILLE TRANSLATOR IN 4.95 TEXT COMPOSE  
The Braille module is located within the Professional Text Compose dialog box in EZ-Engrave. Until 
activated, the Translator remains invisible except for the button and check box that control it. The 
button remains inaccessible until the translator is turned on, by clicking on the check box. 

 

Braille Check Box 
This box is used to activate the Braille translator. It does not translate text to Braille, but rather readies 
the translator to accept text. When activated, the Braille Translator appears in the text entry box of the 
text compose dialog box: 

 
The text entry box is now divided into two areas: The Untranslated Text box, and The Braille 
Translation Box. 

Untranslated Text Box 
This box is designed to hold the text strings that will be translated into Braille. Unlike the normal Text 
Entry box, nothing entered into this box appears on screen in EZ-Engrave unless translated first. Think 
of this box as a holding area where text is held until translated to Braille. 

Braille Translation Box 
Once the text entered in the Untranslated Text box has been converted to Braille, it will appear in the 
Braille Translation box. This box displays the text to be produced on screen by Text Compose, 
including all formatting and font information. 
Untranslated text can be included within a paragraph with Braille text. Enter the required text into the 
Braille Translation box, as with the regular Text Entry box. This text will not be translated into Braille, 
but instead appears on screen exactly as entered, including all formatting and font information. 
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Braille Button  
Pressing the Braille button causes three separate events to occur:  

 
¾ First, all text is cleared from the Braille Translation box;  
¾ Second, all text in the Untranslated Text box will be translated into Braille; 
¾ Third, the translation will be placed in the Braille Translation box. 

Because pressing the Braille button clears the Braille Translation box, be careful not to translate until 
all of the text to appear in Braille is entered. Otherwise, all text that has previously been translated 
within the box will be lost, and replaced with the new translation. 

Mixing Braille and Roman Text 
To create a sign that includes both Braille and Latin (English Alphabet) text, certain procedures should 
be followed to ensure satisfactory results. 

Entering Roman Text 
To include untranslated (Roman) text within a paragraph with Braille text, enter the text directly into 
the Braille Translation box, as with the regular Text Entry box. The text will then appear on screen 
exactly as entered. 

The Braille Button for Mixing Braille and Roman Text 
Pressing the Translation button clears all text from the Braille Translation box before translating text 
from the Untranslated Text box. This means that any text entered directly into the Braille Translation 
box will be lost if the Braille Translate button is pressed. 
Always enter all text to be translated to Braille, and then press the translate button before entering any 
Roman text into the Braille Translation box. For example, when creating a mixed Braille and Roman 
font sign such as: 

 
¾ Enter "Admitting" into the Untranslated Text box; 
¾ Press the Translate button; 
¾ Enter your Roman text into the Braille Translation box in the appropriate place; 
¾ Press the OK button in the Text Compose dialog box. 
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FILE 

  

NEW 
Use the New option to begin a new design session. If there is a file on screen, it will be removed from 
the view screen and all system resources, such as memory. If the existing drawing on screen has not 
been saved, a prompt to Save the file Untitled.CDL appears. 

 

OPEN 
This option recalls an existing file onto the screen from the hard drive. Prior to opening a new file, a 
prompt opens, to Save any existing graphic on the screen if changes were made to the file. Unless the 



File Menu 

Merge option is selected, opening a file will remove all objects from the screen and system resources.  

 

Keyboard Shortcut: [Ctrl+O]  

Look In 
The Look In statement displays the current file path selected. 

 

Click on the Up One Level button   to back up in the directory structure. 

Files 
The Files box shows a list of files available in the selected directory. Any files showing in the scroll 
window may be accessed. To view more files click on the Scroll Bars at the side of the box. 
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Files can be viewed as Large icons (as above), as a list of icons — click the List button , or as a 
detailed description — click the detailed button . The Files box acts like a window in Windows 
Explorer, right mouse clicking within the window provides the same options as available for an 
Explorer window.  

 

File Name 
The File name box shows the file that has been selected from the Files List box.  

 

Files of Type 
Only Ideal Stencil files, *.CDL and *.BAK files, may be accessed from within the Open File dialog 
box, though All Files *.* can be viewed. 
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File Preview 
The window at the bottom of the Open dialog box gives easy access to useful information regarding 
the selected files, such as: 

  
¾ the directory path and file name; 

¾ the size of the selected file; 

¾ the creation date of the file; and 

¾ the date the file was last updated. 
For easier selection of files, a thumbnail view of the selected CDL file appears within the Preview 
window. The Preview check box must be marked to use this option. 

   
When opening a file from the Program Manager, or through the Windows ’95 Explorer, CDL files 
saved with the preview option use a file image as their icon.  Older versions of EZ-Engrave files do not 
have a preview. 

Merge 
The Merge option should be selected if the file being opened is to be combined with the file currently 
on screen. 

 

Open 
Once the desired file is selected, it may be opened by double-clicking on the file name, or by single-
clicking on the file name to select it and then clicking on the Open button. When the file appears on the 
screen, all objects in the file will be restored to the Layers to which they were assigned when they were 
saved. 

To Open a File 
Before opening a file, check the Look In box to see if the required directory and drive is selected. All 
files available in the selected directory will automatically be listed in the Files box. If the directory is 
not listed in the Look In box, click the Up One Level button   to back up in the directory structure. 
Once the required file is selected, it may be opened by double-clicking on the file name, or by single-
clicking on the file name to select it and then clicking on the Open button . When the file 
appears on the screen, all objects in the file are restored to the Layers assigned when they were saved. 
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SAVE 
The Save command is used to store a file on a hard drive or floppy disk. Selecting this command will 
cause the file in the main view screen to be saved under the current file name, displayed in the title bar 
at the top of the screen. Files saved with the Save command will be stored in the current directory as a 
.CDL file format. All Color, Sign Blank and Tiling information will also be stored within the file. The 
first time a file is saved, Save will perform like Save As. 

Keyboard Shortcut: [Control + S] 

SAVE AS 
The Save As command is used for saving the file currently on screen under a new name or in a 
different directory. The EZ-Engrave Preview - Save As dialog box will appear on screen. 

 

Keyboard Shortcut: [Control + V] 

Save In 
The Save In statement displays the current file path selected. 

 
Click on the Up One Level button   to back up in the directory structure. Click on the Create New 
Folder button  to add to the current directory structure. 
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Files 
The Files box shows a list of files currently in the selected directory.  

 

File Name 
The File name box shows the file that has been selected from the Files List box.  

 

Save as Type 
Files can be saved as Ideal Stencil files, *.CDL, or with any specific extension with All Files, *.*, 
selected. 

 

Note:  Changing the file extension does not convert the files to another application, they 
are still EZ-Engrave files. However, the extension will not be recognized by EZ-
Engrave unless the association settings in Windows is changed. 

File Preview 
The window at the bottom of the Save As dialog box provides the directory path and file name. 

 
If a file has previously been saved, a thumbnail view of the selected CDL file appears within the 
Preview window. If this is the first time the file is being saved the preview will remain blank. The 
Preview check box must be marked to use this option. 
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Include Icon 
When opening a file from the Program Manager, or through the Windows ’95 Explorer, CDL files 
saved with the Include Icon option use a file image as their icon. To save a file for an older EZ-
Engrave version, then do not check this option when saving the file. 

  

 

Preview Color Format 
The preview can be saved as one of four different color formats:  Two color (one bit); Sixteen color 
(four bit); 256 color  (eight bit); and True color (twenty-four bit). 

 

Preview Size 
The preview size can be set as one of five different size options:  Tiny (thirty-two pixels square); Small 
(forty-eight pixels square); Medium sixty-four pixels square); Large (ninety-six pixels square); and 
Huge (128 pixels square). 

 

Selected 
Using the Selected option ensures that only those items that are currently selected in the file on screen 
are saved. 

 

Save 
Once the required file is named, it may be saved by clicking on the file name to select it and then 
clicking on the Save button.  
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IMPORT 
The Import command is to open files in formats other than *.CDL.  

 
The Import dialog box functions in the same manner as the Open dialog box, for detailed information 
on some of the featurs for the Import dialog box refer to the Open dialog box earlier in the section. 

Files of Type 
In the Import dialog box a listing under Files of Type includes many of the following, depending on 
the modules installed: 
>  .AI  >  .BMP  >  .CDL  >  .CMF >  .CMX >  .DC2  
>  .DCX  >  .DIB  >  .DWG >  .DXF >  .EPS  >  .GC1  
>  .GC2  >  .GC3 >  .GNT >  .GTP >  .JPG  >  .PCD  
>  .PCX >  .PLT  >  .PRN >  .SYM >  .TGA  >  .THZ 
>  .TIF  >  .VE >  .WMF >  .WPG. 
The Import option provides the ability to recall an existing file onto the screen. Unless the Merge 
option is selected,  importing a file will remove all other files from the screen and all system resources.  

18-8 • EZ-Engrave User Guide 



File Menu 

Files of Type Filter 
The Filter button at the bottom of the dialog box provides the ability to limit the Import filters listed in 
the Files of Type list box.  
Pressing the Filter button opens the Filter Options dialog box. Simply activate or de-activate a filter by 
clicking in the check box. Press OK to return to the Import dialog box. The next importing session only 
those filters that are activated will appear in the Files of Type list. 

  

Thick Line 
The Thick Line option will apply a Thick Line to all outlines and hairlines in the file to be imported. 

 

A Note Of Caution: When importing .EPS and .AI files, be aware that EZ-Engrave does 
not recognize line thickness information in these file types. 

Importing Photo CD (PCD) 
Electing to import a Photo CD file opens the PhotoCD Image dialog box: 

 
From within this box, select the Resolution and Color Format for the Photo CD file to import. 
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A Note About CorelDRAW!TM CMF Files 
If a CorelDRAW!TM version 3, 4, or 5 is installed on the hard drive, EZ-Engrave installs an export 
filter into the CorelDRAW!TM export menu. This is a custom export filter optimized for file exchange 
between CorelDRAW!TM and EZ-Engrave. The filter appears in the CorelDRAW!TM export menu as 
“Export To EZ-Engrave” and generates *.CMF files. This is the preferred method of file exchange. 

Note: The CMF filter is not available if running CorelDRAW!TM 5, 6, 7, or 8. There is 
an add-on module called Short-Cut to export from versions 5, 6, 7, or 8. The CMF filter 
is not available if CorelDRAW!TM is running from the CD-ROM. 

To Import a File 
Before importing a file, check the Look In box to see if the desired directory and drive is selected. All 
files available in the selected directory will automatically be listed in the Files box. If the directory is 
not listed in the Directories box, use the Up One Level  button to step up to the parent sub-directory. 
Once the required file is selected, double-click on the file name, or single-click on the file name to 
select it and then clicking on the Import button. When the file appears on the screen, all objects in the 
file will be restored to the Layers to which they were assigned when they were saved. 

 

EXPORT 
The Export dialog box works in the same way as the Save and Save As dialog boxes excepte that the 
files can be exported in numberous types of files. For more information on the features within the 
Export dialog box please refer to the Save documentation earlier in the section. Select the Export 
command to open the following dialog box: 

 

18-10 • EZ-Engrave User Guide 



File Menu 

File Type 
The File Type box shows the file types available with the Export command. The Export command is 
used to save a file in a format other than .CDL. EZ-Engrave offers the option to save files in several 
different formats, depending on the modules installed: 
>  .AI  >  .DC2(Line)  > .DC2(Line_Arc)  >  .DXF(Line)  >  .DXF(Polyarc) 
>  .DXF(Polyline) >  .DXF(Spline) >  .EPS >  .GAD  >  .GC1  
> .GC2 0 >  .GC3 >  .PLT >  .PS > .TXT(HTD)  
>  .TXT (Newing-Hall) 

Filter 
The Filter button provides the ability to choose which filters will be available for use with the Export 
feature. Refer to the Import documentation earlier in this section (pp.9). 

Customize 
The Customize button provides the ability to set the Export Error Tolerance. Press the Customize 
button to open the Parameter Specification dialog box. 

 
When exporting a file from EZ-Engrave, the resulting file sometimes contains a very large number of 
nodes. This is especially true of artwork that was originally imported from another software. To 
combat this problem, EZ-Engrave allows exporting of files using a certain tolerance level, this will to 
make the exported artwork smoother, and substantially reduce the number of nodes in the file. 
Specify the acceptable amount of error in the Error Tolerance edit box. This box uses the unit of 
measurement specified in the General Preferences dialog box as its standard (i.e., inches or 
millimeters). 
We caution against entering a high value in this box, as the Export Error Tolerance may introduce 
distortion into the exported objects if set for a very high tolerance. As a rule, the default value (0.001 
or 1/1,000 of an inch) will work very well with most files. 

Exporting a File 
¾ When exporting a file select the type of file format from those available in the File Type box; 

¾ Move the cursor to the Save In box and specify the desired Path; 

¾ Enter the file name into the File name box. 

EDIT TEMPLATE 
Selecting this option activates the Open dialog box specifically in the Templates directory of the EZ-
Engrave folders. Contained within this folder are the default template files that come with the EZ-
Engrave application. For more information regarding Templates refer to Templates in the Layout menu 
section later in this chapter. 
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EXPORT IMAGE 
Export Image provides the ability to export the bitmap portion of the file currently on screen in a 
raster/pixel output format. Choose from BMP, PCX, or TIF formats.  
Export Image works similar to Export, however, it will not allow exporting of vector-based objects. 
See the previous pages on Export for more detailed instructions on the options available with Export 
Image. 

ACQUIRE IMAGE 
The Acquire Image option allows access to the TWAIN support offered by EZ-Engrave. This support 
provides the ability to operate TWAIN-compliant scanners directly from within EZ-Engrave, without 
any intermediary software. To function properly, the scanner control software must be properly 
installed within Windows, and must be TWAIN-compliant.  

 
There are two options available under the Acquire Image command. 

Acquire 
This option calls the TWAIN-compliant software, initializes the scanner, and prepares the system to 
receive a scanned image. Upon exit from the scanning software, the acquired image will be imported 
into EZ-Engrave. 

Select Source 
This option provides the ability to choose the TWAIN input device that will acquire images.  
If only one source (i.e., only one scanner and/or scanning software) is attached to the system, set this 
once. However, if more than one source of TWAIN-compliant input (i.e., both a flat bed scanner and a 
hand-held device) is attached, this feature provides the ability to choose between the devices to suit 
specific needs at any time. Select Source opens the Select Source dialog box: 

 

Sources 
The Sources box lists all available TWAIN-compliant devices attached to the system. Click on the 
source to receive data from, and press the Select button.  

Select 
Pressing the Select button changes the source and returns to the main EZ-Engrave view screen. 
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JOB/COST NOTES 

 
The Job/Cost Notes option opens a dialog box to enter all relevant information for a given job. The 
information then becomes part of the file itself, and is always available for review. To access the 
Job/Cost Notes dialog box, select this option from the file menu. 

Company  
Enter the name of the company for whom the current job is being produced in this entry box. 

Date 
The Date field can be used to note the date the job was started or the order taken. Values in this field 
must be entered manually, as there is no automatic date function. 

Contact 
Enter the name of the person responsible for contracting and accepting the finished job. 

Job # 
For an inventory of jobs by number or by any other alpha-numeric code for filing purposes, enter that 
appropriate code into this box. 

Address 
Enter the street name, unit number, and bay or apartment of the customer in this field.  

City 
Enter the city of the customer. 
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Prov. /State 
This field is used to note the name of the province or state where the customer is located. 

Zip/P-Code 
Enter the customer’s Zip or Postal Code in this field. 

Telephone 
Enter the telephone number for the contact for the current job. 

Fax 
Enter the fax number of the contact in the Fax field. 

Order Taken By 
Enter the name or employee number of the person who took the order for the job in this space. With 
more than one salesperson, attribute each job to a specific employee. This provides the ability to 
clarify details with the appropriate person on staff, or to track sales by employees. 

Cust Order # 
Enter the Job or Customer Order number if Purchase Orders are required prior to starting a job. 

File Name 
The name of the EZ-Engrave file will automatically be entered in this field when the Job/Cost Notes 
dialog box is accessed. If the file is saved under a different name, that change is reflected in this field. 

Job Description 
A brief description of the job should be entered into this field. This will help identify a given job 
quickly and easily. 

Vinyl Type & Color(s) 
This field is used to identify the manufacturer, grade, and color of each piece of the vinyl used in the 
current job. This facilitates repairs to, or reproduction of, the job in the future. 

Sign Blank Size 
This field is used to track the final size of the finished Engraveing, including substrate. This field 
automatically displays the size of the sign blank and will change to reflect edits made to that setting. 

Material Type 
Enter the type of material the current job is to be constructed with in this field. (i.e., If the job is to be 
routed in plastic, specify “plastic” in the Material Type field. If routing or engraving in a specific type 
of wood or metal, enter the material accordingly). 

Complexity 
Many Engravers makers use a complexity rating in order to help set pricing on certain types of work. 
Rate each job for complexity and enter the complexity value in this field. 
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For Example: Because of the letter welding and intricate weeding, a Engraving using 
script lettering takes more time than one using a sans serif font. It would be considered 
more complex than the sans serif Engraving, and would be priced accordingly. 

Graphics Size 
This field reflects the finished size of the current job, including all elements of the job, but not 
including the sign blank. This field is automatically calculated and updated each time the Job/Cost 
Notes dialog box is opened. 

# of Bitmaps 
This field reflects the number of bitmaps currently contained in the job, and is automatically calculated 
and updated each time the Job/Cost Notes dialog box is opened. 

# of Shapes 
This field reflects the number of polygons and non-text objects contained in the current job, this 
includes all text objects that have been converted to graphics. The # Of Shapes field is automatically 
updated each time the Job/Cost Notes dialog box is opened. 

# of Text Chars 
This space indicates the number of text characters contained in the current job — excluding text 
objects converted to graphics or generated by the Dimensioning feature. This field is updated 
automatically when the Job/Cost Notes dialog box is accessed. 

Note: Any text character converted to graphics will be recognized as graphic objects 
and included in the # of Shapes field. This includes all text that has been transformed, 
welded, converted to graphics, or has had the path broken or the corners rounded. In all 
cases, a dialog box warning appears before the text is converted. 

# of Colors 
This field displays the number of colors currently used in the job, and is automatically updated each 
time the Job/Cost Notes dialog box is accessed. 

Computer Time 
Use this box to track the amount of computer time spent on a given job. This can be useful information 
when calculating the cost of a given job. Enter the value in this box manually, there is no automatic 
time calculation for this function. 
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Used in combination with TimeSign, available through the Help Menu, the Computer Time field can 
be a crucial aid in calculating bill-able time accurately. 

  
See the section on the Help menu later in this chapter for more information on the TimeSign feature. 

Routing Time 
This box may be used to track the amount of time required to rout a given job, and can aid in 
calculating job costs. This is particularly useful for jobs requiring output on a router or engraver, where 
machine time is a bill-able expense. Values are entered manually, there is no automatic time 
calculation available for this function, however, it can be used in combination with TimeSign to 
calculate bill-able time accurately. 

Weeding Time 
This field is designed to reflect the amount of time required to weed the current job. It is typically used 
either to note the estimated weeding time (for pricing purposes) or the actual weeding time (for 
reference in pricing future jobs).  Values are entered manually, there is no automatic time calculation 
available for this function, however, it can be used in combination with TimeSign to calculate bill-able 
time accurately. 

Routing Time 
Enter the amount of time required to Rout the current job. This field is primarily designed as an aid for 
estimating or costing jobs which specify large-format digital routing, but is also useful for those jobs 
which require printed previews. It may be used to note estimated routing time for pricing, or actual 
routing time for job costing. Values are entered manually, there is no automatic time calculation 
available for this function, however, it can be used in combination with TimeSign to calculate bill-able 
time accurately. 

Production Time 
Enter the required production time in this field. It may reflect the estimated time required for pricing 
purposes, or actual time required for job costing. Values are entered manually, there is no automatic 
time calculation available for this function. 

Travel Time 
Enter the amount of time required to get to and from the current job site in this field. This feature can 
be particularly useful where travel time is a factor in the final cost of the Engraving. 
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Delivery Date 
Enter the due date scheduled for the current job in this area. 

Materials Cost 
Enter the actual or estimated cost of materials for the current job in this field. 

Labor Cost 
The cost of labor should be entered into this field. 

Selling Price 
For future reference, and as an aid to job pricing and accounting, include the selling price of the 
current job in this space in the Job/Cost Notes dialog box. 

Print 
The Print button  opens the Print dialog box to send the Job/Cost Notes sheet to the selected 
printer. 
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PRINT 
The print option sends the current drawing on the screen to a Windows supported printer/ router/ 
engraver. Click on the Print option and the Print dialog box appears: 

 
This Print dialog box is a standard Windows printing dialog box, with three tab levels available: 
Printing; Preferences; and Margins. 

Printing 
Within the Printing tab are options to select the Printer/ router/ engraver, Print Mode, Printer/ router/ 
engraver Setup, number of Copies, as well as the option to Fit to Printer and to Print Badges. 

Printer/ Router/ Engraver 
The current printer/ router/ engraver  selected will be shown directly under the title of the Select 
Printer Options dialog box. A list of available printers/ routers/ engravers is shown inside the Printer 
list box. These are the drivers set up in the Control Panel. Select the required printer/ router/ engraver 
from the choices shown in the list box by clicking on the required printer/ router/ engraver. The 
selected printer/ router/ engraver will become highlighted. 

Note: If a printer/ router/ engraver is not displayed in the printer list box, the printer 
driver must be loaded into Windows using Windows Control Panel before it becomes 
available in EZ-Engrave (See the Control Panel section later in this chapter), Print 
Mode 

Specify the portion of the file to be printed/ routed/ engraved by one of three criteria: All; Sign Blank; 
and Selected.  
Selected Prints only those objects that are currently selected. 
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SignBlank ..................... Prints/ routs/ engraves everything within the confines of the SignBlank, any 
objects outside the SignBlank are left un-printed. When using this option, it is important to 
remember that any object which appears only partially on the SignBlank will be only 
partially printed/ routed/ engraved.; and  

All ..Prints/ routs/ engraves everything within the open file, including objects outside the confines of 
the SignBlank.; 

Printer Setup  
The Printer Setup button  opens the Setup dialog box for the selected printer.  

 
Changes made to this dialog box, and all related dialog boxes accessed though the Setup dialog box, 
are system-wide. Any changes are applied to the Windows’ Print Driver for the selected printer/ router/ 
engraver, and as such, these changes will appear in all other Windows programs. For example, if the 
print resolution for the driver is changed, this change occurs throughout Windows until changed again. 

Fit to Printer 
This option is used to size the printed image to fill the printable dimensions of the sheet currently 
loaded in the printer/ router/ engraver. The edit box which appears when this option is activated 
displays the size of the printed output as a percentage of the size of the actual file. This value can be 
edited if required. 
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Copies 
This entry box is used to specify the number of copies to be printed/ routed/ engraved. This box is 
edited by sweep-selecting the entry and typing in a new number. By default, the entry in this box is 
“1”. 

 

Badges 
When the Badges check box is activated multiple pages can be printed/ routed/ engraved in one sitting. 
This option is only available if the Badges features has been used to create a multi-page file. See 
Printing Multi-page files with Badges in the Layout menu section of this chapter for more information. 

Preferences 

 

Separate Colors 
Selecting this option causes EZ-Engrave to print/ rout/ engrave colored objects on the screen one color 
at a time. 

Clip Separated Colors 
This option clips the separated colors when routing. 

Print Bitmaps 
Select this option to print bitmap files imported into, or Rendered in, EZ-Engrave (i.e., *.BMP, *.PXC, 
or *.TIF files). 

Print As Shown On Screen 
This option prints/ routs/ engraves the file as it is shown on screen. Functionally, this option allows 
printing the file:  
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¾ as wire frames (no fills) if Show Fills is turned off;  

¾ without thick lines if Show Thick Lines is turned off; and  

¾ with bitmaps as a place holder, if Show Bitmap Outline is selected from the View menu. 
All the aforementioned Show… options are available through the View fly-out menu from Options 
menu (See the section on the Options menu later in this chapter for more details). 

 

Print Dimensions 
This option prints/ routs/ engraves any dimensions created in the file. Dimensions include any size 
notations or notes generated using the Dimensioning tools from the Measure tool in the tool bar. 

Note: This option will not be available if printing to a PostScript device and the Use 
Level Two EPS option is selected. 

Use Level Two EPS 
Selecting this option causes EZ-Engrave to print/ rout/ engrave to the PostScript device using Level 
Two PostScript, an optimized printer language. This option is only available if the selected printer/ 
router/ engraver is a postscript device. 

Print Guidelines 
With this option selected any Guides placed on screen will be printed/ routed/ engraved along with the 
Guide Labels. The Guides must be set as visible in order to be printed/ routed/ engraved. 

Print Grid Lines 
With this option selected the Grid placed on screen will be printed/ routed/ engraved. The Grid must be 
set as visible in order to be printed/ routed/ engraved, and will be printed/ routed/ engraved as set to 
view (i.e., View Grid as lines will be printed/ routed/ engraved as lines). 

Print Edge of Sign Blank 
With this option selected the Sign Blank edge on screen will be printed/ routed/ engraved. The Sign 
Blank must be set as visible in order to be printed/ routed/ engraved. 

Margins 
Some printer drivers do not account for the non-printable areas, or margins of the page. In those cases, 
EZ-Engrave provides for the margins settings, by accessing the Margins tab. Enter margin 
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specifications in the entry boxes in this dialog box as required. 

 

CONTROL PANEL 
This option opens the Windows’ Control Panel. 
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FIND FILE 
Use the Find File feature to quickly search the system for files by: name, creation date, modification 
date, or by keyword, without leaving EZ-Engrave. Selecting the Find File option opens the Find File 
dialog box. 

 
There are three main ways of searching the system for a file. 

Name and Location  
Select the Name and Location tab to search the system using the file name and to designate specific 
directories or folders to search. Type in the name of the file in the Name entry box, and use the Browse 
button to select the appropriate drive and/or directories. 

Date Modified  
Select the Date Modified tab to search for files based on specific modification dates. Files can be 
searched generally with the All Files radio button activated or specifically for Files modified between 
certain dates. Enter the dates in the Month/Day/Year format. 
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Advanced  
The advanced tab provides the ability to search for files based on keywords contained in the Job Notes 
section of any CDL file, and can be set to search for Any Keyword or for All Keywords. 

 

Find Now  
The Find Now button activates the search based on the provided parameters. 

Stop  
Use the Stop button to halt a search in progress. 

New Search 
If a search has been stopped and the parameters changed use the New Search button to reactivate the 
Search.  

Found Files List 
All files found during a search are listed in the Found Files list box. Files can be opened directly from 
the list box by double-clicking the selected file. 

INSTALL 
This menu selection expands to display three separate options: Modules, Drivers, and Fonts. 

 

Install… Modules… 
This option is used to activate additional modules that can be purchased separately from the main EZ-
Engrave Foundation module. If activating a new module purchased subsequent to the original purchase 
of EZ-Engrave, a new password must be entered into the existing EZ-Engrave program. Entering this 
new password activates the new module. 
Selecting the Install Modules option first produces a warning dialog box reminding to enter the new 
password exactly as it appears on the sheet provided by Ideal Stencil or one of its authorized re-sellers. 
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Click on OK  to access the Passwords dialog box. 

 

Note: If upgrading EZ-Engrave, it is a good idea at this point to make a note of the 
previous password before continuing. Also note that EZ-Engrave passwords do NOT 
contain any vowels. 

Modules Installed… 
To verify those modules actually installed, press the Modules Installed… button  to open a dialog box 
with a list of the active EZ-Engrave modules. 

 

Activating a Module 
To activate a new module: 

¾ select the Install Modules option in the File menu; 

¾ click in the Password box and enter the password received with the new module; 

¾ click OK to accept the password; 

¾ Exit EZ-Engrave, and  

¾ restart the program for the changes to take effect. 
The new modules activated will now be available when EZ-Engrave is re-entered. 

Note: Always exit from and re-start EZ-Engrave after installation of new passwords. 
Otherwise, the new modules will not be activated by the main EZ-Engrave module. 
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Install… Drivers… 
This option allows for the installation of plotter drivers into EZ-Engrave. Install a new driver into EZ-
Engrave if a new routing device has been purchased, or if an improved or updated driver for the 
existing machine has been received from Ideal Stencil or one of its authorized re-sellers. Clicking on 
the Install… Drivers option opens the Select Components dialog box (ensure that the disk containing 
the drivers installation files is inserted into the appropriate drive). 

Installing a Driver 
The Select Components box requests the language for Driver modules. Follow all on screen 
instructions. The second Select Components dialog box displays a list of those drivers available with 
EZ-Engrave. Drivers already installed are marked with a check mark. 

 

Next 
The Next button proceeds to the next step in the installation process. The Next button only becomes 
available after a driver has been selected. 

Deleting A Driver 
To Delete a driver follow the install procedure, except, instead of selecting new drivers from the 
Drivers List de-select the unwanted driver, and proceed with the rest of the install. 
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Install… Fonts… 
This option allows for the installation of additional fonts into EZ-Engrave. Selecting the Install… 
Fonts… opens the Install Fonts dialog box. 

 
From within this dialog box, specify where the fonts are to be found, and where they are to be placed 
during installation. Fonts can be Registered with actually requiring space on the hard drive. However it 
must be noted that to run EZ-Engrave efficiently any registered fonts should be readily available when 
EZ-Engrave is started. For example if fonts are registered to be found on a CD-ROM, that specific CD 
should be inserted in the CD drive prior to starting EZ-Engrave. 

Font Format 
This box contains a series of check boxes with the type of fonts to be installed. To view a list of the 
available fonts on the selected disk drive click on the appropriate check box. The Font Types available 
for use with EZ-Engrave are: True Type; Adobe Type 1; Corel WFN; Ideal Stencil VEF; as well as 
third party OEM fonts. 

Source Folder 
The Source Folder box displays the currently selected source drive for the fonts. To access another 
driver select the Browse button. 
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Browse 
The Browse button opens the Browse dialog box to change the Source Folder for font selection. Once 
the appropriate drive and directory are selected press OK. 

 

Include Subfolders 
Activating the Include Subfolders option causes EZ-Engrave to search not only in the selected folder 
but in all folders contained within the selected folder. 

Destination Folder 
The Destination Folder box displays the currently selected source drive for installing the fonts into. To 
access another driver select the Browse button. These options are only available if Relocate Fonts To 
Another Folder is activated. 

Relocate Fonts To Another Folder 
The Relocate Fonts To Another Folder button activates the ability to install fonts onto a hard drive 
from a CD or diskette. As EZ-Engrave functions equally well with fonts registered from a CD-ROM, 
installing fonts onto a hard-drive is not required, however the option is available through this feature 
for those who require re-locating fonts. 

Reset 
The Reset button will reset the Font Detective Database included in EZ-Engrave, it is not 
recommended to do this unless required, as resetting the Database removes all fonts from the Database 
except Ideal Stencil VEF fonts.  

Search Now 
The Search Now button will search the selected Source Folder for applicable fonts based on the Font 
Formats selected. The fonts will be listed in the Font list, preceded by an icon depicting the font type. 
If any changes are made to the selection options press the Search Now button to refresh the font list 
based on the new selections. 
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Selecting Fonts 
The list of fonts will be presented alphabetically in the font list box. 

 
¾ To select a font, click on it, each font selected will be highlighted. 

Register 
The Register button is used to install a selected font or group of fonts into EZ-Engrave. To install only 
selected fonts, highlight the required fonts in the Font List box, and then press the Register button. 

Register All  
Pressing the Register All button will install all available fonts from the selected disk into the EZ-
Engrave program. 

Installing New Fonts 
To install new fonts into EZ-Engrave: 

¾ click on the Install Fonts option in the File menu; 

¾ select the font type in the Font Type box; 

¾ select the Source that the fonts are to be installed from; 

¾ select the Directory where the fonts are to be installed (not required if using CD-ROM); 

¾ press Search Now button; 

¾ select the fonts to install from list available; 

¾ press either the Register or Register All button, as appropriate; and 

¾ press the Close button. 

Note: Fonts installed using the Install… Fonts… will be available for use in EZ-
Engrave, but must be set up in the Font Detective Database to be accessed from Text 
Compose. For more information refer to Chapter 3 — Text Composition. 
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EXIT  
The Exit command in the File menu is used to exit EZ-Engrave. If changes have been made to the 
current file, that have not yet been saved, a prompt to do so appears before the program closes.  

 
Upon exit, EZ-Engrave saves all changes made to parameters in the various dialog boxes, Plotter Set-
up, Printing, and so on. The next time that EZ-Engrave is started, these settings will appear by default. 

Keyboard Shortcut: [Control + X] 
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UNDO 
When selected, this command returns the image to the state prior to the last operation performed. If 
selected consecutively, it will Undo each previous operation. Because the information required by 
Undo is stored in memory, Undo as many of the previous actions as the amount of memory in the 
computer permits, with the following exceptions: 

¾ only Undo the last five operations of the Graphic Creation tools; 

¾ NOT Undo operations performed with the Zoom tool; 

¾ NOT Undo operations performed with the File menu; 

¾ NOT Undo the selection of objects. 

Keyboard Shortcut: [Alt+Bksp] 

REDO 
When selected, this operation reverses the latest Undo. Perform as many Redo operations as there are 
Undo operations to reverse. 

Keyboard Shortcut: [Control + Bksp] 

PURGE UNDO  
Selecting this option removes all Undo/Redo information from memory, releasing that memory for use 
by the program. 

CUT, COPY & PASTE 
One of the ways to exchange graphics files between different EZ-Engrave files or between EZ-Engrave 
and other Windows based programs is through the Clipboard. The Clipboard is a temporary storage 
area for items being swapped from one program to another. 

Note: Swapping files from a different program into EZ-Engrave through the clipboard 
may result in some distortion to the graphic. This is due to the variety of methods by 
which Windows programs handle clipboard files. The clipboard should therefore be 
used to manipulate objects within a single program when dealing with graphics. 

Cut & Copy Objects to the Clipboard 
The Cut and Copy commands are very similar in that they both place copies of the selected object or 
objects into the clipboard for later retrieval. The difference between the two commands is that, while 
copy only copies the objects to the clipboard, Cut also deletes the original object from the EZ-Engrave 
Edit window. 
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Using the Clipboard in EZ-Engrave: 
¾ Select the object(s) to be placed on the Clipboard using the Select tool; 

¾ Click on either the Copy or Cut option in the Edit menu. 
Using Copy places a copy of the selected object(s) in the Clipboard without affecting the original 
drawing in any way. 
Using Cut places a copy of the selected object(s) in the Clipboard but removes the selected object(s) 
from the original drawing. 
File formats that can be Cut or Copied to the Clipboard from EZ-Engrave include: 

¾ any on-screen vector image (no fill information will be transferred); 

¾ text characters; and 

¾ BMP, PCX, or .TIF bitmaps imported into the EZ-Engrave view screen. 

Keyboard Shortcut: For Cut: [Control + X], or [Shift+Del]  
                                For Copy: [Control + C], or [Ctrl+Ins] 

Pasting Objects From The Clipboard 
To Paste an object from the Clipboard into a drawing: 

¾ Click on Paste in the Edit menu. 
The Paste command places a copy of the object(s) from the Clipboard into the drawing. Items in the 
Clipboard can be Pasted an infinite number of times into EZ-Engrave or other Windows applications. 
However, the clipboard will only hold one item at a time, and that item is deleted when another item is 
Cut or Copied to the Clipboard or when Windows is closed. 
If an object was copied from another EZ-Engrave file, it will be pasted into the current drawing in the 
same size and location as it appeared in the original drawing. This can sometimes cause problems to 
the unwary for the following reason. If the object Copied (or Cut) into the Clipboard is significantly 
different in scale to the drawing into which the object is being pasted, it may be pasted onto a part of 
the current EZ-Engrave view screen that isn’t immediately visible. 
To see the Pasted object(s): 

¾ click on Zoom tool and select the Zoom to selected tool, or 

¾ Press the [F7] key. 
File Formats that can be Pasted From the Clipboard into EZ-Engrave include: 

¾ vector graphics from EZ-Engrave and some other design program; 

¾ text characters (when the Text Compose tool is activated only); and 

¾ BMP, PCX, or TIF bitmaps. 
A powerful reason for using the Clipboard for swapping drawing files from one program to another is 
reduced file maintenance. When using the Clipboard, the drawing being swapped is not stored as a file 
on a disk but is stored in a temporary memory location. When a Windows session is ended, or if 
another item is Cut or Copied to the Clipboard, the old item is erased automatically. Because the file is 
committed to memory rather than saved to disk, use of the clipboard reduces the need to manage old 
unwanted files on the hard disk as would be required if Export /Import or Save/Open were the only 
routines available to transfer files between programs. 
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CLEAR 
This command will delete any selected objects from the screen. Once deleted, the removed object can 
be returned only by implementing the Undo. 

Keyboard Shortcut: [Del] key  

DUPLICATE 
 
This command creates a duplicate of the selected object on the screen. The duplicate will be drawn 
offset from the original by the amount designated in the General Preferences section of the Options… 
EZ-Engrave Setup… menu.  
 

Keyboard Shortcut: [Control + D]  

EDIT TEXT 
This command will open the Text Compose tool to allow editing of the existing text. This applies to 
text which has been generated in the current session with the Text Compose tool, or text which is part 
of a .CDL file that has been retrieved using the Open or Import commands. To edit text: 

¾ click on any character in the text string to select the text string; 

¾ Select Edit Text from the Edit menu. 
The Text Compose tool is activated, editing text follows the same rules as composing original text. 

Keyboard Shortcut: [Control + T] (text must be selected) 
                                           Double-click on selected text. 

EDIT NOTES 
Use Edit Notes to make changes to any existing notes in the file. This feature is available only when 
one (and no more than one) note is selected. Selecting this option opens the Edit Notes dialog box. 

Note: For more information on the creation and editing of notes, see the earlier section 
of this chapter, titled The Measure Tool. 
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EDIT PATH 
Any graphic objects that are on the view screen, whether created with the Graphic Creation tools, text, 
or imported as a graphic or text from another program, can be changed with the editing tools in EZ-
Engrave. These editing tools allow for customizing of these drawings or fonts, or for quick clean up of 
artwork created from the AccuScan scanning module. In all cases, the basic principles involved in 
editing graphics include changing the location for line nodes, or changing the line segments 
themselves. 
To edit a graphic object on the screen: 

¾ choose the Edit Path option from the Edit menu. 
The Edit toolbox will appear on the screen. Use of the tools in the toolbox are described in the section 
explaining the use of the Graphics Creation tool, earlier in this chapter. 

Keyboard Shortcut: [Control + E] 

EDIT FONT 
The Edit Font feature is only available with the module that includes Font Maker for font creation and 
editing please refer to Chapter  9 — Font Create / Edit for more information. 

SELECT ALL 
This command provides the ability to select all objects in active color layers on the screen without 
having to draw sweep-select or click on individual objects. 

Keyboard Shortcut: [F3] key 
                                           [Control + A]  

SELECT NONE 
This command provides the ability to de-select all objects in active color layers on the screen without 
having to draw sweep-select or click on individual objects. 

Keyboard Shortcut: [Shift+F3]  

 INVERSE SELECT 
By choosing this option all selected objects in the active color layer become de-selected, while all un-
selected objects are selected. 

Keyboard Shortcut: [Alt+F3] 
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REDRAW 
This command refreshes the screen to erase any extraneous images that have appeared on the screen in 
the course of the editing session (i.e., ghosting). 

Keyboard Shortcut: [Alt+D] 

DIGITIZING SETUP 
Selection of this option produces the Digitizing Setup dialog box.  The Digitizing for EZ-Engrave will 
interface directly with a digitizing tablet, no other intermediary software drivers are required. EZ-
Engrave also provides some features specific to digitizing. 

Using A Digitizer With EZ-Engrave 
To use a digitizer with EZ-Engrave, a supported digitizing or graphics tablet must be connected to a 
Serial port (COM1, COM2, etc.) on the computer. Use the serial cable that came with the digitizing 
tablet to connect to the PC, according to the manufacturer’s recommendations. 
The serial port does not require setup, as EZ-Engrave configures it automatically. However, make sure 
that it is a fully functional port, with the correct address and interrupt (IRQ) set in Windows. If there 
are any doubts, refer to the documentation that came with the PC, or contact the PC manufacturer. 
Finally, the Digitizing Module is not designed to work with the stylus (or "pen") often packaged with a 
digitizer. In order to take full advantage of EZ-Engrave’s digitizing capabilities, a digitizing puck (or 
"mouse") must be attached to the tablet. 

Configuring the Digitizer 

 
After the digitizer has been properly installed, turn on the computer and run EZ-Engrave normally. The 
digitizer must now be configured and enabled. Begin by clicking on Digitizing Setup in the Edit menu. 
Within the Digitizing Tablet Setup dialog box, perform the setup and specify the preferences. 
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Digitizer Type 
The Digitizer Type pull-down menu identifies the tablets available for use on the system, select the 
required digitizer from the list by clicking on it. 

 

Note: Not all digitizers will be supported directly by EZ-Engrave, however, most will 
provide an “emulation” mode, (i.e., the digitizer might imitate a Summa Graphics 
Tablet, though produced by another manufacturer). 

Serial Port 
The Serial Port box verifies the port through which the digitizing device is connected, ensure that the 
appropriate port is selected. 

Enable Digitizer 
This check box is used to enable and disable the digitizer. In order to reduce the load on the system, it 
is recommended that the digitizer be disabled when not in use. This will prevent EZ-Engrave from 
polling the tablet, and therefore free up system resources. 

Track Pen 
This check box is used to enable and disable the tracking of the digitizing pen. In order to reduce the 
load on the system, it is recommended that the digitizer be disabled when not in use. This will prevent 
EZ-Engrave from polling the tablet, and therefore free up system resources. 

Reset Baseline 
When starting a new drawing, or if the original angle and position of the tablet’s baseline need to be 
restored, select the Reset Baseline option. The baseline of the tablet will be reset to match that of the 
sign blank. See Set Baseline below for more information regarding baselines. 
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Set Baseline 
The baseline of a drawing defines both the bottom of the artwork, and the angle of the horizontal axis. 

 
Typically, a digitizer automatically sets the baseline as the bottom of the tablet (i.e., lower left to lower 
right corner of the digitizing area). If a baseline is not set, EZ-Engrave will also set the bottom of the 
digitizing tablet as the baseline for the artwork. 
It is often difficult, if not impossible, to be get artwork to line up exactly with the bottom of the tablet. 
For example, in the diagram above the horizontal for the artwork is not the same as horizontal on the 
digitizing tablet. EZ-Engrave will set the baseline to reflect the that of the artwork, rather than the 
baseline of the tablet using the Set Baseline command. 

 
Set Baseline compensates for rotation of artwork on the digitizing tablet, eliminating the requirement 
that artwork be exactly straight on the digitizing tablet. Pressing Set Baseline closes the dialog box, 
while opening the graphic edit mode. 
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The next two clicks of the top button on the digitizing puck will define the horizontal baseline of the 
artwork. The first click will define the origin point (or left limit) of the new baseline, and the second 
will set the angle and the right limit of the baseline.  

 
After the baseline is set, EZ-Engrave will operate in drawing mode, and the artwork can be digitized 
and saved using all the design tools available with EZ-Engrave.  

Using the Digitizer 
Now that the digitizing tablet is properly configured, digitizing artwork can begin. EZ-Engrave 
responds to the four buttons on a standard four-button puck in very specific and predictable ways, this 
helps to speed the process. 

 
There are four buttons on the traditional digitizing puck, usually arranged in a diamond shape. The 
buttons may be square or round, depending on the puck, and each has very specific functions. 
Therefore, it may be easier to refer to each of them by a descriptive name. 

The Corner Button 
The top button is used to create corner nodes, and is therefore referred to as the Corner Button. Each 
time the Corner Button is pressed, a corner node is placed on screen in the drawing. 

The Curve Button 
The button on the left hand side of the puck will place a curve node on the screen. It is therefore 
referred to as the Curve Button. Note that a drawn curve requires at least three nodes to complete, 
however, only the middle node of the three must be a curve node in order to create a curved line 
segment. 
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Note: The curve nodes drawn by the digitizer are different from those drawn by the 
mouse in standard draw mode. Draw mode uses the nodes as control handles that pull at 
the curve as it is formed, while a curve drawn in digitizing mode will pass directly 
through the nodes as they are placed. 

The Tangent Button 
The bottom button on the puck is used to create tangent nodes, and hence is called the Tangent Button. 
Tangent nodes, when placed between a line segment and a curve segment, change the shape of the 
transition from line to curve. For example, a line ending with a corner node will have a definite corner 
where the curve begins, while a line ending with a tangent node will run smoothly from line to curve 
with no visible corner. 

 

The Finish Button 
The last button supported by EZ-Engrave is the button on the right of the digitizing puck. It is used to 
end and close contours, or to create custom defined shapes, and is called the Finish Button. 
To finish a contour, click the Finish Button, and the next node drawn will begin a new contour. If the 
contour being drawn is to be closed, double-clicking the Finish Button will draw a line connecting the 
last node with the first, closing the object. 
The Finish Button can be used with the Corner Button to define “fitted” rectangles. If a corner node is 
drawn at any two opposite corners of a rectangle on the digitizing tablet and the Finish Button is 
double clicked, EZ-Engrave will calculate the actual shape and size of the required rectangle and draw 
it on-screen. 
The Finish Button will also work in combination with the Curve Button to define circles. Click two 
curve nodes representing the diameter of a circle, then double click the Finish Button, EZ-Engrave will 
draw a circle defined by the set diameter. If three points around a circular object on the tablet are set 
and the Finish Button is double-clicked, EZ-Engrave will fit a circle to the three points. If four or more 
points are set, EZ-Engrave will draw a circle that best fits the points drawn. 
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LAYOUT MENU 

BLANK SIZE 
This option defines and places a representation of a Sign Blank onto the screen, ensuring that 
Engravings are created to exact size specifications. This is also useful in visualizing the spatial 
arrangement of all elements that make up a Engraving.  

 

Orientation 
The Orientation for the Sign Blank can be set to either Portrait or Landscape depending on the current 
project requirements. 

Current Selection 
EZ-Engrave software comes with a variety of preset Sign Blank sizes for those standard Engraving 
sizes most often used. To use a preset Sign Blank size simply select from the list provided. 

 

Width & Height 
Blank size will set the measurements based on the unit of measurement specified in the General 
Preferences dialog box available from the Options… EZ-Engrave Setup… menus. 



Layout Menu 

Advanced 
When the Advanced button is pressed the articulated dialog box opens. Providing the ability to add to 
or remove from the custom Sign Blank sizes.  

 

New 
Pressing the New button opens the Add New Blank Size dialog box. Enter the name for the new size is 
the Name box, enter the Width and Height respectively, and adjust the unit of measurement if required 
(be aware, the height and width values do not change when the unit of measurement is changed). Press 
OK to accept the new Blank Size. The New Blank Size will appear in the Current Selection lists, 
however it will only appear in the Advanced list of sizes available the next time Blank Size is 
accessed. 

 

Add 
Any custom sizes that have been removed from the standard list can be added by selecting from the 
Add list and pressing the Add button. 

Remove 
To limit the number of Blank Sizes listed in the standard Blank Size dialog box, access the Advanced 
tools in the articulated box, select any preset Blank Sizes that are not frequently used from the list and 
press the Remove button. This process simply moves the files to the list over the Add button. To be 
able to use the preset again it must be selected and Added to the available list. 
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Display at start up 
To access the Blank Size dialog box every time a new editing session is started, place a check mark 
beside the Display at start up option. Until the check mark is removed, the Blank Size dialog box will 
open whenever the New option from the File menu is selected, or whenever EZ-Engrave is started.  

Set the Blank Size 
To set the blank size: 

¾ click on the Blank Size option from the Layout menu, the Blank Size dialog box opens; 

¾ change the Width and Height values to establish dimensions for the Sign Blank, or simply 
select from the available preset Blank Sizes; 

¾ click OK to accept these values. 
A gray rectangle outline appears on the screen representing the Sign Blank. 

 

Note: The Sign Blank will appear on screen when the Show Sign Blank option in the 
View menu is selected. When the Sign Blank size is changed, this option is 
automatically selected. 

START SEQUENCE 
This option allows for specification of the order for drawing, cutting, plotting, routing, engraving, or 
printing objects. The objects will then be drawn, routed, etc… starting from the first object chosen, in 
order, to the last object chosen. 
If a series of objects, but not all objects, are re-ordered, the re-ordered objects will be placed (and 
therefore drawn, routed, etc…) starting from the original layer of first object selected. 
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Using Start Sequence 
To re-order a number of objects: 

¾ select the object to be drawn/routed first; 

 
¾ select Start Sequence from within the Layout menu; 

¾ select objects in the order in which they are to appear (i.e., select from first drawn to last) 

 
¾ click anywhere on screen away from the objects; 
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The objects will now be redrawn in their new order. 

 

Re-Alignment Using Start Sequence 
The Start Sequence feature can also be used to re-align the selected objects. To align the centers of 
each of the objects along a line: 

¾ Select the objects to be aligned either while in the Start Sequence mode, or just prior to 
selecting Start Sequence.  

The starting point of the line along which the objects will be placed will appear at the center of the 
first-selected object. 

¾ Right mouse click on the point where the last object in the line is to be placed. 
The objects will now appear along the specified line, center-aligned to the line and evenly-spaced. 
For diagonal alignment, click the right mouse button, and, while continuing to hold the button down, 
move the line around the view screen. Wire-frame boxes will appear on screen representing the 
selected objects and their relative positions as long as the right mouse button is held. 

      
Upon release of the mouse button, the objects will be placed along the specified line, center-aligned to 
the line and evenly spaced. 
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By pressing and holding the [Shift] key while defining the alignment line, the objects will be aligned 
by their lower left-hand corner rather than by their centers. 
By pressing and holding the [Control] key while defining the alignment line, the line can be 
constrained to exactly vertical or horizontal. 

DECORATIVE BORDERS 
EZ-Engrave provides the ability to apply a pre-defined frame or Decorative Border to selected 
elements of artwork. The Decorative Borders are also available from the Shapes tool in the tool bar. 
Left mouse clicking on the tool applies the currently set border, right mouse clicking opens the 
Decorative Border dialog box. These are explained in detail in the Shapes section, for more 
information refer to the Shapes section earlier in this chapter. 

ARRAYS 
The Array option allows you to create a pattern using the selected object or objects. Selecting this 
option produces the Array Options dialog box: 
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Array Types 
This section of the Array Options dialog box is used to specify the pattern being generated using the 
Array function. Each array type is displayed graphically as it will appear on screen. The original 
appears in red in the default position it will occupy. 

. The Vertical Array type places copies of the original object into a single column above the 
original object. Negative Vertical Spacing will cause the array to be created below the 
original object. 

. The Diagonal Array type arranges copies of the original object above and to the right of the 
original. Negative Vertical Spacing causes the array to be created below the original object, 
while negative. Horizontal Spacing will cause the array to be created to the left of the 
original object. 

. The Horizontal Array type arranges copies of the original object in a row to the right of the 
original. A negative Horizontal Spacing will cause the array to be generated to the left of the 
original object. 

. The Rectangular Array type arranges copies of the original object in rows above and to the 
right of the original object. Negative Vertical Spacing causes the array to be created below 
the original object, while negative Horizontal Spacing will cause the array to be created to 
the left of the original object. 

. The Circular Array type arranges copies of the original object in a circle in which the 
original object is placed, by default, at the top center position in the array. The size of the arc 
(or section of the circle) actually occupied by the array, may be set by specifying a Start and 
End Degree. Objects are generated in a clockwise manner. 

. The Rotated Circular Array type arranges copies of the original object in a circle in which 
the original object is placed, by default, at the top center position in the array. Each object is 
rotated such that its base is on a tangent to the circle at the position at which the object 
appears. The size of the arc (or section of the circle) actually occupied by the array, may be 
set by specifying a Start and End Degree. Objects are generated in a clockwise manner. 

Spacing Method 
The Spacing Method option defines the spacing of objects using Horizontal and Vertical Spacing. 

The first option calculates spacing as the distance between the lower left corner of each object. 

The second option calculates the actual distance between objects as follows: 

¾ Horizontal Spacing is defined as the distance between the trailing edge of the first object and 
the leading edge of the second.  

¾ Vertical Spacing is defined as the distance from the top of the lower object to the bottom of 
the object above. 

Rotate Each 
This setting forces each object in the array to be rotated a by a set amount. This option is not available 
when applying an array that already calculates rotation as a part of its function (i.e., the Circular 
Rotated array). 
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Final Rotation 
This setting specifies the rotation of the final copy of the selected object, and then applies intermediary 
rotations accordingly to all objects in the array between the first object and the last. For example, if a 
Final Rotation of 90° is set for 3 copies, the first copy will be rotated - 30° the second - 60°, and the 
final copy - 90°, as specified in the Final Rotation setting(i.e., 90°/3).  

Horizontal Spacing 
This entry box specifies the horizontal distance between each of the copies of the object in the array. 
The method by which the objects are spaced is governed by the selected Spacing Method as discussed 
above. This setting is only available when the selected Array Type incorporates a horizontal 
component, and is otherwise grayed-out. 

Vertical Spacing 
This entry box specifies the vertical distance between each of the copies of the object in the array. The 
method by which the objects are spaced is governed by the selected Spacing Method as discussed 
above. This setting is only available when the selected Array Type incorporates a vertical component, 
and is otherwise grayed-out. 

Start Degree 
This setting is available only when the Array Type chosen is circular. It is used to specify the position 
of the first object in the array in degrees from vertical. For example, an object that is at the 12:00 
position of a circle would be defined as being at 0°, while an object at 3:00 would be defined as being 
at 90°, an object at 6:00 is at 180°, and so on.  

  

End Degree 
This setting is available only when the Array Type chosen is circular in shape. It is used to specify the 
position of the last object in the array in degrees from vertical. See circle graph above. 

Radius 
This entry box defines the radius of the circle (i.e., measurement from the center of the circle to the 
edge) around which objects in circular arrays will be placed. This setting is defined in the current unit 
of measurement, and is available only when a circular array is selected. 

Horizontal Copies 
This edit box specifies the number of objects to be placed in each row of the selected array. This 
option is available only for those arrays which include a horizontal component.  
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Vertical Copies 
This box specifies the number of rows to be generated by the selected array. This option is available 
only when an Array Type which incorporates a vertical component is selected. 

Total Copies 
This box specifies the total number of objects to be contained in the array, and is always equal to the 
Horizontal Copies multiplied by the Vertical Copies. 

 

Note: The numbers that appear in the Horizontal, Vertical, and Total Copies boxes must 
be whole numbers. Any decimal numbers will be truncated to a whole number. 

Save Settings On Exit 
This check box saves the changes made to the Array Options dialog box when the box is exited by 
pressing the OK button. If the dialog box is exited by pressing the Cancel button, all changes made 
will be lost. 

MOVE 
The Move option accurately moves selected object(s) to “absolute” coordinates relative to the (0,0) 
origin point on the screen. Objects can also be moved “relative” to their present position. Clicking on 
the Move option in the Layout menu produces the Move dialog box: 

 
The Scroll box is used to specify the type of move to perform. Clicking on the scroll arrow reveals the 
two choices available, Relative and Absolute. 

 

Relative 
Selecting Rel will result in the object moving to a position relative to its current position (i.e., objects 
move X inches to the left).  

Absolute 
Absolute movements will cause the object to move to a specified position on the sign blank (i.e., 
objects move to a specific position on the sign blank). 

X Coordinates 
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Y Coordinates 
If a relative move is specified, a positive value for the Y box moves the object upward, and a negative 
value moves it downward. If objects are moved to an “absolute” position relative to the Sign Blank, 
enter the Y coordinate in the Y entry box. 

Keep Original 
Creates a duplicate object at the set coordinates, and leaves the original object unaffected. 

Note: A shortcut method to access the Move option — click on one of the nubs around 
the selected objects, right click and select Move from the pop-out Layout menu. The 
selected nub is moved to the designated coordinates rather than the lower left nub. 

SIZE 
The Size option re-sizes the selected object to any dimensions without affecting the size of other 
objects on the screen. Select Size from the Layout menu to access the Size dialog box: 

 
From within this dialog, the size of the selected objects can be changed by editing the X and Y values 
which represent the size of the object. Clicking on Apply will force the selected object(s) to the 
specified dimensions and leave the Size dialog box open, while clicking on the Close button will close 
the Size dialog box. If the Close button is selected without having selected the Apply, no sizing is 
applied. 
There are two choices available for sizing selected objects, Absolute and Percentile. Changing the 
value of the X coordinate in the Absolute settings is reflected in the Percentage X coordinate settings. 

Percentage 
Selecting % will result in the object being sized relative to its current size (i.e., 200% sizes the object 
to twice the original size).  

Absolute 
Absolute sizing causes the object to be sized to a specific measurement (i.e., objects is sized from 2 
inches square to 1 inch by 3.02 inches). 

Proportional 
Select this option to re-size the selected object(s) while maintaining current proportions. If 
Proportional is selected, edit one of the X or Y dimensions. The Proportional option will cause the 
object or objects to maintain their aspect. 

20-10 • EZ-Engrave User Guide 



Layout Menu 

ROTATE 
The Rotate option rotates selected object(s) around a designated point. Clicking on the Rotate option in 
the drop-down menu produces the following dialog box: 

            
The small “+” superimposed on the center nub of the selected object is the point around which the 
graphic will be rotated.  

 
This “+” can be moved to any position, and the object rotated as follows: 

¾ Drag the “+” rotational point with the mouse to the location which you wish to become the 
center of rotation. 

 
¾ Rotate the object around this “+” point by selecting any of the outside nubs and dragging the 

bounding box with the mouse. The degree of the rotation will be shown in the Rotate dialog 
box (positive values represent clockwise rotations and negative values represent 
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counterclockwise rotations). 

 
¾ Click on Apply to accept or the X  to cancel the rotation and return to the EZ-Engrave 

screen. If accepted, the object will rotate to the new location of the bounding box. 

 
Rather than manually rotating the graphic, enter values directly into the dialog box. This gives more 
precise control over the rotation of the objects. 

Note: If a nub is clicked with the right mouse button to access the layout menu, the “+” 
rotational point would appear on the selected nub. 
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SLANT 
The Slant option skews or slants selected object(s) horizontally (left or right), or vertically (up or 
down), from a fixed baseline. 

 
Clicking on the Slant Horizontal option or Slant Vertical option from the fly-out menu produces the 
Slant dialog box: 

 
¾ If the Slant Vertical option had been chosen, select one of the corner nubs and drag it with 

the mouse up or down to skew the bounding box. 

 
¾ If Slant Horizontal is selected, the corner nubs can be dragged to the left or right rather than 

up or down.  

 
EZ-Engrave User Guide • 20-13 



Layout Menu 

In either case, the amount of slant will be displayed in the dialog box. Positive values represent a slant 
to the right or slant up, while negative values represent a slant to the left or slant down). Selecting 
Apply, applies the slant, leaving the Slant dialog box open. Selecting the X  closes the Slant dialog 
box without applying the change, unless Apply is selected first. 

CLEAR TRANSFORMATIONS 
The Clear Transformations removes all Move, Rotate, Size, and Slant transformations applied to 
polyarcs or text objects without Undoing any edits made to the object. For example a line of text can 
be rotated and then edited to include an extra letter, Clear Transformations will remove the rotation 
from the text while the extra letter remains a part. 

ALIGNMENT 
The Alignment option precisely aligns selected objects, as well the default Alignment settings for use 
by the Align command can be set (see Align, next). Clicking on Alignment in the Layout menu 
produces the following dialog box: 

 

Align To 
This section of the Alignment dialog box is used to specify the reference point to which the selected 
objects will be aligned. 
SignBlank......................Click on the Sign Blank radio button to align objects relative to Sign Blank. 
Grid  Selecting Grid will align the selected objects with the grid as defined in the Preferences 

dialog box. (This box is accessible through the Options menu, and will be discussed later in 
the section entitled The Options Menu). 

Last Object ....................The Last Object option is used to align a group of objects to one of the objects 
in the group. When aligning a group of objects to a single object, make certain that the object 
used to align the others is selected last. 

Selected This option aligns a group of objects to the bounding box that surrounds the objects. 
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Horizontal Section 
This section is used to specify the horizontal alignment parameters by which the selected objects will 
move laterally  to align to the specified reference point (i.e., side to side). Choose from align to the 
Left, Right, or Center of the selected horizontal reference point, or choose not to align objects 
horizontally at all by selecting the None option. 
Space Equally will take all the selected objects and space them equally within the Align To settings, 
set a percentage offset from the Align To Sign Blank with the Margin settings. 

Vertical Section 
The Vertical Section of the Alignment dialog box allows for specification of how the objects are to be 
aligned to the reference point vertically. Objects will move up or down to align to the Top, Bottom, or 
Center of the specified reference point. Or choose not to align vertically by selecting the None option. 
Space Equally will take all the selected objects and space them equally within the Align To settings, 
set a percentage offset from the Align To Sign Blank with the Margin settings. 

Text Option for Vertical Equal Spacing 
There are two options for how the Align feature will treat text when spacing equaling along the 
vertical. The text can either be treated as a separate object for every paragraph, or as a separate object 
for every line. Both of the options can be set to ignore the descender of the text and align to the 
baseline. 

 

Keyboard Shortcut: [Alt+K] 

ALIGN 
The Align option provides quick access to the parameters set in the Alignment menu. Selecting the 
Align command causes the selected objects to be aligned based on the current settings in the 
Alignment menu. 

Keyboard Shortcut: [Control+K] 
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ALIGN TO BASELINE 
With the object to Align selected choosing the Align to Baseline opens the Align to Baseline dialog 
box. The first requirement once the Align to Baseline dialog box is open is to set the baseline.  

  

Set the Baseline 
To set the baseline click in the location to place the first point of the baseline, a target node will appear 
where the cursor selected, immediately following the first point selection click in the location for the 
second point. The angle of the resulting straight line determines the Baseline. 
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Align Objects to the Set Baseline 

Align Horizontally  
To align horizontally to the baseline, select the Align Horizontal  icon on the Align to Baseline 
dialog box. 

 

Align Vertically  
To align vertically to the baseline select the Align Vertical  icon on the Align to Baseline dialog 
box. 

Align to Angle 
To Align to a specific Angle, enter the Angle value in the Angle entry box and press Apply. 

MERGE PARAGRAPHS 
With the two text blocks selected choosing this menu option causes the text to merge into one 
paragraph. 
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GROUP 
The Group command combines two or more selected objects into a single group object, so that they 
will be treated as a single object when selected. 
To form a group: 

¾ select the objects to include in the group; then 

¾ choose the Group option from the Layout menu. 
The objects are now the components of a group which will be treated by EZ-Engrave as a single 
object. 

 
When a group is selected the status bar will read Group # X. 

 
Groups can also be Grouped, two or more groups can be combined together into a larger group where 
required. An example of this is text created with the Text Compose Tool. The Text Compose tool 
generates text in groups, as follows: 

¾ each line of text is actually a group of letters; and 

¾ each paragraph of text is actually a group of lines of text 
In effect, a paragraph of text is a group of groups. 
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UNGROUP 
The Ungroup option applied to a selected group will reverse a previous Group command and return all 
the constituent items in a group to individual item status. 

 
In order to select a single character of text from a paragraph of text composed with Text Compose, it is 
necessary to first Ungroup the paragraph into its individual lines and then Ungroup the individual line 
into its constituent characters. 

 

MIRROR 
The Mirror option creates a mirror image of the selected object. Selecting Mirror from the Layout 
menu produces a fly-out menu with two options: Vertical, and Horizontal. A Mirror, Vertical 
command will create the reflection of the selected object as if a mirror was held horizontally beneath. 

  
A Mirror, Horizontal command produces an image that is the result of holding a mirror to one side of 
the object. In both cases, the new object replaces the original object. 
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AUTOLAYOUT 
The AutoLayout feature is explained in full detail in the Text Compose chapter of this manual under 
the heading Text AutoLayout (pp.3-37). The AutoLayout and Text AutoLayout features work in the 
same manner, except that AutoLayout is for use specifically with graphics, where the Text AutoLayout 
combines the Layout capabilities for both Text and Graphics. 

BADGES 
This option provides the ability to create copies of a design while replacing the text in each copy. Each 
copy can include elements common to all copies, as well as elements unique to each copy.  
For Example, a series of nameplates for doors in a office building, where the plates include the 
company logo, employee name, employee position, and room number, can be produced automatically 
by creating a single example, and then using the Badges function.  
Within Badges, specify that the employee names, positions, and rooms numbers are unique. Badges 
then generates the specified number of plates as per instructions. 
Selecting Badges opens the Badge Setup dialog box: 

 

Number Of Copies 
Specify the number of copies Badges is to generate in this box. If a data file is specified, and fewer 
copies are specified than lines of data in the file, Badges will use only the data that will fit the number 
of copies required (i.e., ten copies selected, but twenty employees listed in data file, the first ten 
employee names will be inserted). 
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Score Lines 
Selecting this option causes EZ-Engrave to insert a grid that separates each copy to be created (i.e., 
each copy of the template will be enclosed in a box separate from the others). This can be particularly 
useful if copies are to be routed and separated later in the production process. 

Blank Size 
Specify the layout of the material in order for Badges to generate the copies required. Edit the boxes so 
they reflect the size of the piece of output material. 

 

Routing Or Engraving... 
It is recommended that the Height and Width be set to the exact dimensions of the material. 

Rendering An Engraving 
Set Height and Width to match the page size set for the plotter. 

Margins 
Specify Top, Bottom, Left , and/or Right margins for the page. These margins are applied to the rout-
able area of material, not necessarily the actual size. 

Spacing 
Set the Vertical and Horizontal spacing, this causes EZ-Engrave to leave space between each copy, as 
specified. 

 

Page Preview 
This section graphically displays the layout of the page as specified with Size, Spacing, and Margins. 
This box displays the last page generated by Badges, which may not be completely filled.  

 
Where the last page is not completely filled by the copies requested, those objects to be placed on the 
last page will be drawn as white rectangles, while the general layout of all previous pages will appear 
as black outlines. 
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Horizontal/Vertical Placement 
The Horizontal/Vertical Placement radio buttons are used to determine the output order of the copies 
generated by Badges. Horizontal placement causes copies to be placed across the material before 
dropping to the next plate of copies below. If Vertical Placement is selected, EZ-Engrave arranges the 
copies from top to bottom on the screen — as many as will fit on the material before moving to the 
right and beginning another plate of copies. 

Horizontal   Vertical   
 1 2 3 4  1 5 9 13 
 5 6 7 8  2 6 10 14 
 9 10 11 12  3 7 11 15 
13 14 15 16  4 8 12 16 

Total Number of Pages 
This dialog tells the number of pages required to complete the specified number of pages using the 
current layout settings. 

Replaceable Items 
This list box displays all of the text present in the template, this text can be replaced automatically in 
the copies. A standard Windows selection box, select the replaceable text by clicking individual items, 
[Shift-click] to select continuous lists of items, or [Ctrl-click] to select a number of individual items. 
Items are de-selected in the same fashion. 

 

Note: If no items are selected for replacement, the Badges feature will create the 
required copies with no text replacement (i.e., it will simply create exact duplicates of 
the selection of objects). 

Replacement Data File 
This entry box is used to specify the name of the file containing the information to be placed in the 
copies of the template. EZ-Engrave’s Badges function accepts a ‘tab-delimited’ text file. This means 
that any data file, created with any text editor, can be used. Placement of a tab between data points is 
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required. For example, for any given line of data (which represents the information for a single copy of 
the template) the text file might look like this: 
Text Field 1 (TAB) Text Field 2 (TAB) Text Field 3 
Badges substitutes the values in the file into the template. 

Note: If a data file is specified, and fewer copies are required than lines of data in the 
file, Badges will use only the data that will fit into the number of copies required. 
Conversely, if a data file for use with the Smart Cut function, and fewer replaceable 
items are required than entries in the data file, the entries in the data file will be 
truncated to fit the number of replaceable items. 

Browse 
Click on the Browse button to open the Browse dialog box: 

 
From within the standard Windows dialog box, navigate to the data file containing the information for 
the template copies. 

File Name 
Type in the name of the file required, include the exact path in the Look In entry box, or select the path 
from the following options. If a file is selected in the Files list box (noted below) the name will appear 
in the File Name box. If the currently selected drive and directory path are correct the files contained 
in the file list should include the required file. 

Files of Type 
List Files of Type offers only the option to view All Files. 

 
Once a data file has been selected it will appear in the Data Replacement box. 
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Pressing the OK button in the Badges dialog box opens the Text Substitution dialog box: 

 
If a text file is being used to fill the substitution grid, the data will appear. If no text file is specified, 
enter the data as required by clicking on the appropriate cell and entering the required data. 
There is a column for each of the data names selected in the Replaceable Items list box. Each of these 
columns can contain independent entries, or entries may be serialized (i.e., they may contain alpha-
numeric data). 

Serialization 
To serialize the data, select the column to which serial data is to be applied, and press the Serialization 
button. The Serialize dialog box opens: 

 
Within the Serialize dialog box, set the format for the selected field, and specify the serialization 
parameters, as follows: 

¾ Enter the text and alpha-numeric information for the field in the Start box; 

¾ Sweep-select the portion which is to be serialized. By allowing selection of the portion 
which is to be serialized, Badges allows for a mix of serialized text with non-serialized text. 
For example, choose to duplicate the phrase, “Room 101,” in each cell of the grid, but only 
serialize the numbers (i.e., "101"); 

¾ Click on the appropriate serial Type, either number or character; 
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Note: While a numeric base will be incremented through the range of possible numbers 
through to infinity, alphabetic characters will be increased cyclically through the entire 
ASCII character set (i.e., when the increments reach the end of the ASCII character set, 
it will restart at the beginning of the set). 

¾ Click on the Set Base button to establish the selected characters as the base from which 
serialization will be started; 

¾ Enter the incremental value in the Increment box; 

¾ Click on OK to generate and insert the text into the Text Substitution grid; 

 
¾ Complete the Text Substitution grid as required. 

OK 
Press OK to apply the Text Substitution to the copies specified in the Badges dialog box. 
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Multi-page files 
At the bottom corner of the EZ-Engrave view screen there is now a section that describes the current 
page selected, as well as access to the other pages in the file through the use of the arrow buttons. Use 
the back arrows to view a previous page, and the forward arrows to view the next page. The pages are 
listed as #1 / #2, where #1 is the current page selected and #2 is the total number of pages. Only files 
with multi-page badges can contain multiple pages. 

 

Printing Multi-page files 
These multiple page files can also be printed/plotted/routed as multiple pages. When there are multiple 
pages in a file, the Badges option in the Print dialog box is made available. Activating the Badges 
check box converts the Print Mode are to a Print Pages area where the pages can All be printed/ routed/ 
engraved or simply the Current Page or selected pages can be printed/ routed/ engraved. 

 

Badges, Serialization, and Text Formatting 
Any formatting information applied to text in the template object (the original) will be applied to the 
text replacement in the copies. This includes format keys such as Justification, Line Compression, 
Compression-Expansion, object colors, Line Style, Fit Text To Arc, Letter Slant, Line Spacing, etc…  
This gives complete control over the final output of the Badges function, even though no text will be 
entered for the copies. Take advantage of the various formatting capabilities incorporated into EZ-
Engrave to control the output of Badges.  
For example, Justification can ensure that text is always centered on an object or layout regardless of 
the length of the text. Specifying a maximum line length using Compression prevents unexpectedly 
long text strings from obscuring other text, or graphic elements, by limiting the text string length. 
Using these features prevents unwanted surprises, and increases productivity. 

Note:  If the Badges (copies) are ungrouped any formatting changes made to the 
template (original) object will not be applied to the Badges. 

TEMPLATES 
The Template fly-out menu is available when Templates is selected from the menu. 
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Set Template 
A Template is a special kind of file that provides the basic tools for shaping a final file. Templates can 
contain the following elements available from the Set Template fly-out menu: a File element; a Date 
code; a Time code; and Text elements. 

 
Create a Template as a normal CDL file would be created, and select specific items to represent the 
separate Template elements.  

File 
Type in a word and set it to the appropriate size for any artwork proofs. Select the word and choose the 
File option from the Set Template fly-out menu. Multiple objects in a  Template can be set as File 
objects. The following dialog box opens: 

 

File / Prompt at Run Time 
The Template can be set to select the same file every time in the case of a company logo, or it can be 
set to prompt for a file at run time. Use the Browse feature to select a permanent file, or activate the 
check box for prompt at run time to provide the option of inserting a file when the Template is used. 

Stretch 
The file can be set To Fit the designated File object area, to fit as a Proportional object within the File 
object area, or to import at the actual file size (None). 

Orientation 
Select the orientation and location within the File object area for the file in use. 

Date 
Type in a word and set it to the appropriate size for any artwork proofs. Select the word and choose the 
Date option from the Set Template fly-out menu.  EZ-Engrave applies a date code to the selected word 
and will insert the current date set on the system clock, whenever the Template is used. Multiple 
objects in a Template can be set as Date objects. 
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Time 
Type in a word and set it to the appropriate size for any artwork proofs. Select the word and choose the 
Time option from the Set Template fly-out menu.  EZ-Engrave applies a time code to the selected 
word and will insert the current time set on the system clock, whenever the Template is used. Multiple 
objects in a Template can be set as Time objects. 

Text 
Type in a word or sentence and set it to the appropriate size for any artwork proofs. Select the word 
and choose the Text option from the Set Template fly-out menu. Whenever the Template is used, there 
occurs a prompt for the Text to be entered in this location in the Template. Multiple objects in a 
Template can be set as Text objects. 

Other Objects 
Objects that are not defined using the Set Template options as any of the available settings, are inserted 
into any file created using the Template as is. Therefore if the name of the company is to appear on all 
files in the same location, simply enter the name in the Template as it should appear, and do not define 
it as any option within the Set Template menu. 

Saving a Template 
To save a file as a Template, simply save the file with the Template settings as above. When the file is 
opened EZ-Engrave will recognize the Template tags in the file and behave accordingly. 

Opening a Template 
When a file is opened that includes Template tags, a series of Open dialog boxes appear after the 
specified Template is selected. A dialog box will open for each Template object that must be inserted. 

File Objects 
The File Objects will open with the dialog box titled the same as the text that was denoted as a File 
object. Select a File to insert in the appropriate location. These dialog boxes function the same as the 
Open dialog box explained earlier in this chapter.  
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Date and Time Codes 
The Date and Time codes are inserted automatically using the system clock. The Date and Time is 
inserted using the same font, size, and text specifications as used for the Template object in the 
Template file. 

Text Objects 
The Text Objects will cause an entry dialog box to open for every item denoted as a Text object. Enter 
the appropriate text, this text will be automatically inserted into the original Text object location in the 
Template. The Text is inserted using the same font, size, and text specifications as used for the 
Template object in the Template file. 

 

Clear Template 
Clear Template is available only when Edit Template from the File menu has first been selected. Also, 
an item that has been designated a Template Object must be selected to use this feature. Selecting 
Clear Template clears the selected object’s template setting, and does not clear the entire Template. 
Each item must be selected to be cleared, items can be Shift or Control selected and the Clear 
Template option will work, however if any item that is not a Template Object is selected, Clear 
Template is not available. 

CLIP ART GO TO 
The Clip Art Go To provides access to all available Clip art directories set up using the Clip Art 
Categories Setup. EZ-Engrave is installed with a default directory for Sign Blanks already provided. 

 
Selecting from the fly-out menu opens the Clip Art Viewer with the selected directory open. 

EZ-Engrave User Guide • 20-29 



Layout Menu 

CLIP ART VIEWER 
The Clip Art Viewer provides quick and easy access to any Clip Art directories and displays all 
available Clip Art within the directories of BMP and CDL formats. 

 
Any directory can be viewed using the Clip Art viewer, however only BMP and CDL files will appear 
in the view screen. 

Path 
The directory path is listed in this drop-down menu listing. Selecting the down arrow opens the drop-
down list to provides access to all available directories registered as Clip Art Categories. Use the Up 
One Level  button to back up in the directory structure. The View  button toggles the view of 
the Clip Art icons between small and large formats. 

Clip Art Display Window 
All available BMP and CDL Clip Art is shown in the display window. To use a piece of Clip Art either 
select and press OK, double-click, or click and drag the Clip Art onto the EZ-Engrave editing window. 
The file will be merged into the currently open file. 
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CLIP ART CATEGORIES SETUP 
The Clip Art Categories Setup provides the ability to setup a file management system for Clip Art. 
Selecting this option opens the Clip Art Categories dialog box. 

  

Category  
The Category lists all available categories in a drop-down list. 

Path  
The Path box displays the directory path to access the currently selected category. 

Add  
To Add a new Category press the Add button and the New Clip Art Category dialog box opens. Insert 
an appropriate name and key in the path to the required directory or use the Browse button to access 
the Browse dialog box to browse the system. 

 
Any new Categories added will now be listed in the Category list in the Setup dialog box as well as 
from the Clip Art Go To fly-out menu. 

   

Note: If a Category is setup to use the same name as a file within the category the folder 
will use the same thumbnail as the Clip Art. 
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Delete 
To Delete a Category select it from the Category list and press the delete button. The selected Category 
will no longer be available. 



 

EZ-Engrave User Guide • 20-33 





Arrange Menu 

EZ-Engrave User Guide • 21-1 

ARRANGE MENU 
ARRANGE 

 
The Arrange menu contains options which place the objects into a specific layering order relative to 
each other. Changes in the layering of objects has an effect on what is seen on screen as follows:  

¾ Objects which are ‘on top’ or ‘above’ other objects will appear to cover those objects, such 
that the lower objects will appear to be physically ‘underneath’ the objects above them. This 
graphic illustrates the principle using the simple case of two objects which overlap: 

 
 Square set to Back, Square set to Front, 
 Circle set to Front. Circle set to Back. 

TO FRONT 
To Front is used to move the selected object(s) from the current position in a stack of objects to the top 
layer of the stack. 

Shortcut Key: [Control + F] 

TO BACK 
To Back is used to move the selected object(s) from the current position in a stack of objects to the 
back layer of the stack.  

Shortcut Key: [Control + B] 

FORWARD 
Forward is used to move the selected object(s) from the current position in a stack of objects to the 
next higher layer in the stack. This will have the effect of moving the object(s) from underneath the 
object layered directly above it to a position in front of that object.  

Shortcut Key: [Control + U] 



Arrange Menu 

BACKWARD 
Backward is used to move the selected object(s) from the current position in a stack of objects to the 
next lower layer in the stack.  

Shortcut Key: [Control + L] 

REVERSE 
Reverse is used to invert the order of selected objects within a layered stack of objects(i.e., objects are 
layered 1,2,3,4 — Reverse causes the objects to be layered 4,3,2,1).  

Shortcut Key: [Control + R] 

MAKE PATH 
Make Path is used to combine a number of independent, selected objects into a single path. The 
multiple objects become a single object when made into a Path. A Path made up of several objects is 
similar to a Group of objects. However, a Path differs from a Group in two ways:  

¾ Path objects are always the same color, and are forced to the Target color when the Make 
Path command is used; and  

¾ Path objects have a generation relationship. 
Having a generation relationship means that any object which is placed inside or overlapping any other 
object with which it shares a Path, becomes a hole in that object, rather than an independent object that 
overlaps another. 

 
 Square and circle Group Square and circle Path 

Note: The Group objects are solid with different colors, while the Path object, rather 
than being a solid circle on top of a solid square, becomes a single object of one color 
with a hole where the original objects overlapped. 

Keyboard Shortcut: [Control + Z] 
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BREAK PATH 
Break Path will change a selected path into individual and independent graphic objects. The objects 
will be forced to the Target Color.  

 

Keyboard Shortcut: [Alt+Z] 

CONNECT PATH 
When graphics are imported into EZ-Engrave from a third-party software in DXF format, it is common 
for the graphics not to be closed. They appear as a series of lines and curves that are not joined. The 
Connect Path option joins the lines and curves together to form single objects (as they were exported). 
Select the object(s), and use the Connect path option. 

 
Imported object — Multiple Paths Connect Path — Single Path  
form object  forms object 

REDUCE NODES 
When graphics are traced using the scanning tools in EZ-Engrave or imported in vector format the 
polyarcs can sometimes contain more nodes than necessary. Selecting the Reduce Nodes option when 
using the Polyarc tool is activated opens the Convert to Curves dialog box, where the allowable Error 
for the function can be set (see pp.5 for more information). The default setting for allowable error 
generally provides good results.  
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 Before Reduce Nodes applied   After Reduce Nodes applied 

TEXT TO GRAPHICS 
The Text To Graphics option changes a selected text string into a graphic element. Text must be 
converted to graphics before welding, editing nodes, or editing line segments of the text. 

 
Top line is text, bottom line is text converted to graphics. The nodes can be edited in graphics. 

LOCK 
EZ-Engrave supports the use of Locked objects. Specifically, an object set as Locked cannot be re-
sized, but can be routed with all colors in a file regardless of its color on screen. Only graphics can be 
set as Locked objects. 

¾ To set a Locked object, select the object to be used, and click on the Lock command in the 
Arrange menu. 
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Routing A Locked Object 
To rout a Locked object as part of a file, use Cut By Color, an option within the Plot dialog box 
available from the Cut menu.  

 
From within the Cut By Color dialog box, click on the Cut Registration Marks check box. 

 

Note: For more detailed information on the Cut by Color section in chapter 10 — 
Advanced Output. 

UNLOCK 
The Unlock command removes the Lock from the current object, and returns all Locked objects to 
regular object status. 

CONVERT TO CURVES 
The Convert to Curves command changes a selected object composed of vectors into an object 
composed of bezier curves. A drawing composed entirely of vectors will appear jagged when scaled 
up, but bezier curves (which can be curved or straight) tend to scale much more smoothly. 
Because of the nature of bezier curves, a single bezier curve can often replace multiple vectors. As a 
result, Convert To Curves can substantially reduce the number of nodes in an object. 

 
 Text To Graphic Graphic Converted To Curves 
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Selecting Convert To Curves opens the Convert To Curves dialog box: 

 

Allowable Error 
In order to Convert To Curves, the Allowable Error must be specified. Allowable Error represents the 
amount of acceptable deviation from the edges of the original object, and is measured in the current 
unit of measurement as specified in the General Preferences dialog box (i.e., inches or millimeters).  
Setting the Allowable Error at one percent (1%) of the smallest dimension of the object generally 
yields good results. For example, if the object measures ten by three inches, a setting of one percent of 
the smaller dimension, or 0.03 inches, usually yields very good results. 
Converting vectors to curves sometimes introduces minor distortions into a graphic object, as a result, 
caution should be exercised when setting the Allowable Error. Once the Allowable Error is set, select 
OK  to apply the changes, this will close the Convert To Curves dialog box. 
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CLOSE GRAPHICS 
This command will automatically close an open object. An open object has a start and an end point that 
are not joined, even though when looking at the object on the screen it may appear to be a closed 
object. This situation is common for graphics and text imported from third party software. This Close 
Graphics command closes these objects, by drawing a new line between the two open nodes (the start 
and end nodes). 

 
1. Graphic is not closed, fill does not apply. 2. Graphic is closed, the fill is applied. 

Note: To close text characters, the text must first be converted into graphics before the 
Close Graphics command can be used. 
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PLOT 
The Plot command is used to rout or plot a selected file. This command controls multi-copy routting, 
paneling, and other routting variables. 
An important and unique feature of EZ-Engrave’s Rout routine is that it will rout only those objects 
with currently active colors. This allows for the routting of selective elements within a graphic, while 
leaving others unrouted. 

Note: To Rout or Plot, the correct driver must be installed for the make and model of a 
plotter. See the File menu section of this chapter headed Install Drivers, to determine if 
the plotter driver is installed in EZ-Engrave. If a plotter driver is not installed, it must be 
installed prior to routting or plotting a file. 

Select Plot from the Cut menu to open the Plot dialog box: 

 

Keyboard Shortcut: [ALT + P] 

Selected Driver  
The Selected Driver list box is used to specify the router to send the current rout or plot to. This box 
will contain a complete list of all routers installed in EZ-Engrave. 

Note: The Selected Driver list box only lists those drivers which are already installed in 
EZ-Engrave. If a driver is not in this list, then that driver is not properly installed, and 
must be installed using the Install Drivers option in the File menu. 
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Copies 
This section is used to specify the number of copies to rout or plot, and, in the case of multiple copies, 
the space to be left between the copies. 

Copies Counter Box 
This edit box is used to specify the number of copies EZ-Engrave is to rout or plot. Specifying more 
than one copy produces the Xspace entry box. 

  

Stack Copies Check Box 
If routing more than one copy of a given object or objects, the copies can be stacked vertically by 
clicking on the Stack Copies check box. If no stacking is preferred, do not check this box. Electing to 
stack multiple copies makes the Yspace entry box available.  

 

Xspace and Yspace 
Specify the amount of space to be left between copies in a multiple copy rout. The Xspace parameter 
(which becomes available when more than one copy is specified) governs the amount of space left 
between copies placed side by side along the length of vinyl or paper. The Yspace entry box (produced 
by checking the Stack Copies check box) is used to define the space to be left between copies stacked 
above one another on the vinyl. Both of these parameters are measured in the current units of 
measurement as specified in the Preferences dialog box. 

Stack Size 
The number of copies to be rout in a single vertical stack is shown in this edit box. By default, it is the 
maximum number of complete objects which will fit, including the Yspace distance required between 
each. This number can be reduced, but cannot exceed the number that will actually fit. 
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Options 
This section is used to take advantage of some of the advanced features available with EZ-Engrave’s 
routing routines. 

 

Mirror 
Selecting Mirror causes the plotter to plot a mirror image of the selected graphic maintaining all the 
settings established in other segments of the Plot dialog box. This option is particularly useful for 
routing a graphic that is to be reverse-applied, as is the case when creating a window sign to be applied 
from the inside of the glass. 
 

Sort 
The Sort option is used to optimize routing for a number of different situations, depending on the 
current needs and the modules installed into EZ-Engrave. Selecting Sort opens the Sort dialog box: 

 

Sort Types 
¾ Nearest Sort, causes EZ-Engrave to sort the objects that are closest to each other and rout 

them first (i.e., two objects that are one inch apart will be routed in the same pass, whereas 
objects that are five inches apart will be routed separately). 

¾ Using Database Order, objects at the back of a graphic are routed first, while objects at the 
front are routed last. This sort type typically, causes EZ-Engrave to rout objects in the order 
in which were originally generated. Change this order by moving objects forward or 
backward using the options in the Arrange menu. This is EZ-Engrave’s default sort option. 

¾ Horizontally, causes EZ-Engrave to rout objects as they appear in the graphic from left to 
right. Under this sort type, EZ-Engrave will rout those objects whose extreme left edges are 
farthest right first, and rout those whose left edges are farthest left last. This sort order is 
most useful when routing a long file on a friction-fed plotter, as it reduces the required 
amount of travel back and forth along the length of the vinyl. 
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¾ Vertically, causes EZ-Engrave to rout first those objects whose extreme upper edges are 
lowest along the Y-axis. The higher on the Y-axis the object appears, the further in the order 
it will be rout. 

Tool Diameter 
Tool Diameter is available only if the routing option is installed in EZ-Engrave. It causes EZ-Engrave 
to sort all rout paths by the specified tool diameter for each path, from smallest to largest. Sort by Tool 
Diameter in addition to the any one of the other sort options. 
Regardless of which of the sort options is chosen, all objects will, generally, be rout from the inside to 
the outside contours (i.e., the inner circle of an “O” will be routed before the outer circle). 

Sort Within Paragraphs 
The Sort Within Paragraphs option causes EZ-Engrave to sort each letter as an object instead of each 
paragraph. For example if two paragraphs of text one above the other are sorted horizontally, the sort 
plots the first letter of each paragraph before moving across to the next. This has the benefit of saving 
on back and forth motion of the hardware. 

Note: Sort within paragraphs is available in Professional Text Compose only. 

Axis Swap 
Selecting the Axis Swap option causes the objects being plotted to be rotated ninety degrees (90°) 
counter-clockwise from their orientation on screen. This is a convenient way save vinyl, especially 
when routing long strings of single line text. 

Weed Border 
Selecting this option places a Weed Border around the objects selected to be routed. The margin or 
offset between the graphic and the Weed Border is set in the General Preferences dialog box from the 
Options… EZ-Engrave Setup… menus. 

Cut By Color 
Select the Cut By Color option to rout a multi-colored graphic one color at a time. When Cut By Color 
is selected, the Cut By Color dialog box is displayed after the OK option is chosen to send the job to 
the router. 

 

Next Color Layer to Rout 
This list box will display the color layer that is the next color layer to be routed. To select another 
color layer: 
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¾ click on the scroll arrow in the box and a drop-down menu appears displaying all the color 
layers that appear in the drawing; 

 
¾ click on the color layer to rout and it will appear in the display box as the next color to rout. 

The colors are displayed in the drop-down menu in the order they occur in the Color Palette. Select 
any color at any time, and any color can be routed multiple times. 

Cut Registration Marks 
Selecting the Cut Registration Marks causes Registration marks and all objects set as Locked to be 
routed with every color layer. 

Cut 
Click on Cut to proceed to the Set Tile dialog box where all selected objects from that color layer will 
be displayed with the default tile lines shown on screen. 

 
Once a color layer has been sent to the router, the corresponding color plate in the list box will be 
cross-hatched indicating that the color has already been routed once. The color can be re-selected for 
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routing again. 

 

Note: If Cut By Color is activated, a warning appears, if any thick lines are present in 
the drawing, asking if the thick lines should be routed. These thick lines will be shown 
on the screen and their color will appear in the Cut By Color dialog box as a color 
option to rout. 

Cut Fills 
Selecting Cut Fills opens the Tool Path Options dialog box: 

 
This option is available only if one of the modules which include a Tool Path, such as routing, 
engraving, or banner-making has been purchased. For more information on this option, see Chapter 10 
— Advanced Output. 

Tool 
The Tool section is used to define the tool parameters for the present rout or plot.  
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The Tool List Box 
This list box contains a complete list of all tools available for the specified driver.  

 
These tools include: 
 >  Air Brush >  Both Spindles >  Drill 
 >  Drag Knife >  Knife  >  Engraver 
 >  Left Spindle >  Manual depth >  Multi-pass 
 >  Multi-pass depth >  No depth >  Pen 
 >  Pounce >  Pounce Wheel >  Racer Blade 
 >  Right Spindle >  Router >  Single-pass depth 
 >  Spindle off >  Trailing Blade  
All of these options may not be available, they are dependent on the plotter driver installed. Select the 
appropriate option for the tool being used to rout or plot. 

Trailing or Drag Knife 
Select Trailing or Drag Knife if there is a Ideal Stencil Racer Blade tool in the Gerber tool holder or if 
the plotter is equipped with a Trailing Blade or Drag Knife. 
This option invokes a routine in EZ-Engrave which allows for the movement of the knife edge, and is 
offset from the center of the tool. Without this routine, the objects routed would not properly close, and 
corners would not be routed sharp. However, be aware that most routers which support a Drag Knife 
also have their own routines that compensate. As a result, never set both the router and EZ-Engrave in 
Drag Knife mode, as this will result in poor rout quality. 

Pounce 
Selecting this option causes the plotter to make pounce patterns by lifting and lowering the tool holder 
while routing or plotting. This results in the objects in the file being perforated or drawn with a broken 
line. 

 
When the Pounce option is selected, the Dash and Blank variables become active. The value entered in 
the Dash entry box determines the length of the perforation or drawn line. The value in the Blank edit 
box determines the spacing between each perforation or line. 
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Move 
This determines where the router will begin to plot on the X and Y axis. By default, the plotter will 
normally begin routing a graphic file at the lower left hand corner of the vinyl. 

 

Xmove 
Movement along the length of the vinyl (the X-axis) is accomplished by entering the appropriate 
distance in the Xmove entry box. 

Ymove 
To move the plot across the width of the vinyl (the Y-axis) specify a move using the Ymove entry box.  
Both the Xmove and Ymove entry boxes use the current unit of measurement (as specified in the 
General Preferences dialog box) as the unit of measurement. This feature is useful, for example, if the 
vinyl roll has a section already used and the rout must be performed in an upper section of the vinyl. 
This command will adjust the origin for plotting. 

Smoothing 
Smoothing attempts to smooth the transition from each vector or curve in a drawing’s outline to the 
adjacent line segments. Lower Smoothing tends to result in smoother lines, but may also result in a 
marginally less-accurate rout. 

 
¾ Selecting Low results in a smooth, faster rout, but some drawing resolution may be lost;  

¾ Selecting Medium applies a moderate amount of smoothing and is the recommended setting 
for most routing operations, though routing may be marginally slower; and 

¾ Selecting High applies a minimal amount of smoothing on the original drawing file. The 
routing will be slow but accurate. 

Cut 
The Cut section determines which parts of the graphic are going to plot.  
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Page 
Selecting Page will plot all objects on all active layers of the graphic. The Page option will shift the 
objects to be routed from the lower left of the plotter page. 

Window 
Selecting the Window option will rout all those objects in active layers that are currently visible on the 
view screen. If an object is only partially visible on screen, only the visible portion will be routed. The 
Window option will shift the objects to be routed from the lower left of the plotter page. 

Sign Blank 
Selecting the Sign Blank option will cause EZ-Engrave to plot only those objects which appear on the 
sign blank. As with the Window option, an object which is partially on the sign blank will be partially 
routed. 

Selected 
The Selected option results in only selected being routed. Selected can be used in combination with 
any of the other three boundaries for routing the objects that fall within the boundaries of the Rout 
criteria (i.e., Page, Window, or Sign Blank) and are selected will be Routed. 

Object Start Point 
With the Cut section of the dialog box, move the start points of objects about to be routed. 

 
Current ...the start point for original creation of the objects;  
Bottom ..the lowest point on the object; 
Top. .......the highest point on the object; 
Left. .......the left-most point on the object; or  
Right ......the right-most point on the object. 

Jog 
EZ-Engrave supports two related features, called Plotter Jog and Plotter Interrogation. These features 
are designed to help reduce the amount of material waste by routing objects in specific areas of a sheet 
of vinyl. When using this feature, objects can be placed very precisely into areas of vinyl that were left 
unused by a previous job. Also, elements of a current job can be placed into different areas of the vinyl 
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for optimum use of space. Pressing Jog button opens the Jog dialog box: 

  
When new artwork is routed on plastic scraps, left from a previous job, move the origin to fit the 
artwork into a specific area. For example: 

¾ if a previous job has left a section of Plastic in an odd shape; 

  
¾ shift the origin of the routed so that it fits into the remaining Plastic; 

 
While this task can be accomplished by setting an X- and Y-move from within the Cut dialog box, 
jogging the plotter head offers a more precise setting. This is because the head of the router can 
physically be moved to the desired position before committing to the rout. Also, use the Jog option to 
change the angle of the baseline for a given rout. 

Registration 
The first box within the Jog dialog box is the Registration box and offers the option to set the 
Reference Point, the Skew Point, and the Stretch Point, or to Walk the plotter over the Registration 
marks or Reference Points. 
If Registration Marks exist on the artwork, the Reference Points (described below) will be set to the 
Registration Marks. 
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Reference Point  
The first step in jogging the plotter head is to set the Reference Point. This includes both defining a 
target point for the group of objects to be routed, and defining where on the vinyl that point is to be 
placed. 
To set the Reference Point, click Reference Point in the Registration area of the Jog dialog box. This 
setting enables of the Reference Point’s target to be defined, as well as its actual position on the vinyl. 
The next step in setting the Reference Point is to define the Reference Point’s target on the graphic on 
screen. The default Reference Point is the origin of the artwork (i.e., lower left point). This point can 
be moved graphically on screen to suit specific needs. Move this Reference Point to anywhere on the 
artwork by clicking with the left mouse button at the desired position. The Reference Point target 
cross-hair looks like this: 

 
Once the Reference Point is set on the artwork, set the actual position on the vinyl for the Reference 
Point for routing. This involves moving the head of the plotter to the point where the target should be 
placed. The plotter headmay be moved in five ways: 

¾ move the mouse, while holding the right mouse button; 

¾ position the mouse and press the right mouse button; 

¾ press the cursor keys (holding the Shift key moves the plotter head in larger increments); 

¾ enter the coordinates manually; and/or 

¾ move the plotter head with the plotter controls. 

Skew Point 
If there is only a Reference Point set, EZ-Engrave will rout the graphic with a horizontal baseline. 
However, to change the angle of the baseline to make better use of the available vinyl, or to rout a pre-
printed piece of material accurately, set a Skew Point. 

¾ The procedure for setting the Skew Point is identical to setting the Reference Point. Click on 
Skew Point in the Registration section of the Jog dialog box to begin. 

Stretch Point 
If there is only a Reference Point and/or Skew Point set, EZ-Engrave will rout the graphic with the 
exact proportions that it was originally designed at. However, to change the horizontal and/or vertical 
proportions of the graphic to rout a pre-printed piece of material accurately, as some printers/ routers/ 
engravers might resize the image while printing/ routing/ engraving, set a Stretch Point. 

¾ The procedure for setting the Stretch Point is identical to setting the Reference and Skew 
Points. Click on Stretch Point in the Registration section of the Jog dialog box to begin. 

Registration Mark 
Pressing the Registration Mark button causes the plotter to move around to the next registration mark 
location on the vinyl, and is useful when Contour Routing print jobs. The plotter head will remain in 
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the up position during this movement. This feature is particularly useful to ensure that registration is 
accurate for contour routing pre-printed graphics. 

Walk 
Pressing the Walk button within the Registration box causes the plotter to move through the Reference, 
Skew, and Stretch Points on the vinyl. The plotter head will remain in the up position during this 
movement. This feature is particularly useful to ensure that registration is accurate for contour routing 
pre-printed graphics. 

Move The Routing Head With The Mouse  
To move the routing head with the mouse, simply drag the target to the appropriate position using the 
right mouse button. Note that as the mouse moves, the routing head of the plotter mimics the 
movements. The Target representing the plotter head looks like this: 

  
Lead the router to the position for the first reference point, release the right mouse button when the 
plotter head is in position. The routing head can also be moved by [Shift] clicking the right mouse 
button at the first reference point position. 
To check the exact position of the pen or knife, the routing head of the plotter can be dropped to the 
surface of the vinyl by pressing the [Page Down] key on the keyboard. To return the head to the up 
position, press the [Page Up] key. 

Move The Routing Head With The Keyboard 
Moving the routing head with the mouse is generally a coarse adjustment. To supplement this type of 
movement with a finer control, choose to direct the routing head to the required position from the 
keyboard using the Left, Right, Up, and Down arrow keys. Click in the main EZ-Engrave view screen 
before using the cursor keys in order to activate this function. To increase the speed at which the 
routing head is traveling, press and hold the [Shift] key while moving the head.  
To check the exact position of the pen or knife, the routing head of the plotter can be dropped to the 
surface of the vinyl by pressing the [Page Down] key on the keyboard. To return the head to the up 
position, press the [Page Up] key. 

Note: The arrow keys on the keyboard can only be used to move the routing head to the 
position of the Target. The Target itself can only be moved using the mouse. 

Move The Routing Head To An Absolute Position 
Move the routing head with a very high degree of precision to an absolute position on the vinyl, by 
typing in the required X-axis and Y-axis coordinates in the X and Y entry boxes to set the target 
position. 
Once the first target point is specified, press the Set Position button to lock in the coordinates. This 
button, available only in Remote Jog mode, will immediately move the plotter head to the position set 
in the X and Y boxes. 
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Jog Mode 
Select between Plotter Jog and Computer Jog. 

Plotter Jog 
Some plotters have the ability to relay information about the position of their plotting head to the 
computer through the same serial cable by which the computer controls the router. In order for this 
information to be useful, however, the software running on the computer must be capable of accepting 
and recognizing it. The ability to poll information from the plotter is called Plotter Interrogation. 
Because EZ-Engrave supports Plotter Interrogation, certain plotters can actually be jogged directly 
from their own front panel controls, relaying their movements to EZ-Engrave. The plotter’s controls 
can therefore be used to jog the plotter rather than the keyboard or mouse. 
To take advantage of Plotter Jog (where supported by the plotter): 

¾ click on Plotter Jog in the Jog Mode area of the Jog dialog box; 

¾ adjust the plotter head position with the plotter controls; and 

¾ click on Get Position. 
The Get Position button, available only in the Plotter Jog mode, will interrogate the plotter and then 
display the plotter head position in the X and Y Boxes. This option is available only if the router 
supports plotter interrogation. 

Computer Jog 
Computer Jog allows for the use of the mouse, keyboard, or Jog dialog box to control the positioning 
of the plotter head. 

Walk 
Pressing the Walk button causes the plotter to move around the perimeter of the vinyl required by the 
current rout job. The plotter head will remain in the up position during this movement. This feature is 
particularly useful to test that there is enough vinyl to complete the rout job. 

OK 
Clicking on the OK button closes the Jog dialog box and continues the routing process, proceeding to 
either the Tiling dialog box or the Cut By Color dialog box depending on the modules installed and the 
choices made in the main Cut dialog box. 

Move Control 
The Move Control button gives immediate access to the Move Control dialog box. Move Control is 
where the parameters are set that are used by EZ-Engrave to drive the router (See the section later in 
this chapter on Move Control). 

Save Default  
Selecting Save Default button in the Plot dialog box accepts parameter changes made to the Plot menu 
and saves them as the default value for the next time the Plot command is used. 



Cut Menu 

OK 
Clicking on the OK  button closes the Cut dialog box, and moves to the next phase of the routing 
process. The Set Tiles dialog box will open, unless Cut By Color was selected in which case the Cut 
By Color dialog box will open first. 

Set Tiles 
Prior to routing or plotting any file the Set Tiles dialog box will open. 

 
The Set Tiles dialog box displays information about the tiling lines, including: 

¾ the position relative to the origin of the objects being printed,  

¾ the size of the tile, and  

¾ the number of tiles required.  
Except for the number of tiles, these information boxes remain blank until a Tile line is selected. The 
Tiling feature for ploting and routing works in the same manner as the Tiling feature for Printing 
please refer to the section earlier in this chapter on Tiling. 

PLOTTER SETUP 
The Plotter Setup option allows for configuring EZ-Engrave to drive a particular brand of plotter. 
Clicking on Plotter Setup in the Plot menu opens the Plotter Setup dialog box: 

 

Selected Driver 
This box displays the name of the currently selected plotter or router. 
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Installed Drivers 
This list box displays the complete list of all drivers installed in EZ-Engrave. It does not display those 
drivers which were not installed.  
To select a particular brand of plotter: 

¾ move the cursor into the Installed Drivers list box; 

¾ click on the Scroll Arrow (if necessary) to move through the list until the particular brand 
required is found; 

¾ click on it the required plotter driver. 
EZ-Engrave is now ready to drive the selected plotter, the name of which will appear in the Selected 
Driver box. 

Note: If a brand of plotter does not appear on the list, the driver for your plotter has not 
been properly installed. See the Install Drivers option under the File Menu for more 
information. 
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Port Location 
This drop down menu is used to specify the port through which the plotter is connected. To select a 
port, click on the required choice. There are several types of port available: 

¾ COMM Ports, or serial ports are the recommended port of choice when supported by the 
router. The serial port has several features which make it the best choice, including the fact 
that it is designed to handle bi-directional communications (i.e., it allows the computer to 
communicate with the router while also allowing the router to communicate with the 
computer at the same time). To use the serial port to drive the plotter, set up the serial port 
properly from within Windows’ Control Panel. For more information, consult the plotter 
manual. 

¾ LPT Ports, or parallel ports are essentially printer ports. They will often work with a given 
plotter or router, but, unless there is some compelling reason to use an LPT port, a serial port 
is always a better choice. 

¾ File, redirects the plot file to a file on the hard disk. 

MOVE CONTROL 
Move Control offers the option to set those plotter parameters that control the movement of the tool 
head. Define different sets of parameters for each of the different types of tools available for the 
specified plotter. Move Control can be accessed from the Plotter Setup dialog box, from the Plot dialog 
box, or directly from the Cut menu. 
Select Move Control to access the Move Control dialog box for the selected plotter. For example, the 
Ideal Stencil FastBoard driver’s Move Control dialog box looks like this: 

    
while the Allen Datagraph controller Move Control dialog box looks like this: 

 

22-16 • EZ-Engrave User Guide 

For full details on the parameters that appear in the plotter driver’s Move Control dialog box, consult 
the plotter’s manual. 
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TILING 
The Tiling option in the Cut menu establish the settings for tiling large images. Selecting this option 
opens the Tiling dialog box: 

 

Tiling Options 
Pause 

This option stops the plotter between each tile. Note that not all plotters can be paused between page 
boundaries. Page boundaries are set in the Plotter Setup dialog box . 

Stack Tiles 
When routing a file which requires tiling horizontally, but which will fit easily across the width of the 
vinyl, choose to Stack Tiles to reduce the amount of waste. This will cause each successive tile to be 
routed above the previous tile as many times as it will fit on the page width. For example, given a file 
which would tile as follows without the selecting the Stack Tiles option: 

 

EZ-Engrave User Guide • 22-17 



Cut Menu 

Selecting Stack Tiles would rout the file like this: 

 

Rout Horizontal Edge  
Selecting this option causes the horizontal edge of adjacent tiles to be routed. Only those edges which 
fall adjacent to other tile edges will be routed. Where a tile does not butt into another tile, there will be 
no rout tiling line. This feature is particularly useful when overlapping adjacent tiles. If this option is 
not selected, a rout mark will not be provided along the horizontal edges of adjacent tiles. 

Rout Vertical Edge 
Selecting this option causes the vertical edge of adjacent tiles to be routed. Only those edges which fall 
adjacent to other tile edges will be routed. Where a tile does not butt into another tile, there will be no 
rout tiling line. This feature is particularly useful when overlapping adjacent tiles. Not selecting this 
option will cause the plotter to automatically index past the page boundary without breaking the 
continuity of the rout. If an Xspace of zero (0) is set, do not select this option, this allows for effective 
routing of objects much larger than the maximum page size available for the plotter. 

Overlap 
This set of options specifies the amount of over-rout each tile will contain, such that each tile actually 
ends with the beginning portion of the next tile.  

 
If, for example, an overlap of a ½ inch is set, the last ½ inch trailing edge of a given tile will be 
identical to the first ½ inch leading edge of the next tile. This function is useful when overlapping 
adjacent tiles to prevent gaps from appearing between the tiles due to material shrinkage. 

Vertical Overlap 
The value entered into this option specifies the amount of overlap desired along the vertical rout edge 
of adjacent panels. 
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Horizontal Overlap 
The value entered into this option specifies the amount of overlap desired along the horizontal rout 
edge of adjacent panels. 

Spacing  
This setting is used to specify the amount of material which is to be left unrout between tiles when 
routing a job. Specify either a Vertical Space — space between two tiles which are side by side; or a 
Horizontal Space — space between tiles which are one above the other on the material. 

 

Note: This Tiling box is the same box as that in which the tiling parameters for printing 
are specified. Therefore, the rules that are set regarding Tiling in this dialog box will 
also be applied to the Tiles generated when printing a file. 
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TRANSFORM MENU 
FIT TEXT TO ARC 

This feature positions a line of text on an arc. The arced text can be made to vary in radius, in direction 
and in the degree of arc. Fit Text To Arc is found in the Transforms menu. 

 

Note: Fit Text To Arc is only available if the Professional Text Compose module is 
activated. 

More than one line of text can be fit to an arc in a single operation. To implement Fit Text To Arc, 
select the line(s) of text to be arced and click on the Fit Text To Arc option under the Transforms 
menu. The Fit Text To Arc dialog box appears: 

 

Direction  
Up & Down 

Selecting the Up option lays the text along an arc that bows upward in the middle. The Down option 
fits the text to a downward facing arc. 



Transform Menu 

   
Up option   Down option 

Baseline & Topline 
Selecting the Baseline option causes the baseline of the selected text to fall along the edge of the 
specified arc. Selecting the Topline option causes the topline of the bounding box that contains the 
selected text to the specified arc. 

 

Clockwise & Counter-clockwise 
Selecting either of these options causes the text to be fit in a Clockwise or in a Counter-clockwise 
onto the arc as shown below: 

   
Clockwise Up   Counter-clockwise Up 

   
 Clockwise Down    Counter-clockwise Down 
 
An approximation of the visual representation of the choice of arc is displayed in the arc view box. 

Group 
Degree of Arc 

When fitting text to an arc, the text occupies a portion of the defined arc, and the occupied portion of 
the arc is measured in degrees. The Degree Of Arc defines how large a piece of the arc the text will 
occupy. For example, a setting of 90 will result in the text being fit to a section of the arc which 
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measures 90°. 

 

Radius 
When text is fit to an arc, the arc itself is treated as a portion of a circle. The Radius setting determines 
the distance between the arc and the center of the circle that includes the arc. A smaller Radius setting 
produces a more curved line of text, while a larger Radius produces an arc which more closely 
approximates a straight line. 
Degree Of Arc and Radius are interdependent, as they specify the available space for the line of text, 
the length of which is usually fixed. As a result, changes to one of these settings will result in changes 
automatically being applied to the other. The exception to this occurs when the Custom Arc option is 
activated. 

Custom Arc 
Activating the Custom Arc option adds new options to the Group section of the Fit Text to Arc dialog 
box. 

 
Custom Arc allows for specification of both the Radius and the Degree of Arc without regard for the 
actual length of the text being fit into the available space. This is accomplished by applying a 
Compression/Expansion routine to the text string to force it to fit onto the specified arc. There are three 
options available for fitting the text into the specified space: Height Compression; Width Compression, 
and Kerning Compression. 

Height Compression 
Height Compression forces the line of text to the required length by increasing or decreasing the height 
of the characters as necessary. Character Width and Height will also be scaled proportionately. 

Width Compression 
Width Compression forces the line of text to the required length by increasing or decreasing the width 
of the characters as necessary. Character Kerning will also be scaled proportionately, but character 
Height will not be affected. 

Kerning Compression 
Kerning Compression forces the line of text to the required length by increasing or decreasing the 
space between the characters as necessary. Character Width and Height will not be affected. 
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FIT TEXT TO PATH 
This feature positions a line of text on an path. The text can be to follow the path based on the 
direction and alignment, and can be set to the baseline of the text or raised or lowered depending on 
selections made. Fit Text to Path is found in the Transforms menu. 

 

Note: Fit Text to Path is only available if the Professional Text Compose module is 
activated. 

More than one line of text can be fit to a path in a single operation. To implement Fit Text to Path, 
select the line(s) of text as well as the path and click on the Fit Text to Path option under the 
Transforms menu. The Fit Text to Path dialog box appears: 

 
If the object selected for use as a path is a closed path the Fit Text to Path dialog box appears with 
slight modifications: 
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Direction  
Left to Right  & Right to Left  

Selecting the Left to Right button lays the text along a path starting from the left edge of the text and 
the left edge of the path and running the text from left to right. The Right to Left button fits the text to 
a path from the left edge of the text and the left edge of the path and running the text from right to left. 

  
Left to Right option Right to Left option 

Alignment   
Alignment offers the ability to align the text and path to the Left , Center , or Right . 

   
Aligned Left Aligned Center Aligned Right 

Or if the path selected is a closed path the alignment can be Top , Bottom , Left , or Right . 

    
Aligned Top Aligned Bottom Aligned Left Aligned Right 

Baseline Alignment  
Selecting the Baseline Alignment options causes the baseline of the selected text to fall along the edge 
of the specified path as designated by one of four choices: Align to Baseline ; Align to X descender 

; Align to Center Line ; and Align to Ascender Line .  

Align to Baseline  
Selecting the Align to Baseline fits the text to path such that the path is aligned to the bottom of the 
descender characters of the text. Selecting the Align to Baseline option activates the Text to Path 
Distance options. Any settings for distance will align the text that much further above the path. 
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Fit to Path Distance 
Selecting the Align to baseline or the Align to Ascender Line options activates the Fit to Path Distance 
section of the Fit to Path dialog box. 

 
The text can be set to fit the path a specified distance above (or below) the path. This distance can be 
determined as a Relative percentage of the font height or as and absolute measurement in the unit of 
measurement determined in the General Preferences dialog box. 

 
Fit to Baseline with a Relative distance of 50% 

Align to X descender  
Selecting the Align to X descender fits the text to the path such that the path is aligned to the bottom of 
the X characters in the line of text, in other words all descenders will fall below the path. 

Align to Center Line  
Selecting the Align to Center Line fits the text to path such that the path is aligned through the center 
line of the characters of text. 

Align to Ascender Line  
Selecting the Align to Ascender Line fits the text to path such that the path is aligned to the top of the 
ascender characters of the text. As in the Align to Baseline option the Text to Path Distance options are 
made available. Any settings for distance will align the text that much further below the path. 

RENDER TO BITMAP 
Selecting the Render To Bitmap option converts any selected vector or bitmap object. When the 
Render To Bitmap option is selected the Render To Bitmap dialog box opens. 
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Color Depth 
Monochrome................. converts the selected objects to black and white bitmaps; 
16 gray levels................ converts the selected objects to gray scale bitmaps with 16 shades; 
256 gray levels .............. converts the selected objects to gray scale bitmaps with 256 shades of gray;  
16 colors ...................... converts the selected objects to 4-bit color bitmaps with 16 colors;  
256 colors...................... converts the selected objects to 8-bit color bitmaps with 256 colors.  
Full color ...................... converts the selected objects to 24-bit color bitmaps with millions of colors; 

Resolution 
The resolution is measured in Dots Per Inch (DPI), and is set manually, the default screen resolution 
appears in the box. 

As Shown On Screen 
When selected this option causes the bitmap to be created using the current screen settings for Color 
Depth and Resolution. 

Keep Original 
When selected this option will cause the bitmap to be rendered as a duplicate leaving the original 
object as it was.  This option does not apply if the bitmap is being rendered to a file instead of to a EZ-
Engrave Object. 

Create Bitmap File 
Selecting the Create bitmap file button causes the bitmap to be rendered and saved to a separate file 
from the one currently open. When selected it opens the Save Bitmap As dialog box. 

 

Save In 
The Save In box displays the current path for the directory/folder, that the file will be saved in. Select 
within the path structure by clicking on specific directories in the Folders list box. 
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File Name 
Insert the File Name for the bitmap file in the File Name box, to replace a file listed in the Files list 
box, click on the file and the name will appear in the File Name box. 

Save As Type 
There is only one option available from this list box and that is bitmap, though the All Files option can 
be selected, the file will be saved as a bitmap. 

Open as Read Only 
Select the Open as Read Only check box to create a bitmap file that is designated as read only and can 
be viewed but not edited. 

Create EZ-Engrave Object 
Selecting the Create EZ-Engrave Object button causes EZ-Engrave to render the bitmap as a new 
object within the currently open file. 

Save Settings 
Clicking the Save Settings button saves the current settings within the Render To Bitmap dialog box 
and applies them as the default settings to be used the next time the Render To Bitmap is used. 



Image Menu 
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IMAGE 

 
The Image menu is only available with the Special Effects module. 
This menu contains tools for Image editing. 

Note: This menu is only available when advanced modules have been purchased from 
Ideal Stencil or one of its authorized re-sellers. Refer to Chapter 4 — Special Effects for 
more information on these tools. 
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VIEW MENU 

VIEW 
 
The View option specifies the various objects to have visible on screen when working in EZ-Engrave. 

SHOW SIGN BLANK 
To have a sign blank displayed on screen, select this option. Define the size of the sign blank by 
selecting Blank Size from the Layout menu. A small check mark beside the option indicates that it is 
selected. 

  
Show Sign Blank on.    Show Sign Blank off. 

SHOW FILL 
This option provides the opportunity to display objects as filled on screen, or as simple wire frames. 
Wire frames redraw more quickly than filled objects, but filled objects give a better representation of 
the file. To display object fills on screen, select the Show Fill option. A small check mark beside this 
option indicates that it is selected. 

  
Show Fills on;      Show Fills off. 

Keyboard Shortcut: [Alt + S] 



View Menu 

SHOW LINE STYLE 
Select this option to display thick lines that have been applied to any on-screen objects. A check mark 
beside the option indicates that it is selected. 

 
Show Line Style and Fills on;  Show Line Style on — Fills off; Show Line Style and Fills off. 

Keyboard Shortcut: [Alt + N] 

SHOW TOOL PATHS 
The Show Tool Paths option display any tool paths created for fill routines and routing or engraving 
output. 
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SHOW TOOLS PATH ONLY 
The Show Tool Paths Only options displays the only tool paths. 

 
Show Tool Paths with Show 3D also activated. 

SHOW RULERS 
To display the rulers to the right of and at the bottom of the view screen, select this option. To use the 
space for more view screen area, deselect the Show Rulers option. A small check mark beside the 
option indicates that it is selected. The Rulers must be displayed in order for the Guideline functions to 
be available. 

Keyboard Shortcut: [Alt + R] 

SHOW CUSTOM TOOLBAR 
The Show Custom ToolBar option activates the Customizable ToolBar for more information see the 
Custom ToolBar section in Chapter 1. 

 
Show Custom ToolBar activated. 

EZ-Engrave User Guide • 25-3 



View Menu 

 
Show Custom ToolBar de-activated. 

SHOW TEXT OUTLINES 
In order to increase the redraw speed, display text as simple wire frame boxes. Wire frames redraw far 
more quickly than text, this option has the potential to speed up work substantially, whenever working 
with text. A small check mark beside this option indicates that it is selected. 

 
Show Text Outlines activated 

 
Show Text Outlines de-activated 
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SHOW BITMAP AS OUTLINES 
As a rule, bitmaps will redraw more slowly on screen than other objects in EZ-Engrave. In order to 
increase the redraw speed, display bitmaps as simple wire frame boxes. Wire frames redraw far more 
quickly than most bitmaps, this option has the potential to speed up work substantially, whenever 
working with bitmaps. A small check mark beside this option indicates that it is selected. 

  
Show Bitmap As Outlines off;    Show Bitmap As Outlines on. 

Keyboard Shortcut: [Alt + M] 

SHOW 3D 
The Show 3D option applies to any vector that has a tool path applied. This will display a 3D 
simulation on screen of the actual rout depth. Show Tool Paths must be activated for Show 3D to 
function. When a tool path object is selected the depth entry box is displayed in the Status Bar. Enter a 
new depth and press the Enter key or use the arrow buttons to adjust the Tool Path depth. 

  

 
Show 3D activated 
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SHOW REDUCED BITMAPS 
The Show Reduced Bitmaps speeds the work time while still providing a visual guide when editing 
bitmaps. EZ-Engrave reduces the color depth and resolution of the bitmap for display purposes only, 
all work is done on the original higher resolution bitmap. 

  

SHOW ANCHOR TOOL 
Selecting this option activates the Anchor tool for use. This tool is described in detail in the Status Bar 
section of Chapter 1. The Anchor tool will appear with selected objects as well as on the Status Bar. 
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SHOW GRID 
This option controls whether or not the grid is visible on screen. To see the grid, set a check mark 
beside this option in the menu. To have the grid remain invisible, this option should not be checked. 

 

SHOW GUIDE LABELS 
With the addition of the new expanded Guidelines features comes the option to use Guide Labels these 
labels provide the measurement in relation to the Sign Blank for the placement of the Guide. When this 
option is activated the Guides show with measurement labels. See the section on Guideline in the 
Options menu for more information. 

 
Show Guide Labels On    Show Guide Labels Off 
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OPTIONS MENU 
 

OPTIONS 

 
 

The Options menu links to dialog boxes that customize aspects of the user environment of EZ-Engrave 
and its features and functions. 

EZ-ENGRAVE SETUP 
The EZ-Engrave Setup fly-out menu contains choices for accessing dialog boxes that control EZ-
Engrave setup functions specifically. 

General Preferences 
General Preferences is used to set preferences which govern the operation of EZ-Engrave. Selecting 
this option from the Options... Setup… menu opens the General Preferences dialog box. 

 



Options Menu 

General 
Units 

Choose between imperial measurements (i.e., inches) and metric. Once a standard unit of measurement 
is selected, it is used throughout EZ-Engrave. 

 

Weed Offset 
The Weed offset is used to specify the distance between selected objects and the weed border placed 
by the Weed Border and Power Weed tools from the Shapes fly out menu.  

HPGL Resolution 
The HPGL Resolution entry box is used with the File Capture feature of EZ-Engrave. Capturing a file 
from a plotter involves listening to a plotter perform a plot job, interpreting the move commands it 
issues, and recreating the plot on screen. But to capture a file properly, the resolution at which the 
plotter functions is required, so that EZ-Engrave interprets the move controls properly. If EZ-Engrave 
is not aware of the resolution of the plotter, the resulting captured file will typically be out of scale. 
For example, The HP 7475 plotter has a resolution of 1016 steps per inch. If the HPGL file being 
captured by EZ-Engrave was originally configured for a Hewlett Packard 7475 plotter in the third 
party application where it originated, edit the HPGL Resolution to read 1016 so that it would be 
captured at the correct scale (size). 

Layer No. 
The Layer Number option is used to display the ordinal number of each of the color plates. To see the 
color plates numbered, select On, select Off not to have the palette numbered.  

 

Speed Scroll 
Speed Scroll allows the view screen to move, following the cursor when it leaves the main viewing 
area. For example, stretch an object to a point off screen, the screen will scroll to maintain pace with 
the cursor and keep it on screen.  

 
There are three different options that control Speed Scroll: 

¾ Off, turns off the feature so that the view screen remains stationary without using the scroll 
bars; 

¾ Object Move, restrict the automatic scrolling of the view screen to those situations where an 
object is being moved; 

¾ Full, fully enables the automatic Speed Scroll — any time the cursor is dragged off the view 
screen, the view screen follows. 

Duplicates 
Use the Duplicate function in EZ-Engrave to place the duplicate object in a specific position relative to 
the original object. The X Offset and Y Offset are the amounts that a duplicate copy will be offset from 
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the original. 

 

Grid Size 
The values entered into the Width and Height edit boxes are used to construct the alignment grid in 
EZ-Engrave. Values entered into the Width entry box define the spacing between grid lines along the 
x-axis, while entries in the Height box determine the grid line spacing along the Y-axis. 

 

Snap Angle 
Specify the angle that the Fit to Corner tool will snap to when editing line segments and corners in the 
Edit tools. As discussed in the section of the manual concerning the Segment Edit tool, the angle can 
be constrained to a specific set of values by holding the [Control] key while adjusting the corner. 

Palette 
Develop and configure palettes, or a permanent palette, as alternatives to the default palette supplied 
with EZ-Engrave. 

 
The Palette controls are described in detail in the Color Palette section of this chapter. 

Registration Mark Settings 
When selected, this option allows the operator to specify a size and pattern for the placement of 
registration marks around any selected drawing. Registration marks are placed automatically with the 
use of either of the Registration tools. Clicking on this option or right-clicking on the Registration tools 
opens the Registration Mark Setting dialog box. For more information about the Registration Mark 
Settings refer to the Registration tools in the Shapes tool section of this chapter. 
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Dimension Setup 
When using the Dimensioning tools (which are a feature of the Measure tool), pre-configure and 
format the appearance of the dimensions and notes. To do so, select Dimension Setup in the Options… 
EZ-Engrave Setup… menus, and set the preferences in the Dimensioning Setup dialog box. The dialog 
box is also available by right-clicking any of the Measurement tools, for more information about the 
Dimensioning Setup refer to the Measurement tool section of this chapter.  

 

Export Error Tolerance 
When exporting a file from EZ-Engrave, the resulting file sometimes contains a very large number of 
nodes. This is especially true of artwork that was originally imported from another software. To 
combat this problem, EZ-Engrave allows exporting of files using a certain tolerance level, this will 
make the exported artwork smoother, and substantially reduce the number of required nodes in the file. 

 
Specify the acceptable amount of error in the Error Tolerance edit box. This box uses the unit of 
measurement specified in the General Preferences dialog box as its standard (i.e., inches or 
millimeters). 
We caution against entering a high value in this box, as the Export Error Tolerance may introduce 
distortion into the exported objects if set for a very high tolerance. As a rule, the default value (0.001 
or 1/1,000 of an inch) will work very well with most files. 
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Undo Setup 
Selecting this option opens the Undo Control dialog box: 

 
Because Undo information is stored in memory (and later, on the hard drive when all memory is 
exhausted), maintaining a large Undo Stack can result in a substantial loss of performance, even on the 
fastest systems. The Undo Control dialog box limits the resources that can be allocated to the Undo 
feature of EZ-Engrave in two ways: 
Specify the maximum number of operations to be maintained in the Undo Stack by entering a 
reasonable number into the Maximum Number Of Steps Saved field. 
Enter the Maximum Amount Of Memory To Be Used for Undo resources. In other words, specify the 
amount of memory that will be used by Undo, the rest to be reserved for other uses. 
EZ-Engrave will maintain operations in the Undo Stack until either one of the specified limits is 
reached. Our recommended settings are as follows: allow no more than 10 operations in the Maximum 
Number Of Steps Saved; and use an amount of memory which is equal to half of the physical memory 
(RAM) in the computer. These settings will ensure a reasonable balance between the needs of the 
Undo Stack and the overall speed of the computer. 

Note: While the concept of unlimited Undo may seem attractive, it can, in fact represent 
a substantial and unnecessary drain on system resources, and therefore system speed. 
Ideal Stencil recommends being conservative when allocating resources for use by the 
Undo Stack.  
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Dialog Box Font Setup 
The Dialog Box Font Setup is used to determine the font to be used for all dialog boxes used in EZ-
Engrave (i.e., the text compose dialog box).  

 

Current Settings 
The Current Settings box displays the currently selected font and font size being used for the dialog 
box font. 

Options 
The Options box provides three choices for dialog box font settings:  
Use Default....................uses the standard windows font for the dialog boxes;  
Automatic ......................uses the most appropriate font available; and 

Select .............................causes the Font  button to appear. 

Font 
Pressing the Font button opens the Font selection box: 
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Choose a Font, Font style, Size, and Script option and press OK to accept the selection and return to 
the Dialog Box Font Setup, or press Cancel to return to the Dialog Box Font Setup without applying 
the changes. 

   
 Using MS Sans Serif 8pt dialog box font. Using News701BT 12 pt dialog box font.   

Note: Use caution when selecting fonts, large fonts can cause the dialog boxes to 
enlarge to where they do not fit on the screen, and small or fancy fonts can be illegible. 
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Accuracy Settings 
The High Accuracy Settings control how accurately certain functions are to be performed in EZ-
Engrave (i.e., if all nodes will be traced to create a highly accurate outline or if only half of the nodes 
are traced to create an inaccurate outline). Any and all of the Weld tools can be set to high accuracy 
levels as well as the Outline/Inline, Round Corners, and Route Paths. Keep in mind that if the accuracy 
is set to high, the time and system resources required to complete the function will be more.  

 

Selection Tool Settings 
Use the Selection Settings to determine how the cursor respond to commands in EZ-Engrave.  

 
Among the choices available are:  

Use Live Cursor 
Use Live Cursor causes EZ-Engrave to recognize when the cursor passes over an object, the pointer 
icon for the cursor converts to cross-hairs. If Use Live Cursor is turned off the cursor remains the 
standard pointer. EZ-Engrave must be restarted for changes to this option to take effect. 

  
Use Live Cursor turned off. Use Live Cursor turned on. 

26-8 • EZ-Engrave User Guide 



Options Menu 

Use default snapping range  
The snapping range refers to the distance from a line or grid where EZ-Engrave assumes the selected 
object should snap to the nearest grid or line The default snapping range of three pixels is used when 
this option is turned on (i.e., if the edge of an object is within three pixels of a grid EZ-Engrave will 
automatically move the object so the edge is on the grid. 

Snapping range in pixels 
Set the Snapping range, in pixels, to any size greater than zero, a low value is preferable when working 
in small scale, a high value when worker in large scale. 

Nub size in pixels  
Edit the size of the nubs to any range greater than zero, a low value is preferable when working in 
small scale, a high range is preferable when worker in large scale (i.e., when working on objects less 
than twenty pixels wide set the nub size to one or two pixels, when working on objects greater than 
twenty feet wide set the nub size to a larger pixel value). 

Speed Scroll 
Speed Scroll allows the view screen to move, following the cursor when it leaves the main viewing 
area. For example, stretch an object to a point off screen, the screen can scroll to maintain pace with 
the cursor and keep it on screen. There are three different options that control Speed Scroll: 

¾ No speed scrolling, turns off the feature so that the view screen remains stationary without 
using the scroll bars; 

¾ Permit speed scrolling while moving objects, restricts scrolling of the view screen to 
situations where objects are being moved; 

¾ Always permit speed scrolling, fully enables the automatic Speed Scroll — any time the 
cursor is dragged off the view screen, the view screen follows. 

Sketch Tool Settings 
The Sketch Tool Settings are for use with the Graphic Creation tools and for editing vector graphics. 

 
Lines pass through nodes as stated will cause the lines to pass directly through the center of a given 
node. Lines pass near nodes will cause the line to pass near but not touching or over the node. EZ-
Engrave must be restarted for changes to take effect. 
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Lines pass through nodes. Lines pass near nodes. 
 

Import Bitmap Setup 
Import Bitmap Setup opens the Bitmap Import Colors Settings dialogue box. Within this dialog box 
the Background and Foreground colors can be designated for monochrome bitmaps that are imported. 

 
Choose a color from the drop-down lists to select a Background or Foreground color. 

  
Monochrome bitmap with purple background Monochrome bitmap with green background and 
and blue foreground;   yellow foreground. 

  

MANAGE FAVORITE FONTS 
EZ-Engrave will store and retain a list of Favorite Fonts, those fonts most often used. For example, if 
the most common font being used regularly is a Helvetica style of font from a particular manufacturer, 
place all variations of that font (i.e., normal, bold, bold-italic, and italic) into the Favorite Fonts list. 
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Selecting the Manage Favorite Fonts option opens the Favorite Font dialog box: 

 
This box displays the names of the fonts currently designated as Favorite Fonts. From within this 
dialog box, add fonts to the list, remove fonts from the list, or close the dialog box, by simply pressing 
the appropriate button. The first time the Favorite Fonts list is opened there will be no fonts listed. 

Add 
Pressing the Add button produces the Font Detective dialog box to navigate through the system to add 
fonts to the Favorite Font list. See the Font Detective section of Chapter 3 — Text Compose for 
detailed information on how to use Font Detective. 

  
Select the Font of choice via the Font Detective and press the Select Font button to return to Favorite 
Fonts with the new Font added to the list. 
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Remove 
To remove a font or fonts from the Favorite Fonts list, select the font to be deleted and press the 
Remove  button, the font will be removed from the list. 

AUTOMATIC SAVE 
When activated, this option automatically saves the file currently open at predetermined time intervals. 
This protects against the loss of work due to accidental shutdown of the program. Selecting this option 
opens the Automatic Save dialog box. 

 
Should the EZ-Engrave program be shut down without the use of the Exit command in the File menu, 
the work on the screen at the time of the last Automatic Save can automatically be loaded onto the 
screen when re-starting EZ-Engrave. 

Automatic Save Enabled 
Select this option to have the work saved automatically. 

Automatic Load Enabled 
Select this option to automatically load any file which was on screen when the program unexpectedly 
stopped without the use of the Exit command. This feature is only available if the Automatic Save 
function is enabled. 

Time Between Saves 
This option determines the time interval between Save operations by the Automatic Save feature. If 
this time interval is set too long, a significant amount of work will be lost, should the system shut 
down accidentally. If this interval is set too short, the computer will interrupt work too frequently to be 
of help. 

Create Back Files When Saving 
This option causes EZ-Engrave to create a bak back-up file when any open file is saved using the Save 
or Save As commands. The bak file will have the same preface name as the saved file and will be 
stored in the same directory. 

Note: Back up files are a good safety measure however they can use up a tremendous 
amount of hard disk space if they are not removed from the system on a regular basis. 
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PALETTE 
This option provides the means to manage the palettes in EZ-Engrave, the one currently active and 
those saved. For more information on the options available from the Palette fly-out menu see the 
section earlier in this chapter on the Color Palette. 

 

GRID 
This option opens a fly-out menu where the settings for the grid are specified.  

 

Snap To Grid 
The Snap To Grid effects size and move commands. Specifically, move and size functions will be 
constrained to the width and height of the grid cells. For example, if the grid size is one inch by one 
inch, objects can be moved in any direction in one inch increments only. The sizing function is 
similarly effected. A small check mark beside the Snap to Grid option indicates that it is selected. 

Show Grid As Lines 
By default, the grid is displayed as black dots which appear at the intersection of the vertical and 
horizontal grid lines. To have the grid lines themselves visible on screen, check the Show Grid As 
Lines option. This option is particularly useful when using a high resolution screen, upon which the 
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grid dots may be difficult to see. A small check mark beside this option indicates that it is selected. 

 

RESET ORIGIN 
The Reset Origin command returns the origin of the grid to the default position at the lower left of the 
sign blank. This function is useful if the origin has been moved during the edit process with the 
Alignment Grid. 

GUIDES 
A guide is a vertical or horizontal reference line that can be positioned on the view screen at any 
location. As many as twenty guidelines in each direction can be displayed on the screen. 
Objects on screen, nodes, and control nubs (when moving, distorting or transforming) can all be 
snapped to guidelines. This snap feature works in exactly the same manner as the snap to grid. 

 

Use Guides 
To use guidelines, check this option from the Guides fly-out menu in the Options menu. 

Remove All Guides 
This option deletes all guidelines. It may be used at any time, whether or not the guidelines are visible 
on screen. 

Edit Guides 
Selecting the Edit Guides option opens the Edit Guides dialog box, right mouse clicking on any empty 
space in the view screen produces the same results, however the appropriate X and/or Y coordinates 
will be inserted if the Edit Guides dialog box is accessed directly from the view screen with a right 
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mouse click. 

 

Orientation 
There are three orientation types of Guides to use with EZ-Engrave: Horizontal, Vertical, and 
Diagonal. If the Edit Guides dialog box was accessed through the Options menu the X and Y 
coordinates will be listed as 0. If the dialog box is accessed via the right click on screen the X and Y 
coordinates where the cursor was placed are listed.  

Add Parallel line at normal offset 
When activated this option will insert a guide at regular intervals parallel to the selected orientation. 

Diagonal Guides 
When the diagonal orientation is selected for the current guide, the dialog box provides a number of 
new options that aren’t available with the horizontal or vertical guides. 

 

Guide Anchoring 
The Guide Anchoring determines how the guide is Anchored to the Sign Blank. The Guide can be set 
to anchor to one point with a specified angle, or it can be set by two distinct X and Y coordinates, at 
opposite sides of the EZ-Engrave view screen. 

 

X and Y Point 2 Coordinates 
When the diagonal guide is set to anchor to two points, a second set of X /Y coordinates is available. 
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Angle 
When the diagonal guide is set to an anchor of one point and an angle there is one set of X and Y 
coordinates as well as an Angle entry box. 

Guides List Box 
All Guides of the selected orientation are listed in the Guides list box. They can be changed, or 
deleted, and new guides can be added. 

Add 
To Add a Guide select a similar one from the list, edit the X and/or Y coordinates, or if applicable the 
Angle and press Add to create a new Guide using the current settings. 

Change 
To Edit a Guide select it from the list, edit the X and/or Y coordinates or if applicable the Angle and 
press Change to apply the changes. 

Delete 
Delete the selected Guide from the list by pressing the Delete button. 

Delete All 
The Delete All option deletes all guides of the selected orientation. 

Creating Guidelines 
Guidelines can also be created using the following steps: 

¾ Turn on Show Rulers from the View menu; 

 
¾ Activate Use Guides in the Options menu; 

 
¾ Move the cursor onto one of the on screen Rulers; 
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¾ Click the Right Mouse Button.  

 
If the cursor was clicked in the vertical ruler along the left edge of the view-screen, a horizontal 
guideline appears on the screen as a dotted line. If the cursor was clicked in the horizontal ruler along 
the top edge of the view-screen, a vertical guideline will appear on the screen.  

Constraining a New Guideline With The Rulers 
If the [Control] key is pressed while creating a guideline, the new guideline will be forced to appear on 
the nearest ruler increment. 

Deleting a Guideline 
To delete a guideline, simply position the cursor over top of the guideline to be removed and click on it 
with the right mouse button while holding down the [Shift] key. 

Placing Guidelines on a Selected Object 
Guidelines can be created based on the placement of a given object on screen. To accomplish this, 
position the cursor over top of one of the nubs that surround a selected. Click on the nub with the right 
mouse button while holding down the [Shift] key. Clicking on a corner nub produces two guidelines 
which intersect at the nub. Clicking on a side, top, or bottom nub will result in a single guideline being 
created, a vertical guideline for side nubs, and a horizontal guideline for top and bottom nubs. 

Placing Guidelines on a Selected Node 
A pair of intersecting guidelines can be placed on top of any node when in the node edit state. To 
create a pair of intersecting guidelines over a given node, click the right mouse button over the desired 
node while holding down the [Shift] key. A pair of guidelines will appear intersecting at the selected 
node. 

Enabling and Disabling Guidelines 
The Use Guides command from the Options actually toggles the use of guidelines, as opposed to 
adding or removing them. For example, set a series of guidelines, de-selecting the Use Guides option 
removes the guides from the screen, but they will not be deleted. When the Use Guidelines is toggled 
on again, they will re-appear where they were created. 
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WORKSPACE COLORS 
Selecting the Workspace colors option opens the Workspace Colors dialog box. 

 
From within this dialog box the Background Color, Grid Color, Guideline Color, and Signblank Color 
can be set. To change a Color setting use the arrow buttons to scroll through the available palette of 
colors. 

SNAP TO SIGN BLANK 
Selecting this option causes objects to snap to the edges of the sign blank if placed within six pixels of 
it. Selected objects will snap to the sign blank at their outer edges, and at their vertical and horizontal 
centers. A small check mark beside this option indicates that it is selected. 

TOGGLE UNITS 
The Toggle Units option, does just that, it toggles the unit of measurement from inches to millimeters 
and then when selected again toggles the unit of measurement back to inches. This can also be 
achieved through the General Preferences dialog box, or by left clicking on the ruler to open the pop-
up Ruler menu. 
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HELP MENU 
HELP 

 
The Help menu contains options relating to help in operating the EZ-Engrave program. On-Screen 
Help provides an explanation of features, menu items and tools contained in EZ-Engrave. 

INDEX 
The Index option presents a standard Windows help index dialog box.  

 
Click on the item of interest in the index listing and an explanation of that feature will be displayed on 
screen. 



Help Menu 

USING HELP 
Click on this option to access instruction on the use of Windows’ Help facility. 

 

GO TO IDEAL STENCIL WEB SITE 
The Go To Ideal Stencil Web Site options opens a fly-out menu with direct access to specific areas 
within the Ideal Stencil Web site, provided the system is set up with Internet access. 

 
Selecting one of the direct link options opens the WEB browser set as default for the system. These 
links provide direct access to the main Ideal Stencil WEB site, the Technical Support site, and the New 
Products site. 
Access the Web site for up-to-date information as well as tips and trick on how to best use the 
software. There are also updated release available to qualified users for quick and easy download. 
 

E-MAIL TECHNICAL SUPPORT 
Use this option to activate the default e-mail software on the system, provided the system is set up with 
an Internet connection. This option gives direct access to e-mail our Technical Support group 
regarding issues that may arise. 

ABOUT EZ-ENGRAVE 
Select the About EZ-Engrave option to open the About EZ-Engrave dialog box.                
This box provides information regarding the version of EZ-Engrave running, the amount of free 
memory and disk space available, as well as the production date of the software. Click on the OK 
button to close the dialog box and return to the main EZ-Engrave view screen. 
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NOTEPAD 
Select the NotePad to open the Windows’ NotePad application.  A new untitled document will open. 

 

CALCULATOR 
Access the Windows’ Calculator by selecting Calculator from the Help menu. 

 

TimeSign 
Access to EZ-Engrave’s TimeSign is available through the Help menu. TimeSign is a clock/timer 
application that can be used as a stop watch to track time. 

 

Start 
Press the Start button to activate the stop watch. Once activated the Start time will appear beside the 
Start button with a traffic light icon, the light appears green while the timer is running.  The elapsed 
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time in seconds will appear at the bottom of the dialog box, beside the Continue button. 

 

Stop 
Press the Stop button to stop the timer. The Stop time appears beside the Stop button with the traffic 
light icon, the light appears red while the timer is stopped. The elapsed time is displayed at the bottom 
of the dialog box beside the Continue button, at this point TimeSign can Continue or be Reset. 

 

Continue 
Press Continue to recommence timing without resetting the elapsed time to a zero value.  This is ideal 
for situations where the work is interrupted and recommenced, and the total work time is required.  

 

Clock 
The current time is displayed in the top left segment of the dialog box.  TimeSign accessing the 
Windows’ clock setting for this information. 

Reset 
Press the Reset button to return the elapsed time to a zero value. 

 

Close 
Press the Close button to exit the TimeSign application. 
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